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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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EMC Notices
United States of America - FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, 
pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a Commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

Canada

This Class A device complies with Canadian ICES-003 and part 15 of the FCC Rules.

Cet appariel numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

European Union

This equipment is in compliance with the essential requirements and other relevant provisions 
established under regulation (EC) No 765/2008 and Decision No 768/2008/EC referred to as the 
“New Legislative Framework”.

Australia/New Zealand

This equipment is in compliance with the provisions established under the Radiocommunications 
Act 1992 and Radiocommunications Labeling (Electromagnetic Compatibility) Notice 2008.

Korea

This equipment is in compliance with the provisions established under the Radio Waves Act.

Class A equipment (Broadcasting and communications service for business use).

This device is a business-use (Class A) EMC-compliant device. The seller and user are advised to be 
aware of this fact. This device is intended for use in areas outside home.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could 
void the user’s authority to operate this equipment.

Warning — This equipment is compliant with Class A of CISPR 32. In a residential environment this 
equipment may cause radio interference.
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International

This equipment has been tested under the requirements of CISPR 22:2008 or CISPR 32:2015 and 
found to comply with the limits for a Class A Digital device.

Warranty and Repair Policy
The Ultricore BCS system is backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective 
item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are 
conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of 
Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be 
supplied free of charge while defective items undergo repair. Return packing, shipping, and special 
handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profit). Implied warranties, including that of 
merchantability and fitness for a particular purpose, are expressly limited to the duration of this 
warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment 
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration. You can also contact Ross Video for more information on the 
environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your 
area. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

Notice — This is a Class A product. In domestic environments, this product may cause radio 
interference, in which case the user may have to take adequate measures.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.



Security and Privacy 
If you would like more information on how Ross Video security and privacy practices have been 
applied to the Ultricore BCS, what you should know about maintaining security of this product, and 
how we can partner with you to ensure security throughout this product's life-cycle, contact 
techsupport@rossvideo.com.

Ross Video has implemented reasonable administrative, technical, and physical safeguards to help 
protect against security incidents and privacy breaches involving a Ross Video product provided 
those products are used in accordance with Ross Video instructions for use. However, as systems 
and threats evolve, no system can be protected against all vulnerabilities and we consider our 
customers the most important partner in maintaining security and privacy safeguards. If you have 
any concerns, we ask that you bring them to our attention, and we will investigate. Where 
appropriate, we will address the issue with product changes, technical bulletins and/or responsible 
disclosures to customers and regulators. Ross Video continuously strives to improve security and 
privacy throughout the product life-cycle using practices such as: 

• Privacy and Security by Design
• Product and Supplier Risk Assessment
• Vulnerability and Patch Management
• Secure Coding Practices and Analysis
• Vulnerability Scanning
• Access Controls appropriate to Customer Data
• Incident Response
• Clear paths for two-way communication between customers and Ross Video

If you would like to report a potential product related privacy or security issue (incident, breach, or 
vulnerability), contact techsupport@rossvideo.com.

Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
This guide covers the installation, and configuration of the Ultricore BCS Central Controller in a 
routing system. 

 For information on creating and managing databases for your routing system, refer to the Ultrix 
and Ultricore Database Guide.

The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Before You Begin” provides an overview for creating a routing system with Ultricore BCS, and 

general information to keep in mind before installing and configuring your Ultricore BCS panel.
• “Hardware Overview” provides a basic introduction to the Ultricore BCS front and rear panels.
• “Physical Installation” provides instructions for the basic physical installation of the Ultricore 

BCS panel.
• “Getting Started” provides instructions for adding the Ultricore BCS to the DashBoard Tree View, 

and basic global settings in DashBoard.
• “Using DashBoard” outlines the Ultricore BCS tree view in DashBoard, and how to navigate the 

nodes.
• “Role-Based Access Control” outlines the use of the RBAC feature within the DashBoard 

software application for the Ultricore BCS.
• “Navigating the Product Info Interfaces” summarizes the Product Info interfaces (formerly the 

System Status interfaces in software versions prior to v6.0).
• “Navigating the System Configuration Interfaces” summarizes the interfaces used to 

configure the connection points in your routing system.
• “Navigating the Device Configuration Interfaces” summarizes the options and fields to 

configure and monitor global settings of your hardware.
• “Connecting to an ULTRIX-FR12” summarizes the required steps to setup communication 

between the Ultricore BCS and the ULTRIX-FR12.
• “Software License Keys” outlines the available software licensed features, and how to install a 

software key for a licensed feature.
• “Timing Setup” outlines how to specify a time source, and adjust the time offset for your 

Ultricore BCS.
• “Ultricore-IP” outlines how to configure receivers and senders to be used in video and audio 

streaming.
• “Enabling a Service” outlines how to enable a communication service (protocol), and configure 

the additional settings on the Ultricore BCS for each protocol (if required). A summary of the 
supported commands is also provided.

• “User Assigned Parameters” provides information on the User Assigned Parameters feature 
that enables you to configure quick access custom Ultritouch panels for input/output signal 
control in your system.

• “Ultricore-Tally Setup” provides information on the Ultricore-Tally licensed feature for the 
Ultricore BCS.

• “Ultricore-Tally and Ultriscape” outlines how to configure the Ultricore-Tally to work with 
Ultriscape UMD tallies.

• “Operation with Ross Devices” provides general information for operating the Ultricore BCS in a 
routing system that also includes Ross NK Series devices.

• “Setting up a Redundant System” outlines how to configure two Ultricore BCS panels into a 
single standby redundant system.
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• “System Integration Examples” provides generalized examples of integrating Ultricore BCS into 
existing routing systems. 

• “Monitoring” describes the alarms and status indicators in the DashBoard interface for the 
Ultricore BCS. General information is also provided on the Ethernet port LEDs.

• “Panel Menu System Overview” outlines the menus available using the hard panel.
• “Technical Specifications” provides the specifications for the Ultricore BCS.
• “Software Licenses” provides third-party software license information for your Ultricore BCS.
• “Glossary” provides a list of terms used throughout this guide.

Related Publications
It is recommended to consult the following Ross documentation before installing and configuring 
your Ultricore BCS:

• DashBoard User Guide, Ross Part Number: 8351DR-004
• Tally System Console User Guide, Ross Part Number: 2201DR-016
• Ultricore BCS Quick Start Guide, Ross Part Number: 2201DR-109
• Ultricore-Tally Device Setup Guide, Ross Part Number: 2201DR-015
• Ultrix and Ultricore Database Guide, Ross Part Number: 2201DR-108
• ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 Installation Guide, Ross Part Number: 2101DR-003
• ULTRIX-FR1, ULTRIX-FR2, and ULTRIX-FR5 User Guide, Ross Part Number: 2101DR-004
• ULTRIX-FR12 Installation Guide, Ross Part Number: 2101DR-603
• ULTRIX-FR12 User Guide, Ross Part Number: 2101DR-604
• Walkabout Application Note, Ross Part Number: 2201DR-003

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Edit dialog, click Insert Above.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the Ultrix User Guide.
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Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Toll Free Technical Support (North America): 1-844-652-0645
• Toll Free Technical Support (International): +800 1005 0100
• Technical Support: (+1)613-652-4886
• After Hours Emergency: (+1)613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Before You Begin
Ultricore BCS is a fully featured connectivity control system that is designed to handle all the usual 
router requirements as well as harness the power of Ultrix. Ultricore BCS makes it quick and easy to 
configure a system and gives your staff an intuitive and powerful set of controls to make operations 
run smoothly. If you have questions pertaining to the operation of Ultricore BCS, contact us at the 
numbers listed in “Contacting Technical Support”. 

Typical System Equipment
Use Ultricore BCS in topologies where routers and remote control panels are distributed 
throughout a facility. In this scenario some of the routers and panel are physically located a great 
distance from the Ultricore BCS. You would use Ethernet connections to the Ultricore BCS.

Figure 1  Example of a Possible Routing System with Ultricore BCS
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General Overview
Ultricore BCS is the central system controller for Ross Video’s routing systems. It allows the 
connection of Ethernet based routers and remote control panels, and third-party automation 
systems.

By collating the potentially complex aspects of a system’s switching scheme, Ultricore BCS allows for 
minimal out-of-the-box configuration of routers. This not only makes it easier to initially setup a 
system, but it also makes it easier to change configuration as needed.

The DashBoard client software enables you to monitor and control your Ross routing system 
components, from a computer. DashBoard communicates with the Ross routing system through 
Ethernet TCP/IP connections. 

IP Connectivity
Ultricore BCS provides simple, familiar configuration options paired with sophisticated discovery 
and registration to facilitate adding IP into systems.

• Optional software licenses.
• Scalable based on the number of streams required for control in the system.
• Use the same work-flows regardless of transport to enable easier integration in hybrid 

operations using the same logical configuration, and control surfaces.
• Ultricore IP

Before You Begin
Before configuring and operating the Ultricore BCS, you must first:

1. Download and install the latest version of the DashBoard client software. The DashBoard 
software and user manual are available from our website. 

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. 

2. Connect your routers and panels to your facility network.

3. Launch DashBoard.

4. Ensure that your routers and remote control panels are available/visible in DashBoard.

 Ross Video recommends a Memory Allocation of at least 4GB in DashBoard to ensure reliable 
operation. Refer to the DashBoard User Guide for details on setting the Memory Allocation value.

For More Information on...
• downloading and installing DashBoard, refer to the DashBoard User Guide.
• planning and installing your routing system, refer to the user documentation that accompanied 

your devices.
• installing and configuring an Ultrix router, refer to the Ultrix Installation Guide and Ultrix User 

Guide for your router model(s).

Installation and Setup Overview
The generalized work flow of installing and configuring your Ultricore BCS is:

1. Implement your routing system plan by installing the devices and configuring their network 
settings.

2. Use Walkabout to establish communications between Ultricore BCS and DashBoard.
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3. Ensure that DashBoard discovers the routing system and all its devices.

4. Configure individual device settings in DashBoard.

5. Define the routing system database using the options in the Ultricore BCS interfaces in 
DashBoard. Refer to the Ultrix and Ultricore Database Guide for details on configuring your 
databases.

6. Set up control panels.

Implementing a System Plan
Once the topology of the system has been decided with respect to routers, panels, connecting 
devices (NK-NET, NK-IPS) etc. the components are connected and configured. Once all the Ross 
routing system components are configured for network communication, the required information 
is entered into the Ultricore BCS’s databases through its DashBoard interfaces.

An example use topology would be a broadcast facility or studio where there are routers and 
panels distributed throughout a building or a campus with the Ultricore BCS collating the system’s 
components. 

 Ultricore BCS acts as a central system controller for up to 10 DashBoard clients and up to 50 
hardware clients (routers and/or remote control panels).

Establish Communications
Ultricore BCS supports the Walkabout system for initial configuration of IP settings. Once you 
establish communications over Ethernet between the Ultricore BCS panel and DashBoard, you can 
proceed to use the interfaces in DashBoard that enable Ultricore BCS to communicate with the 
other devices in your routing system.

For More Information on...
• establishing a network connection to Ultricore BCS, refer to “Using Walkabout to Assign an IP 

Address to the Ultricore BCS Panel”.

Define the Routing System Database in Ultricore BCS
The Database interface in DashBoard for Ultricore BCS enables you to create system input and 
output lists, assign those signals to system sources and destinations, define multiple levels and 
matrices. You can create multiple databases, each one with unique parameters, that are saved to 
the Ultricore BCS panel memory. This provides the flexibility of recalling a database and editing 
parameters as needed. You may wish to use the following process when defining the database for 
your routing system.

 Ultricore BCS supports a maximum of 64 levels, with a maximum matrix of 4096 sources and 
4096 destinations.

Figure 2  Process for Configuring an Ultricore BCS

 Ultricore BCS does not support Unicode characters.

For More Information on...
• database management, refer to the Ultrix and Ultricore Database Guide.

Establish
Device Details

Define Core
System Settings

Define
Database
Sources

Define
Database
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Define 
Database

Levels

Set up 
Connected

Devices



20 • Before You Begin Ultricore BCS User Guide (v11-rev8)

Set up Virtual Control and Resource Management in Ultricore BCS
Once your router connections are defined, and a database is established, you can start building a 
map of several different physical devices that become one virtual device. When a switch request is 
made for a virtual device, all the physical devices that are mapped to the virtual device are switched. 

Ultricore BCS enables you to map inputs and outputs from routers for control via any remote 
control panel. These parameters can be saved to a database, enabling you to change configurations 
easily and quickly, allowing devices to used in a number of different operating scenarios.

Operation
Once configured, the Ultricore BCS provides central controller functionality for the routing system, 
including:

• the storage and implementation of routing system configurations, which collect a series of 
routing matrices into a system and provide a logical database view of the whole system

• switching the physical crosspoints of the routers according to the system configuration
• the control and system database interface for devices that control and/or display routing status 

(e.g. remote control panels, switchers, master control, automation systems, multi-viewers, and 
tally systems)

• virtual routing, matrix partitioning, and mapping
• label support for protocols supporting labels
• system control through DashBoard
• connection and status logging
• single Ultricore BCS operation or dual redundant mode
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Hardware Overview
This chapter presents information on the Ultricore BCS front and back panels. 

Front Panel Overview
The Ultricore BCS front panel is a touchscreen display that enables you to monitor Ultricore BCS 
communication status and routing system the panel is connected to. (Figure 3)

 This information is also reported in the System Monitor interface in DashBoard. Refer to 
“Monitoring via DashBoard” and “Monitoring via the Front Panel” for more information.

Figure 3  Ultricore BCS — Example of the Front Panel

1. Product Name

Indicates the Ultricore BCS product name.

2. Active Database

Reports the database currently loaded on this Ultricore BCS.

3. Panel Status

Displays the following information:

› IP — the IP Address assigned to this Ultricore BCS.
› Version — the build version of the Ultricore BCS.
› Name — the unique identifier assigned to the Ultricore BCS.
› Uptime — the number of hours, minutes, and seconds since the last reboot of the Ultricore 

BCS.

4. Incoming Connections

Reports the connected external devices currently sending data to the Ultricore BCS: 

› DashBoard Clients — the total number of DashBoard clients communicating with this 
Ultricore BCS.

1) Product Name 4) Incoming Connections 7) Disk Space Utilization

2) Active Database 5) Outgoing Connections 8) System Utilization

3) Panel Status 6) Memory Utilization

Memory Utilization Disk Space UltilizationDB Clients 8
RCP Panels 3
3RD Party Control 1
Ross IP-Video 3/4
Ross IP-Audio 1/2
IP-Video 1/1
IP-Audio 1/1

188_5RU        13.62.18...
145_5RU        13.62.14...
209_5RU        13.62.20...

System Utilization

IP: 12.32.123.235

Version: x.x.x

Name: UltricoreBCS-2AE75D

Uptime: 22h 38m 19s 
default
Active Database

25% 15% 5%
Outgoing Connections

Incoming Connections
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› RCP Panels — the total number of remote control panels communicating with this Ultricore 
BCS.

› 3rd Party Control — the total number of third-party automation control devices 
communicating with this Ultricore BCS.

› Ross IP-Video x/y — where x represents the current number of Ross Video IP Connectivity 
video devices (e.g. NEWT-IPX) communicating with this Ultricore BCS and y represents the total 
number of devices the Ultricore BCS is licensed to communicate with.

› Ross IP-Audio x/y — where x represents the current number of Ross Video IP Connectivity 
audio devices (e.g. IGGY-MADI) communicating with this Ultricore BCS and y represents the 
total number of devices the Ultricore BCS is licensed to communicate with. 

› IP-Video x/y — where x represents the current number of third-party IP Connectivity video 
devices communicating with this Ultricore BCS and y represents the total number of third-party 
video devices the Ultricore BCS is licensed to communicate with.

› IP-Audio x/y — where x represents the current number of third-party IP Connectivity audio 
devices communicating with this Ultricore BCS and y represents the total number of third-party 
audio devices the Ultricore BCS is licensed to communicate with.

5. Outgoing Connections

Reports the name and IP address of each external device that the Ultricore BCS is transmitting 
data to.

6. Memory Utilization

Reports the percentage of system RAM currently in use and will vary depending on the size of 
your routing system.

7. Disk Space Utilization

Reports the percentage of available storage space and will vary depending on the complexity of 
your routing system, the features enabled on the Ultricore BCS, and the stored database(s).

8. System Utilization

Reports on the level of traffic and communications the Ultricore BCS is managing. For example, 
this value is low when the system is idle or during periods of low activity. An increase in activity, 
such as when a user changes configurations, the system is busy switching or processing lots of 
parameter changes, there was a burst of network traffic will impact the System Utilization value 
reported.

Back Panel Overview
The Ultricore BCS back panel provides connections for power supplies, communications, and 
network connections. 
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Figure 4  Ultricore BCS — Back Panel, Side View 

1. PWR1 and PWR2 Connections

There are two power supply connectors located on the back of each Ultricore BCS. Each 
connector requires a 15VDC connection to an external power supply. Refer to Table 47 for power 
specifications. 

The Ultricore BCS ships with one power supply. An option is available to order a second power 
supply.

2. HDMI Port

This port is not implemented.

3. USB Port

This port is used with supported dongles for serial communication. Refer to “Supported 
USB-Serial Converters” for a list of supported devices.

4. ENET1 and ENET2 Ports

Each ENET port is an RJ45 connector 1GbE network interface. The ENET 1 port is a standard 
10/100/1000 RJ45 Ethernet connector and is used to exchange data and communicate with other 
devices in your router system. 

1) PWR1 and PWR2 Connections 3) USB Port

2) HDMI Port 4) ENET1 and ENET2 Ports

Notice — The Ultricore BCS automatically powers on when power is applied.

Notice — The ENET ports do not provide, nor make use of, Power-over-Ethernet (PoE).



24 • Hardware Overview Ultricore BCS User Guide (v11-rev8)



Ultricore BCS User Guide (v11-rev8) Physical Installation • 25

Physical Installation
If you have questions pertaining to the installation of Ultricore BCS, contact us at the numbers listed 
in “Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

Before You Begin
These installation guidelines assume the following:

• The relevant Ross equipment is installed into a ventilated rack frame. The relative humidity in the 
environment of the equipment should be <70% (non-condensing). The ambient temperature of 
the air entering the front panel should not exceed 40°C (104°F), and should not fall below 0°C 
(32°F).

• The install location of the panel should be accessible, dry, and dust-free.
• The socket/outlet should be installed near the equipment and be easily accessible.
• Valid IP addresses are available for the equipment.

Static Discharge

Throughout this chapter, please heed the following cautionary note: 

Mounting Requirements
The Ultricore BCS panel is designed for installation into a standard 19” equipment rack. It has 
integrated rack ears, allowing it to be screwed in using standard screws and cage nuts.

The Ultricore BCS panel mounts in the rack frame by means of four rack screws fastened through 
the front mounting ears. This should normally be sufficient to carry the load, including the weight of 
accompanying cables. 

Under some conditions, the ambient air temperature inside rack-mount cabinets can be greater 
than the ambient temperatures within a room. For safe long term reliability, adequate ventilation 
within a rack frame must also be maintained.

For More Information on...
• the technical specifications for the Ultricore BCS, refer to “Technical Specifications”.

Connecting the Ultricore BCS to a Network
The ENET 1 port is a standard 10/100/1000 RJ45 Ethernet connector and is used to exchange data 
and communicate with other devices in your router system. 

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

The Ultricore BCS is connected directly to your network so that it can interface with the devices in 
your routing system. After a physical connection is established, use the DashBoard client to 
configure the network settings for the Ultricore BCS.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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 If difficulties or problems are experienced when connecting the Ultricore BCS to a network hub, 
or with assigning IP addresses, please contact your network administrator.

To establish a physical connection to the network

1. Connect one free end of the straight through CAT5/5e/6 cable to a free port of the network hub.

2. Connect the other end of the same cable to ENET 1 on the Ultricore BCS back panel.

Figure 5  Ultricore BCS — Network Connection

Connecting to a Power Supply
The Ultricore BCS panel is powered by one +15V DC, 30W PSU, with an optional PSU available.

Each power cord should be connected to a separate power source for protection against failure of 
the A/C power circuit. In the event of one power supply failure, the panel load is seamlessly 
transferred to the other connected redundant power supply.

   

To connect the power cables to the Ultricore BCS panel

1. Connect the male end of the provided power cable into the socket marked PWR1 on the 
Ultricore BCS back panel.

Warning Hazardous Voltages — The safe operation of this product requires that a protective 
earth connection be provided. This protective earth is provided by the ground conductor in the 
equipment’s supply cord. To reduce the risk of electrical shock to operator and service personnel, this 
ground connector must be connected to an earthed ground.

Warning — In some countries it may be necessary to supply the correct mains supply cord. Use only 
certified cords for the country of use.

Notice — The Ultricore BCS automatically powers on when power is applied.

HDMI

PWR 1
PWR 2

USB

ENET 2

ENET 1 To network hub
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Figure 6  Ultricore BCS — Primary Power Connection 

2. Connect the second power cable into the PWR2 power supply socket if a second power supply 
is required.

3. Connect the supplied AC power cable into the power modules.

4. Connect the supplied power cable’s three-prong male connector to an AC outlet.

HDMI

PWR 1
PWR 2

USB

ENET 2

ENET 1

Note: It is recommended that you always connect
the Power Supply Unit to the Ultricore BCS before
connecting to Mains Power.
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Getting Started
The Ultricore BCS system controller with the DashBoard client software allows configuration and 
control of the Ultricore BCS and other routing system devices, enhancing the capability of any 
installed Ross products by providing access to the entire range of functions. Ultricore BCS provides 
a basic platform operation with SLP discovery and manual configuration of connection to 
DashBoard. 

This chapter provides instructions on basic set up that includes launching DashBoard, using 
Walkabout to assign an IP address to the Ultricore BCS panel, adding the Ultricore BCS to the Tree 
View in DashBoard, and accessing the Ultricore BCS interfaces in DashBoard.

Launching DashBoard
DashBoard must be run on a computer that has a physical wired Ethernet connection. Wireless 
connections do not allow device discovery.

For More Information on...
• the DashBoard client software and user documentation are available on our website.

To launch DashBoard

1. Ensure that you are running DashBoard software version 9.14 or higher.

2. Launch DashBoard by double-clicking its icon on your computer desktop.

Using Walkabout to Assign an IP Address to the Ultricore BCS 
Panel
Once the Ultricore BCS panel is physically installed and cabled to your facility network, you will need 
to assign it a static IP Address to enable DashBoard to locate it on your network. Establishing an IP 
Address enables DashBoard to communicate with the Ultricore BCS and update the Basic Tree View 
with the Ultricore BCS nodes.

To assign a static IP address to the Ultricore BCS panel

1. Launch DashBoard.

2. From the DashBoard client main toolbar, select File > Show Walkabout.

The DashBoard window displays the Walkabout table.

3. Click Refresh, located at the bottom of the Walkabout tab, to ensure the list in the Walkabout 
table is current.

4. In the Walkabout table, find the entry for the Ultricore BCS you want to configure.

5. Use the Name field to assign a unique identifier to the Ultricore BCS panel. This is the name 
displayed in the Tree View of DashBoard.

 After editing a cell in the Walkabout table, press Enter to confirm your edits. To verify your 
changes, wait up to 1 minute, then click Refresh.

6. Use the Address field to specify the IP Address supplied by your IT Department for this device.

7. Ensure the Netmask field is set to match your network requirements.

8. Use the Gateway field to specify the IP Address for connection outside of the local area 
network (LAN).

9. Click Reboot in the row of the Walkabout table for the Ultricore BCS to reboot the device.
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Adding the Ultricore BCS to the Tree View in DashBoard
Once you have assigned the Ultricore BCS panel to a static IP Address via Walkabout, you can then 
manually add it to the Tree View in DashBoard. Manually adding the Ultricore BCS panel displays its 
node in the Tree View, granting you access to the interfaces described in “Using DashBoard”.

To manually add the Ultricore BCS to the Tree View in DashBoard

1. In the Basic Tree View toolbar of DashBoard, click .

The Add New Connections dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Enter the IP Address for the Ultricore BCS in the IP Address field assigned in “To assign a static 
IP address to the Ultricore BCS panel”.

6. Click Detect Frame Information.

The fields in the TCP/IP DashBoard Connect/openGear Device dialog are auto-populated with 
data retrieved from the Ultricore BCS panel.

7. Click Finish. 

The Ultricore BCS panel displays in the Tree View. 

Reviewing the Network Settings for the Ultricore BCS Panel
Once you establish initial communications with the Ultricore BCS panel, and it displays in the 
DashBoard Tree View, you may wish to alter the network settings according to your facility network 
requirements.

To update the network settings for the Ultricore BCS panel

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Network tab.

3. Locate the Settings area of the tab.

4. Use the Address field to specify the new static IP Address for the Ultricore BCS panel.
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 Do not assign the Ultricore BCS to an IP address in the range of 192.168.13.xx. These are reserved 
addresses.

5. Use the Subnet Mask field to specify the subnet mask for your network.

6. Use the Gateway field to specify the gateway for communications outside of the local area 
network (LAN).

7. Click Network Settings Apply.

Re-naming the Ultricore BCS
Each Ultricore BCS can be given a unique name that is used on internal menus and as the identifier 
in the tree views of DashBoard. 

 Changing the Ultricore BCS name after database configuration takes time to propagate through 
the system, and for DashBoard to reconnect, resuming stable system operation. Sufficient time 
must be allowed when making this change before attempting to use the system. This time will 
vary depending on features, matrix size, and configuration. In the case of a system with an 
ULTRIX(-NS)-1RU and ULTRIX(-NS)-2RU, the worst case will be 3-4 minutes. In the case of a system 
with an ULTRIX(-NS)-5RU, the worst case is 10 minutes. The Ultricore BCS name is typically 
assigned during initial commission and very rarely ever changed again.

To re-name the Ultricore BCS in DashBoard

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Setup tab.

3. Use the Device Name field to specify the new name for the Ultricore BCS.

4. Press Enter to apply the new name.

Configuring Access for DashBoard Clients
You can specify which DashBoard clients on your network can access and connect to your Ultricore 
BCS. By default, the Permitted Clients list is blank, allowing all DashBoard clients on your network 
to connect to your Ultricore BCS.

To enable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Network tab.

3. Locate the Permitted Clients area of the Network tab.

4. Click Add in the Permitted Clients area of the Network tab.

The Add Address dialog opens.

5. Use the IP Address field to specify the IP Address of the DashBoard client you wish to grant 
access to your Ultricore BCS.

6. Click Apply.

The Add Address dialog closes.

The Dashboards list in the Permitted Clients area updates to display the specified IP Address.

7. Repeat steps 4 to 6 for each DashBoard client you want to allow access.

 Ensure that the IP Address for your DashBoard client machine is also added.
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8. Click Apply in the Permitted Clients area to apply the change.

To disable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Network tab.

3. From the Dashboards list, select the IP Address for the DashBoard client you want to disable 
access for.

 Do not delete the IP Address for your DashBoard client machine.

4. Click Delete in the Permitted Clients area of the Network tab.

5. Click Apply in the Permitted Clients area to apply the change.
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Using DashBoard
This chapter outlines the Ultricore BCS tree view in DashBoard, and how to navigate the nodes.

If you have questions pertaining to the operation of Ultricore BCS, contact us at the numbers listed 
in “Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

For More Information on...
• the DashBoard client software, refer to the DashBoard User Guide.
• the database interfaces in DashBoard, refer to the Ultrix and Ultricore Database Guide.

Overview
Ultricore BCS groups the configuration, monitoring, and operating features in a Tree View in the 
DashBoard client window. (Figure 7) Each node of the tree opens to reveal one or more sub-nodes, 
giving access to the features for your Ultricore BCS.

Figure 7  Example of the Ultricore BCS Nodes in a DashBoard Window

Ultricore BCS includes the following interfaces, as separate nodes, in the DashBoard Tree View.

Product Info
Double-clicking the Product Info node displays two types of tabs within the same DashBoard 
window: Status (read-only) tabs located on the left, and a series of configuration options (tabs) 
located on the right. Refer to “Navigating the Product Info Interfaces”.

System
The System tree includes three sub-nodes: Configuration, Control, and Monitoring. 

• The Configuration sub-node enables you to set up communications with devices in the routing 
system. Refer to “Navigating the System Configuration Interfaces” and “Navigating the 
Device Configuration Interfaces”.

• The Control sub-node provides access to the Ultripower Manager sub-node. Double-click this 
sub-node to display the interface for grouping Ultripower units together to safely power on/off 
the ULTRIX-FR12. Refer to the ULTRIX-FR12 user documentation for details.

• The Monitoring sub-node enables you to monitor the status of your Ultricore BCS and the routing 
system. Refer to “Monitoring”.

Database
Expanding the Database node enables you to configure the databases, matrices, destinations, 
sources, levels, soft panels, and salvos for the routing system. Refer to the Ultrix and Ultricore 
Database Guide for details.



34 • Using DashBoard Ultricore BCS User Guide (v11-rev8)

Navigating the Ultricore BCS Interfaces in DashBoard
The interfaces are accessed by expanding the Ultricore BCS node in the DashBoard Tree View and 
selecting the appropriate sub-node. Several of the interfaces are organized in a table layout with a 
toolbar on the bottom, and a toolbar on the left side of the tab.

For More Information on...
• the database interfaces for your routing system, refer to the Ultrix and Ultricore Database Guide.

To access the Ultricore BCS interfaces in DashBoard

1. Locate the Ultricore BCS node in the Tree View of DashBoard.

2. Expand the main Ultricore BCS node.

3. Expand the Ultricore BCS sub-node to display a list of sub-nodes in the Tree View.

Each sub-node is an Ultricore BCS interface.

4. Double-click the Product Info sub-node to display that interface in the right pane of the 
DashBoard window.

The Product Info interface displays two panes within the same DashBoard window: status 
(read-only) fields in the left pane, and a series of tabs with configurable menus and settings in 
the right pane. Refer to “Navigating the Product Info Interfaces” for an overview of the 
available tabs, menus, and settings. 

5. Expand the System sub-node to access the functions of the interface.

The System tree includes three sub-nodes: Configuration, Control, and Monitoring.
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6. Expand the Configuration sub-node.

The Configuration tree includes two sub-nodes: Ultricore BCS and Connections.

• The Configuration > Ultricore BCS node provides access to the Device Configuration 
interfaces. Refer to “Navigating the Device Configuration Interfaces” for details.

• The Configuration > Connections node enable you to manage the auto-detected devices in 
your routing system. Refer to “Navigating the System Configuration Interfaces” for details.

7. Expand the Control sub-node.

The Ultripower Manager sub-node displays. Double-click this node to display the options for 
configuring multiple Ultripowers in an ULTRIX-FR12 workflow. Refer to “Connecting to an 
ULTRIX-FR12” for details.

8. Expand the Monitoring sub-node.

The Logs and Health sub-nodes display. Double-click a node to display the monitoring 
information for your routing system. Refer to “Monitoring via DashBoard”.
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Role-Based Access Control
This chapter outlines the use of Role-Based Access Control (RBAC) within the DashBoard software 
application for the Ultricore BCS.

 This feature requires software version 6.1.0 or higher.

Before You Begin
Ensure the following:

• The Ross Platform Manager and appropriate licenses are purchased to use RBAC features.
• The RPM Server is configured and added to DashBoard.
• The permissions for the devices in your routing system are defined via the Ross Platform 

Manager.

For More Information on...
• configuring the Ross Platform Manager and Server, refer to the DashBoard RPM User Guide.
• the Ultricore Profiles feature, refer to the Ultrix and Ultricore Database Guide.

Enabling RBAC for an Ultricore BCS
The RBAC feature determines access to an individual devices (Ultrix or Ultricore) via a DashBoard 
instance (client). Once RBAC is enabled, any DashBoard without RPM will not be allowed to connect 
to the device unless the user enters a 'master password'. 

• If a DashBoard instance has RPM and the account for the current user is configured to allow 
access to the device, the user will be able to continue using the device. 

• If the user does not have access, the device will be disconnected from DashBoard until a user 
with access rights is signed-in.

To enable RBAC on an Ultricore BCS

1. Launch DashBoard.

2. Locate the Ultricore BCS node in the Tree View.

3. Expand the Ultricore BCS node to display a list of sub-nodes.

4. Expand the Ultricore BCS sub-node.

5. Double-click the Product Info sub-node.

The Product Info interface displays.

6. Select the Setup tab.

7. Locate the RPM Role Based Access Control Required area.

8. Click Role Based Access Settings.

The Change RBAC Settings dialog opens.

9. From the RPM Role Based options, select On.

  The RPM Role Based is set to Off by default.

10. Use the Client Master Password field to specify the text string a user can enter to gain access 
to this device when RPM is not present in DashBoard or if DashBoard is unable to connect to 
the RPM Server.
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11. Click Done.

• The Change RBAC Settings dialog closes.
• On the Setup tab, the RPM Role Based Access Control Required field now reports On.

To verify that RBAC is enabled

1. Close the Product Info interface in DashBoard.

2. Locate the device node in the DashBoard Tree View.

3. Right-click the device node.

4. Select Disconnect.

The device node displays a grayed out icon.

5. Right-click the device node.

6. Select Connect.

The device node displays with a lock icon. Any user attempting to access this device will be 
prompted to enter the password specified in step 10 in the previous procedure. 

Accessing a Device with RBAC Enabled
Once the Ultricore BCS is accessed through DashBoard are configured to require connection to an 
authenticated DashBoard instance (client), connection requests from unauthenticated sources are 
declined. A Lock icon displays next to the Ultricore BCS node in the Basic Tree View to indicate that 
RBAC is enabled for that device. If RBAC is enabled but your system is not using an RPM Manager or 
Server or the RPM Server is unavailable, you will need to enter a Client Master Password to gain 
access to the device. This section outlines how to use a Client Master Password to access a device 
when RBAC is enabled.

 If RPM is used, access to the device is based on the privileges of the current user signed into 
DashBoard.

For More Information on...
• managing access control in DashBoard, refer to the DashBoard RBAC User Guide.

To access an Ultricore BCS when RBAC is enabled

1. Locate the Ultricore BCS node in the Tree View of DashBoard.

Notice that the node displays an icon with a lock symbol.

2. Double-click the Ultricore BCS node.

The Password dialog opens.

3. Enter the password as defined in step 10 of “To enable RBAC on an Ultricore BCS”.

4. Click Login.

The Password dialog closes and the Ultricore BCS node displays a green icon and its tree nodes 
are accessible.

 Entering an incorrect password denies access and the device icon is lit red.
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Navigating the Product Info 
Interfaces
This chapter summarizes the Product Info interfaces (formerly the System Status interfaces in 
software versions prior to v6.1).

Overview
The Product Info interface displays two panes within the same DashBoard window: status 
(read-only) fields in the left pane, and a series of tabs with configurable menus and settings in the 
right pane. (Figure 8)

Figure 8  Example of the Product Info Interface for an Ultricore BCS

The following sections briefly outline each tab displayed on the Product Info interface starting with 
the leftmost tab.

Product Tab
The Product tab provides read-only information about the general hardware and software status. 

Table 1 summarizes the read-only information displayed in the Product tab.

Table 1  Product Info — Product Tab

Item Parameters Description
Product <text> Indicates the product name

Vendor <text> Indicates the supplier/manufacturer

System Version # Indicates the build version

Serial Number # Indicates the serial number 
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Other Tab
Table 2 summarizes the read-only information displayed in the Other tab.

BCS Redundancy Tab
The BCS Redundancy tab enables you to establish a failover system between two physical Ultricore 
BCS panels. Refer to “Setting up a Redundant System” for details on using this tab.

Network Tab
The options in the Network tab are organized into two sections: Settings (editable fields), and 
Ethernet Redundancy (read-only fields). Table 3 summarizes the fields and menus displayed in the 
Network tab. 

Uptime #h #m #s Indicates the number of hours since the last reboot

System Time DD mm dd yyyy 
hh:mm:ss

Indicates the current date based on the internal 
clock (if no connection to an NTP Server is available) 
where:
• DD represents the calendar day
• mm represents the month
• dd represents the day
• yyyy represents the year
• hh:mm:ss represents the current local time

Table 2  Product Info — Other Tab

Item Parameters Description
Frontend Software 
Date

# Read-only information used by Ross Technical 
Support.

Backend Software 
Date

#

Device FW Rev #

Table 3  Product Info — Network Tab

Item Parameters Description
Information

Active ENET ENET # Indicates which Ethernet port on the rear panel 
is the primary Ultricore BCS network connection

ENET # LINK Connected            
(x, y)

Indicates that a valid network link is configured 
on the specified Ethernet port of the Ultricore 
BCS rear panel where:
• x represents the speed in number of Mbps
• y represents the link type (e.g. full duplex)

Table 1  Product Info — Product Tab (Continued)

Item Parameters Description
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ENET # LINK Not Connected Ethernet communications for the Ultricore BCS 
are invalid. The Ethernet cable may be 
disconnected on the rear panel or the Ethernet 
network may be down or experiencing 
problems.

ENET MAC (read-only) # Indicates the MAC Address for the Ultricore BCS 

Settings

Address # Specifies the IP address for the Ultricore BCS 
panel

Subnet Mask # Specifies the subnet mask for the Ultricore BCS 
panel

Gateway # Specifies the gateway for communication 
outside of the local area network (LAN)

Apply Updates the Address, Subnet Mask, and Gateway settings

Cancel Ignores any unsaved changes made to the Address, Subnet Mask, 
and Gateway settings and reverts back to the current running 
values.

Services

SSH Selected Enables system administrators to securely log 
onto remote systems and execute commands 
over an unsecured network via the Secure Shell 
(SSH) Login client-server protocol

Cleared Disables this service

Walkabout Selected The Walkabout configuration software can be 
used to configure the basic network 
communications settings for the Ultricore BCS

Cleared Disables this service

Change Click this button to edit the services

SNMP

Enable SNMP Selected Enables the SNMP Agent on the Ultricore BCS

Cleared Disables the SNMP Agent on the Ultricore BCS

SNMP Community 
Name

# Specifies the SNMP Agent identifier for 
communications

SNMP Trap 
Destination IP 
Address

# Specifies the target address the Ultricore BCS 
sends SNMP traps to

Permitted Clients

DashBoards: # Lists the IP Address of each DashBoard client 
that is allowed to communicate with this 
Ultricore BCS

Add Enables you to add a new DashBoard client to the Permitted 
Clients list

Table 3  Product Info — Network Tab (Continued)

Item Parameters Description
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Setup Tab
Table 4 summarizes the options displayed in the Setup tab. 

Delete Deletes the selected DashBoard client from the Permitted Clients 
list

Delete All Clears all entries in the Permitted Clients list

Edit Enables you to modify the selected entry in the Permitted Clients 
list

Cancel Ignores any unsaved changes made to the Permitted Clients list 
and reverts back to the current running values. 

Apply Updates the Permitted Clients list settings

Table 4  Product Info — Setup Tab

Item Parameters Description
Device Identification

Device Name <name> Provides a unique identifier for the Ultricore BCS in the 
Tree View

System Name <name> Provides a unique identifier for the routing system

Log Settings

Logging Selected Enables the Ultricore BCS to update the entries in the 
System Logs interface

Cleared Disables this feature

Output Debug 
Messages

Selected Only use this feature under the guidance of Ross 
Technical Support.Cleared

DashBoard Interface

DashBoard Timeout 30-300s Sets the maximum number of seconds that DashBoard 
waits until it queries the Ultricore BCS. The default is 
70 seconds.

Update Applies the new value in the DashBoard Timeout menu.

Status

mm/dd/yy ERROR: Duplicate device 
name [abc] for ID [#]

Reports when multiple devices, with the same name, 
are communicating with the Ultricore BCS where:
• mm/dd/yy represents the date of the error
• [abc] represents the device name
• [#] represents the ID number assigned to the device

Clear Clears the Status field entry

Routing Behavior

Salvo/Multi- 
Crosspoint Take 
Completion

Require All 
Crosspoints

The Take operation will fail entirely if any destinations 
are locked or protected

Best Effort The Take operation will be performed for any valid 
routes and fail for locked or protected routes

Table 3  Product Info — Network Tab (Continued)

Item Parameters Description
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Navigating the System Configuration 
Interfaces
This chapter summarizes the System > Configuration interfaces.

For More Information on...
• the System > Configuration > Ultricore IP sub-node, refer to “Ultricore-IP”.

Configuration Tree Overview
Expanding the top Configuration node enables you to access the sub-nodes that manage the 
available devices in your routing system that are auto-detected by your Ultricore BCS. (Figure 9)

Figure 9  Expanded Ultricore BCS Configuration Nodes in the Tree View

Double-click the first sub-node to display the Device Configuration interface in the right pane of 
the DashBoard window.(Figure 10) Refer to “Navigating the Device Configuration Interfaces” to 
learn more about the features of the Device Configuration interface.

Figure 10  Example of a Device Configuration Interface
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Double-click the Connections sub-node to display a series of tabs in the right pane of the 
DashBoard window. (Figure 11)

 
Figure 11  Example of the Ultricore BCS > Connections > Incoming Connections Interface

The following sections outline the tabs, fields, and settings available in the Connections interface.

Connections Interface
The Connections interface lists and configures the connection points in your routing system. The 
interface is organized into three tabs: Incoming Connections, Services, and Protocol Servers. The 
following sections outline each tab.

 Prior to software version 6.1, the Connections interface tabs and fields were included in the 
Database > Connections and Database > Third-Party Matrices interfaces.

Incoming Connections Tab
The Incoming Connections table lists the connection details of remote client devices under the 
supervision of the active database currently communicating with the router. (Figure 12)

Figure 12  Example of Entries in a Connections > Incoming Connections Interface
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Table 5 summarizes the fields displayed in the Incoming Connections tab. 

Table 5  Connections — Incoming Connections

Item Parameters Description
Communication tcp   The device is communicating over a network 

connection. Note that the DashBoard client 
computer, the router, and the external device must 
be on the same network.   

ip: # Specifies the IP Address of the device on the 
network

ip: localhost Specifies that the device is the router you are 
currently configuring

port:##### Specifies the ethernet port the devices is associated 
with on the network

TBUS | port: The device is communicating via the specified T-Bus 
port

Description <text> Provides a short textual description of the device

Device ID <name> Specifies the external device for the connection 
point

Name <name> Assigns a unique identifier for the device in the 
routing system. This name is also used when 
matrices are defined in the system.

Protocol GVG Native The device uses the third-party GVG protocol to 
communicate

NVISION This device communicates via the third-party 
NVISION protocol

OGP This device uses the openGear Protocol to 
communicate

Probel SW-P-08 The device communicates via the Probel SW-P-08 
protocol

Ross NK The device uses the Ross NK protocol to 
communicate (T-Bus or TCP only)

TSL UMD v3.1 The device uses TSL UMD protocol version 3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 5.0

Ultrix The device uses the Ross Ultrix protocol to 
communicate (TCP only)
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Services Tab
The Services tab lists the available communications protocols and provides options for 
enabling/disabling each communication protocol. (Figure 13)

Figure 13  Example of the Connections > Services Tab

Table 6 summarizes the options displayed on the Services tab.

 
Table 6  Connections — Services

Item Description
SSH service Enables the ability to log onto the primary device via an SSH server. 

Secure Shell (SSH) Login is a client-server protocol used by system 
administrators to securely log onto remote systems and execute 
commands over an unsecured network. SSH may also be used by 
Technical Support for advanced troubleshooting.

Walkabout Enables the primary device to communicate with devices in the 
Walkabout system

Ember Plus Enables the primary device to communicate with a third-party control 
system via the Ember+ media distribution protocol

GVG Native Enables the primary device to communicate via the GVG Series 7000 
Native protocol and is available over an RS-422 or RS-232 serial 
connection, as well as ethernet connection.

Nvision Enables the primary device to communicate via a limited sub-set of the 
NVISION serial NP0010 protocol, and the NVISION NP16 Ethernet 
protocol.
Requires the Ultricore-NVISION license.

Probel SW-P-08 Enables the primary device to communicate via the Probel SW-P-08 
protocol. This protocol is available over an RS-422 or RS-232 serial 
connection, as well as an ethernet connection.

RossTalk Communications via the RossTalk protocol (a plain text based protocol 
that allows control of Ross Video equipment)

TSL Enables the primary device to communicate via the TSL UMD v3.1, TSL 
UMD v4.0, and TSL UMD v5.0 protocols.
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Protocol Servers Tab
The Protocol Servers tab lists the currently active servers running in the routing system. This tab is 
auto-populated based on the external devices on the same network as your primary device. (Figure 
14)

Figure 14  Example of the Connections > Protocol Servers Interface

Table 7 summarizes the fields displayed in the Protocol Servers tab.

 

Server Options Dialog

Click Options (located in the bottom left corner) to display the Server Options dialog. (Figure 15) 
This dialog provides additional settings for the supported protocol servers. 

NK Enable this option if there are Ross NK series devices or signal types 
the primary device itself does not handle. 
The Ross NK series devices must be connected to the Ethernet 
network by virtue of an Ross NK-IPS or NK-NET devices to enable 
communication with the primary device.

Web Access Remote access and upgrades are disabled by default (the Upload 
button is disabled in the DashBoard interfaces). Remote upgrades 
may optionally be enabled through DashBoard via this option. 

On bootup or power cycle, this option will default back to disable 
(box is unselected). You must select the box again if you wish to 
enable web access and firmware upgrades after a bootup or power 
cycle.

Table 7  Connections — Protocol Servers

Item Description
Name Indicates the unique identifier for the device in the routing system. 

This name is also used when matrices are defined in the system

Communication Indicates the communication protocol, IP Address, Port Number, and 
configuration details of the device.

Table 6  Connections — Services (Continued)

Item Description
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Figure 15  Example of the Services > Server Options Dialog

Table 8 summarizes the fields displayed in the Server Options dialog.

 
Table 8  Connections — Protocol Servers > Server Options

Item Parameters Description
GVG Native

L4 Echo No The Ethernet Layer 4 acknowledge is disabled. This 
is the default.

Yes The Ethernet Layer 4 acknowledge is enabled

Sequence More to 
Come Character

# Enables the user to assign a number to the 
seq_flag field in a packet that will indicate more 
messages to come. The default value is 9.
A value of 0 (zero) indicates the last or only packet.

Send Trailing HT Yes Includes the trailing <HT> character (Horizontal Tab 
(0x09)) in the packet

No The trailing <HT> character is not included in the 
packet

Send nbr_sources 
Leading Zero

Yes Always forces the nbr_sources field to be 2 ASCII 
characters (e.g. 1 becomes 01). This supports 
fragmentation of large message streams.

No Allows the nbr_sources field to be a single ASCII 
character

Repeated Packet 
Holdoff (ms)

# Ultricore BCS detects repeated identical packets, 
and will skip processing if the packets are repeated 
within the specified delay. The default is 0.

Probel SW-P-08
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Protocol Variant Use Last Req The Ultrix will respond using protocol variant 
(extended/non-extended) as per the received 
request format. This is the default.

Non-Extended Ultrix will always replay using non-extended 
formatting

Extended Ultrix will respond with extended formatting

Matrix Mode No Ultrix will use information from the LEVEL section of 
the protocol to control Ultrix levels

Yes Ultrix will use information from the MATRIX_ID 
section of the protocol to control Ultrix levels

Do not wait for ACK No Ultrix will wait for message acknowledgments 
between connect responses. This is the default

Yes Ultrix will not wait for message acknowledgments 
between connect responses

Batch Collate Time 
(ms)a

# Wait up to 100 milliseconds for multiple commands 
received before processing. The default is 0 (which 
disables this feature).

Batch Collate Split 
Size (# of 
commands)

# Wait up to 100 received commands before 
processing. The default is 0 (which disables this 
feature).

Unused Field # Send number (0-15) in either Level or Matrix field - 
which ever is not used as per Matrix Mode setting. 
The default is 0.

Probel Filter Yes Probel SW-P-08 crosspoint tally responses are 
provided when there are no status changes 
resulting from the crosspoint connect message.

No Removes the Probel Crosspoint Switch filter

Repeated Packet 
Holdoff (ms)

# Ultricore BCS detects repeated identical packets, 
and will skip processing if the packets are repeated 
within the specified delay. The default is 0.

TSL UMD v5.0

Wrapping No The DLE/STX wrapping is not enabled. This is the 
default.

Yes Enables the DLE/STX wrapping for TCP/IP transport

PBC in Count No Packet Byte Count is not included in total byte 
count. This is the default.

Yes Packet Byte Count is included in total byte count

Nvision

Offset 0 The Ultrix level matches the NVISION level

1 The Ultrix level is the NVISION level plus 1

Ember+

Table 8  Connections — Protocol Servers > Server Options (Continued)

Item Parameters Description
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Mode Virtual Each level is represented by a Matrix and the Labels 
will be the one defined in the Destinations and 
Sources interfaces

Physical The whole router is represented as a single Matrix 
and the physical socket labels are used. The 
external control system using Ember+ commands 
bypasses the virtual IO mapping and directly 
controls the Ultrix physical socket connections. 
Therefore the Ultrix should not be switched by any 
other devices

a. When the Batch Collate Split Size and Batch Collate Time are both active, the option that occurs first will 
release the batch, and the Batch Collate Split Size and the Collate Time values are reset.

Table 8  Connections — Protocol Servers > Server Options (Continued)

Item Parameters Description
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Navigating the Device Configuration 
Interfaces
The Device Configuration interfaces provides options and fields to configure and monitor global 
settings of your hardware. This chapter briefly summarizes the Device Configuration interfaces.

Overview
The Device Configuration interfaces are accessed via the System > Configuration tree in DashBoard. 
(Figure 16)

Figure 16  Expanded Ultricore BCS Configuration Nodes in the Tree View

Double-click the Ultricore BCS sub-node to display the Device Configuration interfaces in the 
DashBoard window. (Figure 17)

Figure 17  Example of an Ultricore BCS Device Configuration Interface

A toolbar always displays at the left of the Device Configuration interface. Use this toolbar to 
navigate between the Device Configuration interfaces. Selecting a button from the toolbar displays 
that area at the top of the interface (but below the rear panel image). The following sections outline 
the areas starting with the topmost button on the toolbar.

Frame Information
When the Device Configuration interface is first displayed in the DashBoard window, the Frame 
Information area automatically displays at the top of the interface. This area provides options for 
configuring the global time settings.
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Table 9 outlines the read-only fields and menus in the Frame Information area.

Licenses
Use the fields in this area to manage the licenses for your Ultricore BCS. From here you can view 
which licensed features are enabled, and enter license keys for new features. Refer to “Software 
License Keys” for details on this interface.

Alarms
From the Alarms area you can specify what components the Ultricore BCS monitors such as the 
network status, and the storage capacity. (Figure 18)

By default, the Ultricore BCS monitors the following components (these options are enabled): 
Storage Space and ENET 1.

The Alarms area also displays the read-only State columns that report the status of each enabled 
alarm using color indicators which vary in severity from green (valid), yellow (caution), to red 
(alarm).

Table 9  Device Configuration — Frame Information

Item Description
Type (read-only) <text> Indicates the product name

Firmware 
(read-only)

# Indicates the build version

Time DD mm dd yyyy 
hh:mm:ss

Indicates the current date based on the internal clock (if no 
connection to an NTP Server is available) where:
• DD represents the calendar day
• mm represents the month
• dd represents the day
• yyyy represents the year
• hh:mm:ss represents the current local time

Set to PC Time Assigns the DashBoard client computer as the time source for the Ultricore BCS

Use Daylight 
Saving Time

Select to add one hour to the currently selected UTC Offset (and enable Daylight 
Saving Time to the clocks displayed in the System Clock and Device interfaces)

Set Time Zone Manually specify the time zone your DashBoard client computer is located in

NTP Servers

Name (read-only) Server # Reports the identifier for the NTP server the Ultricore BCS 
can access

Address # Indicates the IP address for the NTP server the Ultricore 
BCS can access

Status Synchronized 
(Green)

The Ultricore BCS has a valid connection to this NTP server

Disconnected 
(Yellow)

The Ultricore BCS cannot connect to the NTP server 
specified at the IP address
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Figure 18  Example of the Alarms Area

Communication Settings
The Communication Settings area provides fields for assigning the IP address, subnet mask, and 
gateway to the ENET port on the Ultricore BCS. (Figure 19) You can also quickly monitor the status 
of the active ENET port. Refer to “Reviewing the Network Settings for the Ultricore BCS Panel” 
for details.

Figure 19  Example of the Communication Settings Area

Ultricore-Tally
If the Ultricore-Tally licensed feature is enabled, this area provides a read-only field to monitor the 
status of the tally system. Refer to “Ultricore-Tally Setup” for details.
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Connecting to an ULTRIX-FR12
The Ultricore BCS acts as a primary controller for one or more ULTRIX-FR12. A connection is made 
from the controlling Ultricore BCS panel to each ULTRIX-FR12. The controlling Ultricore BCS 
(primary) contains the full database configuration for the entire operation of the routing system.

Figure 20  Example Workflow with an ULTRIX-FR12 and Ultricore BCS

All client devices, such as a remote control panel (RCP) or third-party controllers, must be 
configured for and communicate with the primary Ultricore BCS. Each ULTRIX-FR12 configured as a 
client device will only accept control commands via the Ultricore BCS. To configure an ULTRIX-FR12 
as a client device, the Remote Controller Mode must be first enabled on the ULTRIX-FR12.

An Ultricore BCS with the Ultricore-IP license also enables the video senders/receiver endpoints to 
be reported as available ports to the routing database. The video senders/receivers are seen as part 
of a single video-IP matrix, and the audio senders/receivers are part of a single audio-IP matrix. 
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When a video sender stream is active and the video format changes on the SDI input of that 
stream, the Ultricore BCS will automatically detect the update and then updates all the receivers 
subscribed to that sender. This allows the existing streams to adapt.

Setup Overview
1. Configure the Ultripower Manager feature to group the Ultripower units together to safely 

power on/off the ULTRIX-FR12. Refer to the ULTRIX-FR12 Installation Guide for details.

2. Set up any licensing requirements for the ULTRIX-FR12. Refer to the ULTRIX-FR12 User Guide.

3. Set up any Ultriscape requirements for the ULTRIX-FR12. Refer to the Ultriscape User Guide.

4. Enable Remote Controller Mode on the ULTRIX-FR12. Refer to the ULTRIX-FR12 User Guide.

5. Create a database within the Ultricore BCS to accommodate the I/O of the ULTRIX-FR12. Refer 
to the Ultrix and Ultricore Database Guide.

6. Create a connection point from the Ultricore BCS to the ULTRIX-FR12. Refer to the Ultrix and 
Ultricore Database Guide.

7. Edit the Ultricore BCS database to map logical sources and destinations to ULTRIX-FR12 
inputs/outputs. Refer to the Ultrix and Ultricore Database Guide. 

8. Map the Ultriscape heads/PiPs. Refer to the Ultriscape User Guide for details.
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Software License Keys
The Ultricore BCS includes software options that license functions and features. This chapter 
outlines the available software licensed features, and how to install a software key for a licensed 
feature. 

Before You Begin
When installing a software license key on the Ultricore BCS:

• You must have the DashBoard client installed and communicating with the Ultricore BCS that you 
wish to install the key for.

• Ensure that you are using DashBoard version 9.14 or higher. This information is available by 
selecting Help > About DashBoard from the DashBoard main toolbar.

License Keys Overview
Table 10 provides a brief summary on the types of licensed features available for the Ultricore BCS.

Table 10  List of Ultricore BCS Licensed Features

License Description
Ultricore-NVISION Enables the use of the NVISION protocol on Ultricore BCS

Ultricore-SNMP Enables basic SNMP monitoring on Ultricore BCS 

Ultricore-EMBER+ A license that enables the use of the EMBER+ protocol for video and audio 
streaming 

Ultricore-BCS-CLIENT Each seat adds support for 25 device connections (panels, routers, 
DashBoard clients) to a maximum of 100 connections

Ultricore-IP Enables RDS and basic NMOS-IS-04 discovery support for the Ultricore-IP 
feature. You must install this license to enable the Ultricore-IP feature for 
the Ultricore BCS. Refer to “Ultricore-IP” for details on this feature.
Depending on your routing system, you will also need to install one of the 
following IP licenses.

Ultricore-IP+V Each seat adds support for 16 video streams between Ross Video devices

Ultricore-IP+A Each seat adds support for 384 audio streams between Ross Video 
devices

Ultricore-IP+V3RD Each seat adds support for 16 video streams from third-party devices

Ultricore-IP+A3RD Each seat adds support for 384 audio streams from third-party devices

ULTRICORE-TLX Enables the Tieline Builder feature for the Ultricore BCS. Refer to the 
Ultrix and Ultricore Database Guide.

Ultricore-Tally Enables the Ultricore-Tally feature. Refer to “Ultricore-Tally Setup”. 
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Installing a License Key
Ross Video uses license keys to control user access to specific Ultricore BCS features. You can 
obtain a key for an Ultricore BCS licensed feature from Ross Video Technical Support.

To install an Ultricore BCS license key

1. Launch the DashBoard client. 

2. Locate the Ultricore BCS node in the Tree View.

3. Expand the Ultricore BCS node to display a list of sub-nodes in the Tree View.

4. Expand the Systems sub-node.

5. Expand the Configuration sub-node.

6. Double-click the node for your Ultricore BCS.

The Device Configuration interface opens.

7. Click Licenses from the left toolbar.

8. Make a note of the character string in the Request Code field for the feature you wish to 
enable.

9. Contact Ross Video Technical Support using the information found in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility 
name, and the Request Code from the Licenses table.

b. You will be given a License Key that must be entered in the applicable field in the Licenses 
table.

10. Enter the provided License Key in the applicable License Key field in the Licenses table.

 You can also right-click on the row for the License Key you are installing, and copy the Request 
Code to or paste the License Key from the Microsoft® Windows® clipboard.

11. Click Apply in the row for the License Key you entered in step 10.

12. Verify that the Count field is updated to report each installed License Key.
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Timing Setup
This chapter outlines how to specify a time source, and adjust the time offset for your Ultricore BCS.

Specifying the Time Source
The Ultricore BCS requires an external time source in order to accurately report the time-of-day. 
The options in the Device Configuration interface enable the selection of time source via an NTP 
Server in your facility, or you can set the device time to match the computer which is running the 
current DashBoard client.

Using an NTP Server as the Time Source
 Before proceeding, contact your IT Department to learn the IP address(es) of the NTP server(s) in 

your facility. 

To specify an NTP Server as the time source for the Ultricore BCS

1. Expand the Ultricore BCS node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultricore BCS node.

The Device Configuration interface opens.

5. Locate the NTP Servers area. 

6. If you are using one NTP server, enter the IP address in the Address field of the Server 1 row.

7. If using a backup NTP server:

a. Enter the IP address of the first NTP server in the Address field of the Server 1 row.

b. Enter the IP address of the backup NTP server in the Address field of the Server 2 row.

8. Select the NTP Client Enabled box.

9. Verify that the Status field(s) in the NTP Servers table report a valid connection to the listed IP 
address(es). You may need to refresh the interface as follows:

a. Close the Device Configuration interface.

b. Re-open the Device Configuration interface by repeating steps 1 to 4 to update the field(s).

Using the DashBoard Client Computer as the Time Source
This section outlines how to set the Ultricore BCS to the local time without using an NTP Server. 
Instead, you will set the time to the values reported by the DashBoard client computer you are 
using.

 The time the Ultricore BCS reports is not linked to this computer. It is a once off setting of the 
time to match the computer time when the Set to PC Time button is selected on the Ultricore 
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BCS interface. If the DashBoard client computer time changes, you will need to update the time 
reported on the router by repeating the procedure below.

To specify the DashBoard client computer as the time source for the Ultricore BCS

1. Expand the Ultricore BCS node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultricore BCS node.

The Device Configuration interface opens.

5. Locate the Frame Information area. 

6. Click Set to PC Time. 

Configuring a Timing Offset
You can choose to offset the System Status and Device interfaces with respect to UTC Time or 
Daylight Saving Time. Note that the UTC offset does not include any Daylight Saving offset that may 
be in force. The Daylight Saving Time offset is enabled separately.

 At startup, the UTC Offset is set to 0 to ensure the displayed time matches the system time. 

To specify an offset

1. Expand the Ultricore BCS node to display a list of sub-nodes in the Tree View.

2. Expand the Systems sub-node.

3. Expand the Configuration sub-node.

4. Double-click the Ultricore BCS node.

The Device Configuration interface opens.

5. Locate the time offset options at the top of the Frame Information area.

6. To specify an UTC offset, select your current time zone offset from the UTC drop-down menu. 

Once set, the offset will be added or subtracted based off of the system clock, including NTP. 

7. To add one hour to the currently selected UTC Offset (and enable Daylight Saving Time to the 
clocks displayed in the System Clock and Device interfaces), select the Use Daylight Saving 
Time box. 
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Ultricore-IP
Ultricore-IP discovers, exposes, and controls multicast streams found on your IP network. This 
licensed feature allows scalable, easy integration of IP signals into hybrid or pure IP environments. 
The required streams can be added to your routing database as available ports. This chapter 
outlines how to configure the Ultricore-IP options, the discovery of NMOS devices, and how to 
manage the IP matrix for your routing system.

 Ensure that you have the required software licenses installed and are connected to an Ultrix 
router with at least one Ultrix-IP-IO or ULTRIX-IPX-IO blade installed. Refer to the Ultrix User 
Guide for your router to learn more.

What are Receivers, Senders, and Streams?
The following terms may be used throughout this chapter:

• Receiver — an element within a device that receives exactly one stream, which contains one flow 
from a network. If redundancy is enabled, then both sender and receiver can represent the two 
flows. 

• Sender — an element within a device which presents exactly one flow, packaged as a stream 
onto a network. 

• Stream — one flow, encapsulated within a transport protocol. Examples include SMPTE ST 
2110-20 Video, or SMPTE ST 2110-30 Audio.

Functional Overview
Ultricore-IP is an optional software license that runs on the Ultricore BCS panel that uses the same 
routing work flow regardless of the transport protocol. The number of video and/or audio streams 
the Ultricore-IP recognizes depends on the software license(s) installed for the Ultricore BCS. Refer 
to “License Keys Overview” for a list of available licenses.

 The connection between Ultricore BCS and Ultricore-IP is via Registration and Discovery Service 
(RDS).

Once the required software licenses are installed, the RDS instance running on Ultricore BCS is 
activated and all devices that support NMOS IS-04 can register themselves with it. Once Ultricore-IP 
connects within the RDS, it can add the detected devices and resources to the router matrix much 
like SDI ports.

Setup Overview
The generalized work flow of configuring the Ultricore-IP feature is:

1. Download and install the latest version of the DashBoard client software.

2. Install the Ultricore-IP software license key to enable RDS and basic NMOS-IS-04 discovery. 
Refer to “Installing a License Key”.

3. Install the additional Ultricore-IP software license key(s) to enable support for video and/or 
audio streams as per your system requirements. Refer to “License Keys Overview”.

4. Configure the PTP settings for the router (with at least one ULTRIX-IPX-IO blade) that the 
Ultricore BCS will communicate with. Refer to the Ultrix User Guide for your router.

5. Configure the IP device(s) in your routing system. Refer to the Ultrix User Guide for your router.



62 • Ultricore-IP Ultricore BCS User Guide (v11-rev8)

6. Use the Ultricore-IP interface to discover each advertised network stream via the NMOS IS-04 or 
IS-05 protocol. Refer to “Configuring the NMOS Discovery Options”, “Configuring the RDS 
Options”, and “Discovery of the RDS and NMOS Devices”.

7. Verify that the NMOS detected ports are added to the list of available ports for the routing 
system. Refer to “Monitoring via Ultricore-IP”.

8. Add the discovered NMOS ports to your database. Refer to the Ultrix and Ultricore Database 
Guide.

System Overview
The Ultricore-IP feature enables the video senders/receiver endpoints to be reported as available 
ports to the router database. The video senders/receivers can be seen as part of a single video-IP 
matrix, and the audio senders/receivers are part of a single audio-IP matrix. Or the streams belong 
to the same matrix with video and audio on different levels where each stream is reported as a 
single level despite how many channels it transports.

Figure 21  Example of a Simplified IP System with an Ultricore BCS
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Install the Ultricore-IP License on the Ultricore BCS
Refer to “Installing a License Key” for details on the available Ultricore-IP licenses and how to 
install them for your Ultricore BCS.

Accessing the Ultricore-IP Interface
Once the Ultricore-IP license is installed, and a connection is made with an Ultrix with at least one 
ULTRIX-IPX-IO blade, the Ultricore IP sub-node displays in the Tree View of DashBoard. 

To access the Ultricore-IP interface in DashBoard

1. Launch DashBoard.

2. Locate the Ultricore BCS node in the Tree View.

3. Expand the main Ultricore BCS node to display a list of sub-nodes.

4. Expand the second Ultricore BCS sub-node.

5. Expand the System sub-node.

6. Expand the Configuration sub-node.

7. Double-click the Ultricore IP sub-node.

The Ultricore IP interface displays with the Main tab automatically selected.

For More Information on...
• the available tabs and menus in DashBoard, refer to “Ultricore-IP Interface Overview”.
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Configuring the NMOS Discovery Options
This section outlines how to specify the Network Media Open Specifications (NMOS) version that 
the Ultricore-IP will use to communicate with the Registration and Discovery Service (RDS) for your 
network. The Ultricore-IP will detect the advertised streams of NMOS devices in your network (on 
the same subnet as the Ultricore BCS) and report them in the Ultricore IP interface.

To specify the NMOS Version

1. Display the Ultricore-IP interface. 

2. Select the Advanced Options tab.

The General sub-tab is automatically selected.

3. Use the Version to Connect options to select each NMOS version that the Ultricore BCS will use 
to detect streams on your network.

4. If required, use the IS-05 Preferred Version options to specify the NMOS IS-05 Connection 
service.

5. Click Apply (located in the bottom right corner of the tab).

To manually add a connection to an NMOS device

1. Display the Ultricore-IP interface. 

2. Select the Advanced Options tab.

3. Select the Static NMOS Devices tab.
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4. Click Add.

The Add Static NMOS Device dialog opens.

5. Use the IS-04 URL field to specify the IS-04 URL of an NMOS device that you wish to connect to.

6. Select the Add if Unreachable? box to report the device to the Ultricore BCS even if a valid 
connection cannot be established.

7. Click Apply.

The Add Static NMOS Device dialog closes and the Static NMOS Devices tab updates with a 
new row for the added device.

To configure the NMOS connection options

1. Display the Ultricore-IP interface. 

2. Select the Advanced Options tab.

The General sub-tab is automatically selected.
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3. Locate the Connection Manager area of the tab.

4. Use the Number of Dispatchers field to set the maximum number of connections that can be 
triggered in parallel. Each dispatcher can handle one connection at a time.

5. Select the Update Connections on Sender Changes box to enable the SDP Updates feature. 

When an active sender, that is associated with any receiver, is updated, the system will issue a 
connection update to all affected receivers. This update includes the latest information about 
the sender, including the updated SDP data.

6. Select the Keep reporting offline devices box to report a NMOS device even if a connection is 
lost to the device. The Ultricore BCS reports the device as inactive in the Debug > General tab.

7. Click Apply (located above the Stop button).

Configuring the RDS Options
This section outlines how to configure the Ultricore BCS will register in a Registration and Discovery 
Service (RDS). This allows the Ultricore-IP to detect the RDS advertised streams in your network and 
report them in the Ultricore IP interface.

 If your network has more than one Ultricore BCS running or if a third-party RDS is present, ensure 
that there is only one instance of the RDS with the same priority on the network.

To configure the Ultricore BCS registration options for RDS

1. Display the Ultricore-IP interface. 

2. Select the Advanced Options tab.

The General sub-tab is automatically selected.

3. Locate the Discovery Options area of the tab. 

4. To determine how the Ultricore BCS will register in an RDS system:

• Select the Enable mDNS Browsing box to configure the Ultricore BCS to use mDNS to 
automatically register in an RDS on the network with the lowest priority; or

• Clear the Enable mDNS Browsing box to allow the user to set an RDS IP in the Registry 
Service Address field and forces the Ultricore BCS to register to this specific RDS.

5. Select the Connect to All Priorities box to enable the Ultricore BCS to communicate with 
devices registered with the RDS at any priority.
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6. Click Apply (located above the Stop button).

To manually specify a connection to an RDS

1. Display the Ultricore-IP interface.

2. Select the Advanced Options tab.

The General sub-tab is automatically selected.

3. Select the RDS tab.

4. Click Add.

The Add RDS dialog opens.

5. Use the Name field to assign a unique identifier to this RDS. This name is used in the 
Ultricore-IP interface tabs to identify this RDS.

6. Use the IP field to specify the IP address of the RDS that the Ultricore BCS is forced to register 
to.

7. Use the Port field to specify the port used for the corresponding RDS.

8. Select the Secure box to indicate that the RDS uses the HTTPS protocol for data transfer.

9. Click Apply.

The Add RDS dialog closes and the RDS tab updates with a new row for the added RDS.
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Discovery of the RDS and NMOS Devices
The Ultricore-IP provides a quick method for establishing communication between the Ultricore 
BCS and your RDS. You can also choose to stop communication, or restart as required.

To start communications

1. Locate the bottom toolbar on the Ultricore-IP interface.

2. Click Start.

• Communication is established between Ultricore BCS and devices in the NMOS system of 
your network. The menus and fields in the Ultricore-IP tab will be automatically updated.

• Communication is established between Ultricore BCS and RDS in your network. The menus 
and fields in the Ultricore-IP tab will be automatically updated.

To stop communications

1. Locate the bottom toolbar on the Ultricore-IP interface.

2. Click Stop.

• Stops communication between Ultricore BCS and devices in the NMOS system. The menus 
and fields in the Ultricore-IP tab are no longer updated.

• Stops communication between Ultricore BCS and RDS in your network. The menus and fields 
in the Ultricore-IP tab are no longer updated.

To restart communications

1. Locate the bottom toolbar on the Ultricore-IP interface.

2. Use the Priority on Restart field to assign a priority to the Ultricore BCS when it uses mDNS to 
automatically register with an RDS on the network.

3. Click Restart.

• Disconnects and re-connects communication between Ultricore BCS and the devices in the 
NMOS system.

• Disconnects and re-connects communication between Ultricore BCS and the RDS in your 
network.

Automatic Sender Session Description Protocol (SDP) Updates
By default, a receiver is automatically updated when the associated sender changes. The Ultricore 
BCS monitors all active connections on the system. When an active sender, that is associated with 
any receiver, is updated, the system will issue a connection update to all affected receivers. This 
update includes the latest information about the sender, including the updated SDP data.

Overview
This feature is helpful to avoid receivers to be configured with a stale version of a sender. If the 
parameters of a sender changes, an SDP update is trigged. This update is then forwarded to all 
receivers that Ultricore BCS detects as subscribed to the updated sender. 

 This feature is enabled by default via the Advanced Options > General > Update Connections on 
Sender Changes setting.
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ULTRIX-IPX-IO Senders Adaptive Input
On an ULTRIX-IPX-IO blade, the senders have a configuration option that allows the stream to 
update itself following its SDI input format detected (as long as it is a valid video format). You can 
choose to limit the video format changes on a bandwidth base or just allow one fixed video format. 
In the case where the sender can follow the video that is on its input, the SDP is updated on all 
interfaces/protocols where it is available (such as NMOS, Ember+, etc.)

This update of the sender is identified by the Ultricore BCS, which in turn forwards it to all 
subscribed receivers.

For More Information on...
• cabling the ULTRIX-IPX-IO blade, refer to the Ultrix Installation Guide for your router.
• configuring the ULTRIX-IPX-IO blade, refer to the Ultrix User Guide for your router.

Editing a Stream
You can edit the streams detected and reported on your IP network via the Ultricore-IP > Main or 
Connections interfaces in the DashBoard client software. 

To edit a receiver stream

1. Display the Ultricore-IP interface.

2. Ensure the communications between Ultricore BCS and the RDS and NMOS devices is not 
active. Refer to “To stop communications”.

3. Select the Main tab.

4. Locate the Receivers area of the tab.

5. Select the row for the stream you wish to edit.

6. Click .

The Config tab opens.

 The settings and values in the Receiver Details are automatically provided by the RDS system.

7. If you are operating a redundant system, use the applicable Destination Port, Interface IP, 
Multicast IP, Source IP, and RTP Enabled fields to edit the Primary connection (first column), 
and/or the Secondary connection (second column).
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8. To disable a stream, clear the Active box.

9. Click Apply to update the receiver stream details.

The Receiver Details dialog closes and the stream is updated.

10. Start the communications between Ultricore BCS and the RDS and NMOS devices. Refer to “To 
start communications”.

To edit a sender stream

1. Display the Ultricore-IP interface.

2. Ensure the communications between Ultricore BCS and the RDS and NMOS devices is not 
active. Refer to “To stop communications”.

3. Select the Main tab.

4. Locate the Senders area of the tab.

5. Select the row for the stream you wish to edit.

6. Click .

The Config tab opens.

 The settings and values in the Sender Details are automatically provided by the RDS system.

7. Use the Ultricore Port Index field to specify the label is reported in the Ultricore BCS database 
for this stream.

8. To disable a stream, clear the Active box.

9. If you are operating a redundant system, use the applicable Destination Port, Interface IP, 
Multicast IP, Source IP, and RTP Enabled fields to edit the Primary connection (first column), 
and/or the Secondary connection (second column).

10. Click Apply to update the sender stream details.

The Sender Details dialog closes and the stream is updated.

11. Start the communications between Ultricore BCS and the RDS and NMOS devices. Refer to “To 
start communications”.
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Mapping the Streams
You can map the Ultricore-IP receiver and sender streams using the options in the Main tab.

 This procedure does not impact the active database of the Ultricore BCS nor does it perform a 
crosspoint switch. This procedure is meant to map the data from one device to another in your IP 
system before adding the streams to your routing matrix (via the database).

To route a receiver to a sender stream

1. Display the Ultricore-IP interface.

2. Select the Main tab.

3. To select the receiver stream:

a. Locate the Receivers area of the tab.

b. Select the row(s) for each source you wish to route.

4. To select the sender stream:

a. Locate the Senders area of the tab.

b. Select the row(s) for each destination you wish to route.

5. Click  in the Senders area.

 To stop routing the streams, select the streams and click  in the Receivers area.

Monitoring via Ultricore-IP
The Ultricore-IP interface reports diagnostic information for each stream and NMOS device that is 
detected by the Ultricore BCS. This information is helpful for troubleshooting connections, verifying 
communications, and monitoring memory statistics, stream interrupts, and other errors. This 
section outlines how to access the Ultricore-IP monitoring features.

 Primary and redundant stream information is monitored individually.

To view the settings for a device

1. Display the Ultricore-IP interface.

2. Select the Main tab.
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3. In the Devices area, select the row for the device.

4. Click Details.

The Info and Alarms tabs display.

5. Use the Info tab to review the IP settings, PTP settings, number of sessions, and active ethernet 
ports.

6. Select the Alarms tab to review the reported error conditions. A short description is provided 
for each error.

To view the traffic from a device

1. Select the Debug tab.

2. Select the Connection Statistics tab.

 You may wish to click Refresh Statistics to update the tab contents.

3. In the Resources area, locate the row for the device.
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To monitor a stream 

1. Display the Ultricore-IP interface.

2. Select the Main tab.

3. To monitor a receiver stream:

a. In the Receiver area, select the row for the stream.

b. Click Details.

4. To monitor a sender stream:

a. In the Sender area, select the row for the stream.

b. Click Details.

To monitor a connection

1. Display the Ultricore-IP interface.

2. Select the Debug tab.

3. Select the Connections Statistics sub-tab.
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To monitor the NMOS traffic

1. Display the Ultricore-IP interface.

2. Select the Debug tab.

3. Select the General sub-tab.

Ultricore-IP Interface Overview
The Ultricore-IP interface in DashBoard is organized into a series of tabs at the top: Main, 
Connections, Debug, and Advanced Options. The bottom toolbar provides read-only information 
and global settings. (Figure 22) This section summarizes these tabs, and the bottom toolbar 
features.

Figure 22  Example of the Ultricore-IP Interface

Main Tab
The Main tab is organized into three areas: Devices (top), Receivers (left), and Senders (right). 
Table 11 summarizes the areas and fields of the Main tab.
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Table 11  Ultricore-IP — Main Tab

Item Description
Devices

Details Opens the Info and Alarms tabs on the right side of the window. 
The Info tab reports additional read-only information that is not 
reported on the Main tab for this device. This includes information 
such as the IP address, PTP Domain, number of active sessions, 
and detected error conditions.
The Alarms tab provides additional information on any error 
conditions with the selected device.

Device Name Reports the unique identifier of the device as assigned by the 
master NMOS device

Device ID The Node ID assigned to the device for NMOS communication

Senders The total number of advertised audio and video sender streams 
from this device 

Receivers The total number of audio and video receiver streams available 
from this device

Active connections The number of active NMOS connections on this device

Ross Indicates if the device is a Ross Video product or not

Status A summary of the alarms detected on the device. The most severe 
alarm is noted and the total number of alarms is also reported.

Receivers

Details Opens the Config tab on the right side of the window. 
The Config tab provides reports read-only information that is not 
reported on the Main tab for this receiver stream. This includes 
information such as the Sender ID, Destination Port, Interface IP, 
Multicast IP address, and Source IP address. You can also 
enable/disable RTP, edit the database label, enable/disable this 
stream, configure the primary and secondary settings when 
operating in a redundancy setup. 

Column Visibility Displays a dialog that enables you to specify the Receivers columns 
to show/hide on the Ultricore-IP > Main interface

Connect/Disconnect Click the Connect button to create a connection between the 
selected Receiver and Sender streams.
Click the Disconnect button to cancel the connection between the 
selected Receiver and Sender streams.

Device Name Reports the unique identifier of the device (as assigned by the 
master NMOS device) that is receiving this stream

Device ID The unique ID assigned to the NMOS device that is transmitting 
this stream to the Ultricore-IP

Resource Name The NMOS node label assigned to this receiver stream. When 
referring to an Ultrix router, the nomenclature of 
Slot.Port.ip-Type.Channel is used. For example, 
slot1.out[2].ip-video.ch1.

Media Type Specifies the type of data that the receiver stream will transport 
(video, audio, ancillary, etc.)
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Connection Tab
The Connection tab provides a list of all connections that are created on the system which includes: 
what device this connection belongs to, the ID of the receiver and sender, and any alarms that 
might be present on that connection.

Ultricore Port Index Specifies the label is reported in the Ultricore BCS database for this 
stream 

Resource ID The unique ID assigned to this receiver stream

Enabled This receiver stream is active and is available to the Ultricore-IP

DB Registered This receiver stream is made available to the Ultricore BCS 
database

Senders

Details Opens the Config tab on the right side of the window. 
The Config tab provides additional read-only information that is 
not reported on the Main tab for this sender stream. This includes 
information such as the Color Space, the aspect ratio, SDP value, 
and Destination IP. You can also edit the database label, 
enable/disable this stream, and set up a redundant system by 
configuring the Primary and Secondary settings. 

Column Visibility Displays a dialog that enables you to specify the Senders columns 
to show/hide on the Ultricore-IP > Main interface

Connect/Disconnect Click the Connect button to create a connection between the 
selected Receiver and Sender streams.
Click the Disconnect button to cancel the connection between the 
selected Receiver and Sender streams.

Device Name Reports the unique identifier of the device (as assigned by the 
master NMOS device) that is sending this stream

Device ID The ID assigned to the sending device for NMOS communications

Resource Name The NMOS node label assigned to this sender stream. When 
referring to an Ultrix router, the nomenclature of 
Slot.Port.ip-Type.Channel is used. 
For example, slot1.out[2].ip-video.ch1.

Media Type Specifies the type of data that the sender stream will transport 
(video, audio, ancillary, etc.)

Media Detail Provides a summary of the resource media type (video format, 
audio codec, etc.)

Ultricore Port Index Specifies the label is reported in the Ultricore BCS database for this 
stream

Resource ID The unique ID assigned to this sender stream

Enabled The sender stream is active and is available to the Ultricore-IP

DB Registered This sender stream is made available to the Ultricore BCS database

Table 11  Ultricore-IP — Main Tab (Continued)

Item Description
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Figure 23  Ultricore-IP — Connection Tab

Table 12 summarizes the fields and menus of the Connection tab.

Table 12  Ultricore-IP — Connection Tab

Item Description
Connection Usage (Used/Limit)

Type Specifies the type of data that the connections are transporting 
(video, audio, ancillary)

Ross Reports the number of connections to a Ross Video product (such 
as Ultrix-IPX, NEWT-IPX, and IGGY-MADI)

Others Reports the number of connections to a third-party NMOS device

Connections

Details Opens the Connections Details tab. This tab provides additional 
read-only information that is not reported on the tab for this 
connection. This includes information such as 

Delete Removes the connection from the list

Device Name Reports the unique identifier of the device (as assigned by the 
master NMOS device) for a specific connection

Device ID The ID assigned to the device for NMOS communications

Receiver ID The unique ID assigned to this receiver stream of this connection

Receiver Name Reports the connection label that will be reported in the Ultricore 
BCS database. When referring to an Ultrix router, the 
nomenclature of Slot.Port.ip-Type.Channel is used. For 
example, slot1.out[2].ip-video.ch1.

Receiver Type Specifies the type of data that the connection transports (video, 
audio, ancillary)

Sender ID The unique ID assigned to the sender stream of this connection

Status Provides a summary of the error conditions detected on the 
specified connection. To view a detailed summary of the errors, 
select the row for the connection and click .
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Debug Tab
The Debug tab enables you to monitor and troubleshoot the RDS session(s) of the Ultricore BCS. 
There are two sub-tabs: General and Connection Statistics. 

Figure 24  Ultricore-IP — Debug > General Tab

Table 13 summarizes the fields and menus of the Debug > General tab.

Table 13  Ultricore-IP — Debug > General Tab

Item Description
NMOS RDS

Active Determines if the specific RDS session is enabled or disabled

Name Reports the unique identifier of the detected RDS

Priority The RDS priority (selected from a range of 0 to 99 where 0 is the 
highest priority). 
Note that when there is more than one RDS with the same priority, 
problems may arise on the network because devices and 
controllers cannot differentiate RDS with the same priority and 
they might connect to different ones, generating situations where 
the controllers do not see the devices.

IP Reports the IP Address of the detected RDS

Port Reports the UDP port of the detected RDS

Protocol Reports the transfer protocol the RDS is using for its Application 
Programming Interface (API)

Version Supported Indicates the NMOS version the RDS can support for 
communications

Statistics

This area reports the resources found on the RDS it is connected to and how many of 
those devices the Ultricore BCS was able to parse as valid.
If the device type or the resource type is not valid or not recognized by the Ultricore BCS, 
the Total Valid Found field will report smaller numbers than the line reporting the 
numbers found on the RDS.
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Table 14 summarizes the fields and menus of the Debug > Connection Statistics tab.

Advanced Options Tab
The Advanced Options tab provides additional settings for RDS discovery, NMOS communication, 
and connection management. You can also create connections to specific RDS and NMOS devices in 
your IP system. These settings are organized into three sub-tabs: General, RDS, and Static NMOS 
Devices.

Open Web Sockets

Ultricore-IP connects to the RDS using web sockets. This area lists the detected open 
connections. For example, if you select Advanced Options and set the NMOS IS-04 
version to v1.2 and v1.3, this field reports the entries for each connected version.

Table 14  Ultricore-IP — Debug > Connection Statistics Tab

Item Description
Clear Statistics Resets all fields on the Connection Statistic tab 

Refresh Statistics Updates the fields on the Connection Statistic tab

Global

Description Provides a summary of the type of request the Ultricore BCS 
issued on all connections

Total Requests Reports the total number of requests the Ultricore BCS sent of this 
type via all connected RDS

Failures Reports the number of failed attempts the Ultricore BCS made of 
this request type via all connected RDS

Timeout Reports how long the Ultricore BCS waited before declaring the 
request ignored and re-sending the request on the RDS

Max Request 2s Reports the number of requests the Ultricore BCS sent of this type 
within a 2 second period

Internal Delay 
Average (us)

Reports the average delay length between issuing the request and 
the acknowledge that it was received

Min (us) Reports the lowest number of requests the Ultricore BCS issued

Max (us) Reports the highest number of requests the Ultricore BCS issued

Resources

Resource Reports the Device ID of a connected NMOS device

Description Reports if the connection is a transceiver, receiver, or sender, and 
the type of data (audio, video, ancillary)

Add This area summarizes the connection statistics for all connection 
requests made by this resource

Remove This area summarizes the disconnect/remove statistics for all 
connection requests made by this resource

Table 13  Ultricore-IP — Debug > General Tab (Continued)

Item Description



80 • Ultricore-IP Ultricore BCS User Guide (v11-rev8)

Figure 25  Ultricore-IP — Advanced Options > General Tab

Table 15 summarizes the fields and menus of the Advanced Options > General tab.

Table 15  Ultricore-IP — Advanced Options > General Tab

Item Description
Discovery Options

Enable mDNS 
Browsing

Select the box to configure the Ultricore BCS to use mDNS to 
automatically register in an RDS on the network with the lowest 
priority; or
Clear the box to allow the user to set an RDS IP in the Registry 
Service Address field and forces the Ultricore BCS to register to this 
specific RDS.

Connect to all 
Priorities

Select the box to enable the Ultricore BCS to communicate with 
devices registered in the RDS at any priority; or
Clear the box to configure the Ultricore BCS to communicate with 
devices registered in the RDS at a specific priority

Version to Connect

Specifies the version of NMOS the Ultricore BCS will use to communicate with devices on 
the network

IS-05 Preferred Version

Specifies the NMOS IS-05 connection service the Ultricore BCS will use to communicate

Connection Manager Options

Number of 
Dispatchers

Sets the maximum number of connections that can be triggered in 
parallel. Each dispatcher can handle one connection at a time 

Update Connections 
on Sender Changes

Select this box to enable the SDP Updates feature. 
When an active sender, that is associated with any receiver, is 
updated, the system will issue a connection update to all affected 
receivers. This update includes the latest information about the 
sender, including the updated SDP data.
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Table 16 summarizes the fields and menus of the Advanced Options > RDS tab.

Table 17 summarizes the fields and menus of the Advanced Options > Static NMOS Devices tab.

Bottom Toolbar
The bottom toolbar of the Ultricore-IP interface provides a quick method for establishing 
communication between the Ultricore BCS and your RDS. You can also choose to stop 
communication, or restart as required.

Offline Devices

Keep reporting 
offline devices

If a connection is lost to an NMOS device, the Ultricore BCS will still 
reports the device and its streams, but the device is noted as 
inactive in Debug > General tab.

Table 16  Ultricore-IP — Advanced Options > RDS Tab

Item Description
User Defined RDS

Add Displays the Add RDS dialog.
Use this dialog to manually define a specific Registration and 
Discovery Service (RDS). This will force the Ultricore BCS to register 
to this specific RDS.

Name Reports the unique identifier of the specified RDS

Address Reports the IP address of the specified RDS

Table 17  Ultricore-IP — Advanced Options > Static NMOS Devices Tab

Item Description
Static NMOS Devices

Add Displays the Add Static NMOS Device dialog. 
Use this dialog to specify the IS-04 URL of a device that you wish to 
connect to. This is useful if you wish to add a device that is 
available on a separate RDS system.

Device Name Reports the unique identifier of the device (as assigned by the 
master NMOS device) for a specific connection

Device ID Reports the ID assigned to the device for NMOS communications

IS-04 URL Reports the IP address of this NMOS device

Polling Period

Polling Period Determines how often the Ultricore BCS will contact this device to 
verify the connection

Reset Sets the Polling Period to the previous value

Apply Updates the Polling Period with the edited value

Table 15  Ultricore-IP — Advanced Options > General Tab (Continued)

Item Description
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Figure 26  Example of the Bottom Toolbar on the Ultricore-IP Interface

Table 18 summarizes the bottom toolbar features of the Ultricore-IP interface. 

Table 18  Ultricore-IP — Bottom Toolbar

Item Parameters Description
Ultricore-IP

Status (read-only) active • Ultricore-IP is running
• If an RDS is present on the network, 

Ultricore-IP will connect to it and show the 
content found for the selection NMOS 
versions it is configured to

inactive Ultricore-IP does not detect an RDS running on 
the network

RDS Service

Status (read-only) active The RDS instance for this Ultricore BCS is 
running and waiting for devices to register

inactive The RDS instance for this Ultricore BCS is 
disabled and not available for use

Priority on Restart

# After the Restart button is selected, the Ultricore BCS uses mDNS 
to automatically register in an RDS on the network with the 
specified priority

Start Communication is established between Ultricore BCS and devices 
in the NMOS system of your network. The menus and fields in the 
Ultricore-IP tab will be automatically updated.
Communication is established between Ultricore BCS and RDS in 
your network. The menus and fields in the Ultricore-IP tab will be 
automatically updated. 

Stop Stops communication between Ultricore BCS and devices in the 
NMOS system. The menus and fields in the Ultricore-IP tab are no 
longer updated.
Stops communication between Ultricore BCS and RDS in your 
network. The menus and fields in the Ultricore-IP tab are no longer 
updated.

Restart Disconnects and re-connects communication between Ultricore 
BCS and the devices in the NMOS system.
Disconnects and re-connects communication between Ultricore 
BCS and the RDS in your network.
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Enabling a Service
The Ultricore BCS supports a set of third-party communications protocols that allow the Ultricore 
BCS to communicate with devices in your routing system. Before creating a connection point to 
each device, you must first enable the required protocol(s) on the Ultricore BCS, and configure any 
settings required for communication. This chapter outlines how to enable a communication service 
(protocol), and configure the additional settings on the Ultricore BCS for each protocol (if required). 
A summary of the supported commands is also provided.

If you have questions about the operation of your Ross devices, contact us at the numbers listed in 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

For More Information on...
• establishing a connection point to a device in your routing system, refer to the Ultrix and 

Ultricore Database Guide.

Enabling a Communication Service
Use the options in the System > Configuration > Connections > Services interface to enable or 
disable each required service (protocol). This allows the Ultricore BCS to communicate with an 
external device that uses each enabled third-party protocol.

To enable a service

1. Locate the Ultricore BCS node in the Tree View of DashBoard

2. Expand the Ultricore BCS node to display a list of sub-nodes.

3. Expand the System sub-node.

4. Expand the Configuration sub-node.

5. Double-click the Connections sub-node.

6. Select the Services tab.

The Services tab lists the available communications protocols and provides options for 
enabling/disabling each protocol for the Ultricore BCS.

 Some services require that a license key is also enabled. Refer to “Software License Keys”.

7. Enable or disable a service by selecting or clearing the associated box. Choose from the 
following:

• SSH service — Enables the ability to log onto the Ultricore BCS via an SSH server. Secure Shell 
(SSH) Login is a client-server protocol used by system administrators to securely log onto 
remote systems and execute commands over an unsecured network. SSH may also be used 
by Ross Technical Support for advanced troubleshooting.

• Walkabout — Enables the Ultricore BCS to communicate with Ross Video devices in the 
Walkabout system.

• Ember Plus — Enables the Ultricore BCS to communicate with a third-party control system via 
the Ember+ media distribution protocol.

• GVG Native — Enables the Ultricore BCS to communicate via the GVG Series 7000 Native 
protocol and is available over an RS-422 or RS-232 serial connection, or ethernet connection.

• Nvision — Enables the Ultricore BCS to communicate via a limited sub-set of the NVISION 
serial NP0010 protocol, and the NVISION NP16 ethernet protocol. 



84 • Enabling a Service Ultricore BCS User Guide (v11-rev8)

• Probel SW-P-08 — Enables the Ultricore BCS to communicate via the Probel SW-P-08 
protocol. This protocol is available over an RS-422 or RS-232 serial connection, as well as an 
ethernet connection.

• RossTalk — Communications via the RossTalk protocol (a plain text based protocol that 
allows control of Ross Video equipment).

• TSL — Enables the Ultricore BCS to communicate via the TSL UMD v3.1, TSL UMD v4.0, and 
TSL UMD v5.0 protocols.

• NK/RCP — Enable this option if there are Ross NK series devices or signal types the Ultricore 
BCS itself does not handle. The Ross NK series devices must be connected to the ethernet 
network by virtue of an Ross NK-IPS or NK-NET devices to enable communication with the 
Ultricore BCS.

• Web Access — Remote access and upgrades are disabled by default (the Upload button is 
disabled in the DashBoard interfaces). Remote upgrades may optionally be enabled through 
DashBoard via this option. Select this option if you wish to setup a redundant system, 
upgrade the Ultricore BCS or as directed by Ross Technical Support. This option is disabled by 
default.

On bootup or power cycle, the Web Access option will default back to disable (box is unselected). 
You must select the box again if you wish to enable web access and firmware upgrades after a 
bootup or power cycle.

8. Click Apply.

Configuring the Service Settings
The Protocol Servers tab lists the currently active servers running in the routing system. This tab is 
auto-populated based on the external devices on the same network as your router and using the 
protocols enabled in the Services tab. Some services require you to configure additional settings on 
the router. This section briefly summarizes those additional settings.

For More Information on...
• the supported protocols, refer to “Server Options and Supported Commands”.

To configure the protocol settings

1. Locate the Ultricore BCS node in the Tree View of DashBoard

2. Expand the Ultricore BCS node to display a list of sub-nodes.

3. Expand the System sub-node.

4. Expand the Configuration sub-node.

5. Double-click the Connections sub-node.

6. Select the Protocol Services tab.
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7. Click Options (located in the bottom toolbar).

The Server Options dialog opens.

8. Locate the options for the third-party protocol you wish to configure for communications.

9. Refer to the following sections for a summary of the settings based on the protocol.

10. Click Apply.

The Server Options dialog closes and the new settings are applied.

Server Options and Supported Commands
Some protocols require additional settings be configured on the router. The following sections 
outline these required settings based for each protocol.

GVG Series 7000 Native Protocol Commands
The router supports the GVG Series 7000 Native protocol and is available over an RS-422 or RS-232 
serial connection, as well as an ethernet connection. Refer to Table 19 for connection details.

Table 19  Default GVG Native Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet
Port (incoming) 12345

Port (outgoing) 12345a

a. For outgoing connections, port 12345 is the default 
value but is user configurable.



86 • Enabling a Service Ultricore BCS User Guide (v11-rev8)

Table 20 summarizes the Server Options for the GVG Series 7000 Native protocol.

  

Refer to Table 21 for a list of supported GVG Native Protocol commands.

Table 20  Server Options — GVG Series 7000 Native

Option Setting Notes
L4 Echo Yes Send command acknowledgments on 

protocol layer 4 (Ethernet only)

No Do not send acknowledgments. This is the 
default.

Sequence More 
to Come 
Character

# Enables the user to assign a number to the 
seq_flag field in a packet that will indicate 
more messages to come. The default value is 
9. 
A value of 0 (zero) indicates the last or only 
packet.

Send Trailing HT Yes Includes the trailing <HT> character 
(Horizontal Tab (0x09)) in the packet

No The trailing <HT> character is not included in 
the packet

Send nbr_sources 
Leading Zero

Yes Always forces the nbr_sources field to be 2 
ASCII characters (e.g. 1 becomes 01). This 
supports fragmentation of large message 
streams.

No Allows the nbr_sources field to be a single 
ASCII character

Repeated Packet 
Holdoff (ms)

# Ultricore BCS detects repeated identical 
packets, and will skip processing if the 
packets are repeated within the specified 
delay. The default is 0.

Table 21  GVG Native Protocol Commands

Message
NotesCommand Description

BK[,parameter]
BK,D Force next QD command to return 

status of all destinations
Clears the flags associated with the D,no_parameter 
command. After BK,D is sent, the next QD,no_parameter 
command will result in destination statuses or all 
destinations being returned.

BK,E Request status of level 4 echo setting

BK,E,ON Set level 4 echo to on An err=00 response will be returned for successful 
commands that do not generate their own response (e.g. 
Take commands).
This is a per session setting.

BK,E,OFF Set level 4 echo to off (default) No response will be given for commands that do not 
generate their own response.

PR,dest_name,level_bitmap Protects a specific destination from 
having its source changed

ER error-code response is currently not supported.

QC[,dest_name] Query Combined Destination status by 
name

QD[,dest_name] Query Destination status by name No information is returned for unmatched destination levels
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For More Information on...
• these commands, refer to the GVG protocol documentation.

NVISION Commands
This section outlines the NVISION protocol commands supported by the router.

 Ensure that the Ultricore-NVISION license is installed for your router. Refer to the Ultrix User 
Guide for details.

Table 22 summarizes the settings in the Server Options dialog for the NVISION protocol.

  

Qd[,dest_name] Query Destination status by name Sets response src_name to NO_XPT for unmatched 
destination levels

QI,destIndex,lvlIndex Query Destination status by indexa

Qi,destIndex,lvlIndex Query Destination status by indexa The srcIndex returned will be 0xfffe if an error condition 
applies to the crosspoint being reported.

QJ[,destIndex] Query Destination status by indexa No information is returned for unmatched destination levels

Qj Query Destination status by indexa Sets response srcIndex to 0xFFFe for unmatched destination 
levels

QN,parameter
QN,S Query source names/labels As defined inactive database

QN,D Query destination names/labels As defined inactive database

QN,L Query level names/labels As defined inactive database

QN,IS Query names via source indexa

QN,ID Query names via destination indexa

QT Query date and timea

TA,dest_name,nbr_sources,src_name_
entry1[,...src_name_entryn]

Takes sources (on specified levels) to 
specified destination, by name rather 
than index

Src_name_entryn = src_name,level_bitmap

TD,dest_name,src_name_entry Takes same source to all or specified 
levels

Src_name_entryn = src_name[,levelbitmap]
No levelbitmap=all destination levels

TI,destIndex,srcIndex[,levelIndex] Request take by index with level indexa

TJ,destIndex,nbr_sources,srcIndex,lev
el_bitmap[,...,srcIndex,level_bitmap]

Takes sources (on specified levels) to 
specified destinations by index rather 
than name; allows breakaways

TS,salvo_name Request Take Salvo TS,salvo_name

UP,dest_name,level_bitmap Removes Protect from specified 
destination

ER, error-code response is currently not supported.

a. Zero-based hex logical index numbering.

Table 22  Server Options — NVISION Protocol

Option Setting Notes
Offset 0 The Ultricore BCS level matches the NVISION 

level

1 The Ultricore BCS level is the NVISION level 
plus 1

Table 21  GVG Native Protocol Commands (Continued)

Message
NotesCommand Description
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NVISION NP16 Ethernet Protocol

The router supports the NVISION NP16 Ethernet protocol. Table 23 outlines the default values for 
the router when using NP16.

NP16 Commands

The NP16 protocol defines the message format as follows: 

Protocol ID | Sequence Number | byte count | Command

Each field consists of a 32bit number where:

•  Protocol ID — 0x0000000C (Router Control Protocol)
•  Sequence number — controller generated and added to Ultricore BCS response message
•  byte count — total number of bytes in message including header (<8176)
•  Command — refer to Table 24.

 The protocol is zero based, meaning that destination 0 in the protocol relates to destination ID#1 
in Ultrix. This is true for sources, destinations, and level values.

Refer to Table 24 for a list of supported NP16 commands.

NVISION NP0010 Serial Protocol

The router supports a limited sub-set of the NVISION serial NP0010 protocol.

Table 25 outlines the router default values for an NP0010 serial connection.

Table 23  Default Connection Types — NVISION NP16

Setting
TCP Port 5194

Table 24  NP16 Protocol Commands

Message
NotesCommand Description

0x0000 0050 Performs a TAKE

0x0000 0051 Set Output LPR Sets or releases a lock or protect on a 
destination

0x0000 0052 Get Status of Outputs Retrieves the crosspoint status

0x0000 0059 Router Partition Information

0x0000 005E Crosspoint Tally Retrieves the crosspoint status

0x0000 0070 Machine Control Take Format 1 only

Table 25  Default Connection Types — NVISION NP0010 Serial

Setting
Connection Type RS232, RS422

Baud 9600, 19200, 38400, 56700, 
115200

Data Bits 8

Parity No

Stop Bits 1
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Refer to Table 26 for a list of supported NP0010 commands.

Probel SW-P-08 Protocol Commands
The router supports the Probel SW-P-08 protocol and is available over an RS-422 or RS-232 serial 
connection, as well as ethernet connection. Table 27 provides the default values for this protocol.

 

When Ultricore BCS is the controller, Probel SW-P-08 System 1 is implemented. When Ultricore 
BCS is not the controller, Probel SW-P-08 System 3 is implemented (where equipment functions 
exist). 

Table 28 summarizes the settings in the Server Options dialog for the Probel SW-P-08 protocol.

  

Table 26  NP0010 Protocol Commands

Message
NotesCommand Description

0x50 Take Non-timestamped version only

0x51 Destination status Get destination status

0x55 Lock destination Assert a destination lock

0x56 Protect destination Assert a destination protect

0x58 Release destination lock/protect Releases the destination lock and protect

0x66 Destination LPR state Get destination locked/protect/released 
status

Table 27  Default Probel SW-P-08 Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet
Port (incoming) 8910

Port (outgoing) 8910a

a. For outgoing connections, port 8910 is the default 
value but is user configurable.

Table 28  Server Options — Probel SW-P-08 Protocol

Option Setting Notes
Protocol Variant Non-extended Use non-extended commands only

Extended Use extended commands only

Use Last Request Use command set as per last received command 
format (e.g. if received a non-extended 
command, reply in a non-extended format). This 
is the default.
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Table 29 lists the supported Probel SW-P-08 Serial Protocol commands.

Matrix Mode Yes Swap matrix and level fields

No Do not swap matrix and level fields. This is the 
default.

Unused Field # Send number (0-15) in either Level or Matrix field 
- which ever is not used as per Matrix Mode 
setting. The default is 0.

Do not wait for ACK Yes Ultricore BCS will not wait for message 
acknowledgments between connect responses

No Ultricore BCS will wait for message 
acknowledgments between connect responses. 
This is the default.

Batch Collate Timea # milliseconds Wait up to 100 milliseconds for multiple 
commands received before processing. The 
default is 0 (which disables this feature). 

Batch Collate Split 
Size

# received 
commands

Wait up to 100 received commands before 
processing. The default is 0 (which disables this 
feature). 

Repeated Packet 
Holdoff (ms)

# Ultricore BCS detects repeated identical packets, 
and will skip processing if the packets are 
repeated within the specified delay. The default 
is 0.

a. When both Batch Collate Split Size and Batch Collate Time are both active, the option that occurs first will 
release the batch, and the Batch Collate Split Size and the Collate Time values are reset.

Table 29  Probel SW-P-08 Native Protocol Commands

Request Message Response Message
NotesCmd ID Description Cmd ID Description

01 Crosspoint Interrogate 03 Crosspoint Tally Get single crosspoint status

02 Crosspoint Connect 04 Crosspoint connected Take single crosspoint

10 Protect Interrogate 11 Protect Tally Get destination protect 
status

12 Protect Connect 13 Protect connected Set destination protect

14 Protect Disconnect 15 Protect dis-connected Turn off destination protect

17 Protect Device Name Request 18 Protect Device Name Response Get name of device that hold 
protect

19 Protect Tally Dump Request 20 Protect Tally Dump Get all protect status

21 Crosspoint Tally Dump Request 22, 23 Crosspoint Tally Dump Get all crosspoint status
Cmd22: Byte max dest 191
Cmd23: Word max. dest. 
65535 

97 Implementation Request 98 Implementation Status Get list of commands 
supported

100 All Source Names Request 106 Source Name Response Get all source names (8 char. 
max.)

101 Single Source Name Request 106 Source Name Response Get single source names (8 
char. max.)

Table 28  Server Options — Probel SW-P-08 Protocol (Continued)

Option Setting Notes
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RossTalk Commands
The RossTalk protocol is a plain text based protocol that allows control of Ross Video equipment.

 Each command should be terminated by a carriage return and a line feed (CR/LF).

To send RossTalk commands to the router

1. Create a network connection to the Ultricore BCS on Port 7788.

2. At the prompt, enter the commands you wish to send. Refer to Table 30 for a list of supported 
commands.

102 All Destination Association Name 
Request

107 Destination Association Name 
Response

Get destination names (8 
char. max.)

103 Single Destination Association Names 
Request

107 Destination Association Name 
Response

Get single destination name 
(8 char. max.)

104 All UMD Labels Request 108 UMD Label Response Only one set of labels is 
currently supported. UMD 
Labels replicate source 
labels. (16 char. max.)

105 Single UMD Labels Request 108 UMD Label Response Get single source label (16 
char. max.)

120 Crosspoint Connect On Go Group Salvo 122 Crosspoint Connect On Go Group Salvo 
Acknowledge

Add crosspoint to preset 
group

121 Crosspoint Go Group Salvo 123 Crosspoint Go Done Group Salvo 
Acknowledge

Switch/clear preset group

124 Crosspoint Salvo Group Interrogate 125 Crosspoint Group Salvo Tally Preset group status

EXTENDED
129 Extended Crosspoint Interrogate 131 Extended Crosspoint Tally Get crosspoint status

130 Extended Crosspoint Connect 132 Extended Crosspoint Connected Take single crosspoint

138 Extended Protect Interrogate 139 Extended Protect Tally Get destination protect 
status

140 Extended Protect Connect 141 Extended Protect Connected Protect a destination

142 Extended Protect Disconnect 143 Extended Protect Disconnected Turn off protect for a 
destination

147 Extended Protect Tally Dump 148 Extended Protect Tally Dump Message Get all protect status for 
given level

149 Extended Crosspoint Tally Dump 151 Extended Crosspoint Tally Dump Word 
Message

Get destination status for 
given level

228 Extended All Source Names 234 Extended Source Name Response Get source names (8 char 
max.)

229 Extended Single Source Name 234 Extended Source Name Response Get single source name (8 
char max.)

230 Extended All Destination Association 
Names

235 Extended Destination Association 
Names Response

Get all destination names (8 
char. max.)

231 Extended Single Destination 
Association Name

235 Extended Destination Association 
Names Response

Get single destination name 
(8 char. max.)

232 Extended Single UMD Label Request 236 Extended UMD Labels Response Get all source labels (16 char. 
max.)

233 Extended Single UMD Label Request 236 Extended UMD Labels Response Get single source label (16 
char. max.)

248 Extended Crosspoint Connect On Go 
Group Salvo

250 Extended Crosspoint Connect On Go 
Group Salvo Acknowledge

Preset group acknowledge

252 Extended Crosspoint Group Salvo 
Interrogate

253 Extended Crosspoint Group Salvo Tally Preset group status

Table 29  Probel SW-P-08 Native Protocol Commands (Continued)

Request Message Response Message
NotesCmd ID Description Cmd ID Description
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For More Information on...
• adding a RossTalk label to an Ultriscape layout, refer to the Ultriscape User Guide.

TSL UMD Protocol v3.1 Commands
Table 31 outlines the default values for the router when using TSL UMD v3.1.

Table 30  RossTalk Protocol Commands

Message
NotesCommand Description

GPI ## Execute the salvo number corresponding to the 
numerical ## extension of the command

For example, GPI 04 triggers the salvo 
<salvo_name>[4] as listed in the Ultricore BCS 
database

TIMER ##:RUN Request Timer ID to start/resume

TIMER ##:STOP Request Timer ID to stop

TIMER ##:PAUSE Request Timer ID to pause

TIMER ##:END Request Timer ID to end

TXTLABEL ID:<id>; TEXT:<text>; 
BGCLR:<bgcolor>; TXTCLR:<textcolor>

Where:
• <id> is a unique “rosstalk id” associated with 

an Ultriscape RossTalk display object. This 
field is compulsory.

• <text> is the text to be displayed. This field is 
optional.

• <bgcolor> is the background color of the text 
label. Specified in comma separated RGB 
format using 2 byte hex values (e.g. 
RR,GG,BB). This field is optional.

• <textcolor> is the text color of the text label.                
Specified in comma separated RGB format 
using 2 byte hex values (e.g. RR,GG,BB). This 
field is optional.

There is a 20 character maximum.
Messages with only the id field will be ignored. 
The following is an example of a message:
TXTLABEL ID:25; TEXT:CAM1; 
BGCLR:0x00,0x00,0x00; 
TXTCLR:0xFF,0xFF,0xFF

Note that <bgcolor> and <textcolor> are 
specified as R,G,B triplet. For example:
• 255,255,255 or 0xff,0xff,0xff is white

• 0,0,0 or 0x0,0x0,0x0 is black

• 255,0,0 or 0xff,0x0,0x0 is red 

XPT D:<dest> S:<source> I:<user_id> [L:<levels>] Crosspoint command for a router TAKE where:
• <dest> is the logical destination ID from the 

active database (1-based)

• <source> is the logical source ID from the 
active database (1-based)

• <user_id> is the numeric user/panel ID that 
will be used to request the switch

• <levels> is an optional parameter specifying 
comma-separated list of 1-based level IDs to 
switch (for breakaway, e.g. L:1,2,4). If no 
levels are specified, a follow switch (all valid 
levels) is requested. 

• <levels> supports ranges specified by two 
numbers separated by dash (e.g. L:1-16)

Range start value must be less than the end 
value
Single levels and ranges can be mixed in the 
list (e.g. L:1,3,4-8,12-17)
There are no spaces between numbers or 
ranges
Invalid numbers or improperly specified 
ranges will be ignored 
An argument is separated from its value using 
a single colon (:)
Command arguments are separated single 
spaces
The arguments may be specified in any order, 
(e.g. these are equivalent: XPT D:1 S:4 I:2 and 
XPT S:4 I:2 D:1)
Examples:
• ID 7 requesting to switch Dest 2 to Source 1 

on Levels 1,3,5 and 12-16

• XPT I:7 D:2 S:1 L:1,3,5,12-16

Table 31  Default Connection Types — TSL UMD v3.1

Setting
Serial
Connection Type RS422

Baud 38400
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Protocol Implementation

The router implements the protocol with the following structure:

 DisplayID|Control|DisplayData

Table 32 lists the supported TSL UMD Protocol v3.1 commands. 

Data Bits 8

Parity Even

Stop Bits 1

Ethernet
TCP Port 5727

UDP Port 4490

Table 32  TSL UMD Protocol v3.1 Commands

Protocol 
Breakdown Description Ultriscape System Use

Display Address 0 - 126 display identification enumeration DisplayID associated with source or destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Tally 1 (Red)a

a. Green/Red may be swapped by configuring the Global Tally Settings in the Ultriscape Head 
interface.

Bit 1 Tally 2 status Tally 2 (Green)a

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bits 4-5 Brightness value Not used

Bit 6 Reserved Not used

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h-3Eh) UMD display text

Table 31  Default Connection Types — TSL UMD v3.1 (Continued)

Setting
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Refer to Table 33 when using TSL UMD v3.1 and configuring PiP Tallies in an Ultriscape Head. 

TSL UMD Protocol v4.0 Commands
 Table 34 outlines the default values for the router when using TSL UMD v4.0.

Protocol Implementation

The router implements the protocol with the following structure: 

Header | Control | DisplayData | VBC | XData

Table 35 lists the supported TSL UMD Protocol v4.0 commands.

Table 33  Ultriscape Tally Display — TSL UMD v3.1

Red Tally Green Tally Display
ON ON RED IS ON

ON OFF RED IS ON

OFF ON GREEN IS ON

OFF OFF OFF (no tallies are lit)

Table 34  Default Connection Types — TSL UMD v4.0

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet
TCP Port 5728

UDP Port 4491

Table 35  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description Ultriscape System Use

Header 0x80 + 0 - 126 display address DisplayID associated with source or destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Not used

Bit 1 Tally 2 status Not used

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bit 4-5 Brightness value Not used

Bit 6 0=display data, 1=command data Display data only (0)

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h - 7Eh) UMD display text

VBC
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TSL UMD Protocol v5.0 Commands
Table 36 outlines the default values for the router when using the TSL UMD v5.0 protocol.

Table 37 summarizes the settings in the Server Options dialog for the TSL UMD v5.0 protocol.

  

Bits 3-0 Byte count of XData

Bits 6-4 Minor protocol version (v4.0=0)

Bit 7 0

XData1

Bits 0-1 Right Hand tally valuea Not implemented

Bits 2-3 Text display valuea Sets text background color

Bits 4-5 Left hand tally valuea Displayed in either border or text background; 
can be either or both

Bit 6 Reserved

Bit 7 0

XData2

Bits 0-1 Right Hand tally value Not implemented

Bits 2-3 Text display value Not implemented

Bits 4-5 Left hand tally value Not implemented

a. Where 0=off, 1=Red, 2=Green, 3=Amber

Table 36  Default Connection Types — TSL UMD v5.0

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet
TCP Port 5729

UDP Port 4492

Table 37  Server Options — TSL UMD v5.0 Protocol

Option Setting Notes
Wrapping Yes Wrap commands for TCP mode

No Do not wrap commands (UPD mode). 
This is the default.

Table 35  TSL UMD Protocol v4.0 Commands (Continued)

Protocol 
Breakdown Description Ultriscape System Use
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Protocol Implementation

Ultricore BCS implements the protocol with the following structure: 

PBC | Ver | Flags | Screen | DMSG (Index, Control, Length, Text)

Table 38 lists the supported TSL UMD Protocol v5.0 commands.

PBC in Count 
Value

Yes Include the Packet Byte Count field 
when calculating the byte count value

No Do not include the Packet Byte Count 
field in the byte count value. This is 
the default.

Table 38  TSL UMD Protocol v5.0 Commands

Protocol 
Breakdown Description Ultriscape System Use

PBC Total byte count of packet

Ver. Minor version number (0=v5.00)

 Flags

Bit 0 0=ASCII strings, 1=UTF-16LE

Bit 1 0=display data, 1=screen control Display data only (0)

Bits 2-7 Reserved (0) Not used

Screen 16bit Screen ID ScreenID associated with source or 
destination

DMSG

Index 16bit Display Address DisplayID associated with source or 
destination

Control

Bits 0-1 Right hand tally valuea

a. Where 0=Off, 1=Red, 2=Green, 3=Amber

Sets right-hand tally indicator color

Bits 2-3 Text display valuea Sets text background and border color

Bits 4-5 Left hand tally valuea Sets left-hand tally indicator color

Bits 6-7 Brightness value (0-3) Not implemented

Bits 8-14 Reserved (0)

Bit 15 0=display data, 1=command data Display data only (0)

Length Byte count of text

Text Text as defined by Flag 0 setting UMD display text

Table 37  Server Options — TSL UMD v5.0 Protocol (Continued)

Option Setting Notes
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User Assigned Parameters
 User Assigned Parameters is considered a beta feature as of software v5.1.0.

The User Assigned Parameters feature enables you to easily configure quick access custom 
Ultritouch panels for input/output signal control in your system. User Assigned Parameters can 
help you to:

• Simplify live production workflows by placing select audio and video signal control parameters 
right at an operator's fingertips.   

• Quickly adjust the signal levels from any audio/video input or output device in a signal path (e.g 
incoming encoder from a satellite feed). 

• Review input signal level adjustments in an UltriScape window before cutting to the next shot. 
• Efficiently deploy operator workflows that safeguard live productions while providing optimal 

utility. 

For More Information on...
• configuring User Assigned Parameters for UltriProc, refer to the ULTRIX-FR1, ULTRIX-FR2, and 

ULTRIX-FR5 User Guide or the ULTRIX-FR12 User Guide. 

Overview
A typical television production system includes many devices, physical or virtual, connected into 
signal paths that allow operators to create and adjust those signals to deliver the look, feel and 
sound needed for their respective productions. 

As these systems get larger, the user environment to manage and operate them also gets 
exponentially more complex to navigate through the correct controls on the correct device. More 
complex systems invariably need more console real estate for dedicated control surfaces and 
pressure builds to use flexible, rout-able control surfaces such as Ultritouch. However, these alone 
do nothing to simplify the assignment to the many devices that may be needed during normal 
operations.

User Assigned Parameters leverages the inherent efficiency of the Ultritouch touchscreen panels. 
Ultritouch can already display custom control panels, but they are complex to build and require the 
user to carefully select the appropriate device for the signal they wish to monitor or adjust. This 
manual custom configuration and association with devices needs to be set up well in advance with 
changes during a production being either potentially slow or error prone. 

User Assigned Parameters dramatically reduces these risks by switching the functions of the panel 
quickly and efficiently to a targeted subset of controls and doing that in lock step with the signals 
being routed or monitored and hence the devices being used at that moment in the production.
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Figure 27  Examples of a User Assigned Parameters Panel and Drawers

User Assigned Parameters in DashBoard
 User Assigned Parameters is maintained separately from the Ultricore BCS routing database.

The custom soft panel system within DashBoard involves the creation of grid files for each 
complete soft panel. While very powerful, these tend to be built for a specific device. The 
implementation in User Assigned Parameters uses DashBoard custom widget functionality and 
adds the ability to embed widgets in any Ultritouch soft panel, dynamically switch those widgets, 
and assign them to any appropriate device on the fly. 

To accomplish this, User Assigned Parameters maintains data in the following interfaces:

• Product Catalog — maintains product specific data common to all devices of that product type. 
For example, Ultrix and RAPTOR are two different products. The Product Catalog includes:
› Widgets area — maintains all available widgets linked to products. Widgets are user-defined 

controls within a device’s DashBoard window (e.g. numeric keypad).
› Parameters area — a generic widget (e.g. uapslider, uapnumslider) is used with a product, any 

openGear protocol (ogp) parameter can be linked to a control within that widget, the 
Parameters table tracks that association. This area is not yet fully implemented.

• Device Manager — manages all instances of products in the client system. This table links a 
device to its product type and its IP address and associated communications parameters. For 
example, an ULTRIX-FR12 is a device in the Ultrix product group, and an MC1-UHD in the RAPTOR 
product group.

• Signal Paths Manager — maintains the assignment of devices to the signal path 
(source/destination) they are wired into. 

Accessing the User Assigned Parameters Interfaces
Each User Assigned Parameters interface is represented by a tab in the main User Assigned 
Parameters window as selectable buttons. Configuration of these interfaces are only required at 
initial system build or subsequent system reconfiguration. 

 User Assigned Parameters is maintained separately from the Ultricore BCS database.

To access the User Assigned Parameters interfaces

1. Expand the Ultricore BCS node in the Tree View of DashBoard

2. Expand the Database sub-node.

3. Expand the Configuration sub-node.
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4. Double-click the User Assigned Parameters sub-node.

The User Assigned Parameters interface opens in the DashBoard window with the Product 
Catalog tab automatically selected.

The following sections briefly outline the areas and options on each page. 

Product Catalog
This page enables you to add products (devices), define the communication protocol, and set the 
product name/type required for context for control. 

• Product area — A product catalog can be imported as a spreadsheet (*.xlsx) to quickly get things 
started. Or you can define products by manually adding new entries to the Product area.

• Widget area — Control widgets (panels) are associated with products as part of the product 
catalog configuration. The system has initial support for generic widgets that then have individual 
parameters from products assigned to them (e.g. such as sliders for the Ultrix Audio control).
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Device Manager
Devices in User Assigned Parameters are instances of product that make up your system and are 
auto-populated on the page. Each device to be controlled has an entry in the Device Data table. 
(Figure 28) Each entry includes:

• a name for reference
• the IP address and port assigned the device uses for communication
• a specific OGP Device ID 
• the slot number the card is located in (for openGear cards in a frame)

Figure 28  Example of the User Assigned Parameters > Device Manager in DashBoard

Signal Path Manager
In order to ensure that the control panel is controlling functions that relate to the signals being 
routed, devices are associated with the signal paths they are part of. This is configured in the Signal 
Path Manager. (Figure 29)

Figure 29  Example of the User Assigned Parameters > Signal Path Manager in DashBoard

The Signal Name is the name used when routing on the router panel. The Signal Type and Signal 
Index are there for information purposes only but may be useful especially when differentiating 
signals where the names may be similar or the same for a source and destination.

This information is ultimately defined by the facility system configuration (wiring) at your location. 
For example, a signal is wired into the input that is linked to SRC 2 and goes through a 
GATOR-TOOLBOX card labeled as GTB-1. Whenever a router panel selects SRC 2 or a destination 
that has SRC 2 routed to it, the available controls for GTB-1 are made available on the panel. 
Multiple devices can be in that path, the operator will get all controls for all devices in the SRC 2 
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path similarly devices wired in the output path associated with the DST selected on the same router 
panel are also available to the user.

Data Export Manager
Use the Data Export interface to create a backup of User Assigned Parameters data as well as 
system updates and configuration. You can choose the type of data to export by selecting its button 
from the top toolbar, and saving the data as an *.xlsx file. This file can then be imported to the 
corresponding User Assigned Parameters interface via the Import button.

Figure 30  Example of the User Assigned Parameters > Data Export Manager in DashBoard

Defining the User Assigned Parameters Product Catalog
You begin by defining the Product Catalog for the User Assigned Parameters database. The Product 
Catalog can be defined by importing an existing catalog (an *.xlsx file) or by manually defining the 
product entries via the Add Product option on the Product Catalog page. This section outlines both 
methods.

Creating a Product Catalog File
A Product Catalog file is a spreadsheet that captures the data used by the User Assigned 
Parameters database. This file must contain the following information for each product you want to 
define.

For More Information on...
• exporting an existing Product Catalog to an *.xlsx file, refer to “Exporting User Assigned 

Parameters Data”.

Importing a Product Catalog
Importing an *.xlsx file enables you to quickly define the Product Catalog for your Ultricore BCS by 
using an existing data set.

To import a product catalog

1. Display the User Assigned Parameters interfaces as outlined in “To access the User Assigned 
Parameters interfaces”.

The Product Catalog tab is automatically selected.
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2. From the Product Data toolbar, click Import.

The Open dialog opens on your desktop.

3. Navigate to the *.xlsx file you wish to import.

4. Click Open.

The Product Data page updates to display the data imported from the selected file.

Manually Defining a Product Catalog in DashBoard
You can update the Product Catalog by defining a new product by suppling the name. Before 
proceeding, consider what devices that the new product will apply to and how to best describe 
them consistently. For example, openGear cards provide a variety of functions (e.g. Frame Syncs, 
Up/Down Converters, Master Control, Distribution Amplifiers, etc.). You can create a product type 
for the product line (openGear), or a function (e.g. Up/Down Converters), or the card model (e.g. 
UDC-8225A, UDC-8625A).

To add a new entry to the Product Catalog

1. From the Product Catalog > Product Data toolbar, click Add.

The Add Product dialog opens.

2. Use the Model Name to assign a unique identifier to this product. 

For example, if you have multiple MC1-UHD cards, you could assign “MC1-#” to each card where 
# represents the frame slot the card is located in. This identifier is also searchable via the Filter 
options in all User Assigned Parameters pages.
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3. Use the Product Type field to classify the product. 

For example, enter “Ultrix” for all models ULTRIX-NS-FR1, ULTRIX-NS-FR2, ULTRIX-NS-FR5, and 
ULTRIX-FR12 in your system.

4. Use the Manufacturer field to specify the vendor who manufactures the product.

5. Use the Channels field to specify the number channels the device will provide in the signal 
path.

6. User the Comms Type menu to specify the protocol the device uses to communicate within 
your routing system. 

7. Click Add Product.

The Product Catalog updates to display a row for the newly added product.

8. Repeat steps 2 to 7 for each new product.

9. Click Close to exit the Add Product dialog.

To edit a product entry

1. In the Product Catalog > Product Data area, select the row for the product to edit.

2. From the Product Data toolbar, click Edit.

The Edit Product dialog opens.

3. Update the required field(s).

4. Click Edit Product to apply your changes.

5. Click Close to exit the Edit Product dialog.

Managing the Widgets
Once the product data is defined, widgets are added in the Widget Data area. Those widgets already 
designed are supplied with the spreadsheet import so no configuration is required unless a new 
widget is needed after the import.

 In this section, the term “CustomPanel” refers to the interface a specific device (e.g. openGear 
card) displays within the DashBoard window. This term is not interchangeable with “soft panel” 
which refers to a panel that is created and used in the Ultrix system.

Creating a Grid File

A CustomPanel is a user interface you create in the PanelBuilder feature of the DashBoard client 
software. CustomPanels are saved as *.grid files to a folder on your DashBoard client computer. 
Widgets are DashBoard panel elements stored within the *.grid file. 
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 This process is similar to creating a CustomPanel in the DashBoard system by cutting and pasting 
controls from one device control page into the grid file. Once pasted, all normal editing options 
are available as long as the resulting grid file is contained in an <abs> or <table> element.

To create a grid file

1. Display the device’s interface in the DashBoard window. Refer to the user guide for your device 
for details.

In the example below, the QSP-8229A is displayed.

2. In DashBoard, select File > New > New CustomPanel File.

The Create new CustomPanel File dialog box opens.

3. In the File name box, type a unique name for the new grid file.

4. Use the Template list to select Blank Self-Contained Data Source Panel (XPression).

This creates an empty panel which stores only the device data, timers, and/or local parameters 
data to the grid file.

5. If the folder in which you are saving the grid file is not already listed in the File Navigator tab and 
you want it to be, select the Add to File Navigator box.

6. Click Finish.

The new panel appears as a new tab in the DashBoard window.

7. Use your mouse pointer to grab the new panel tab and drag it to the right side of the screen 
until the split screen line displays. Then release the new panel tab.

8. Select the QSP-8229A pane.
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9. Click PanelBuilder from the DashBoard main toolbar.

10. Select the area in the device panel that you want to make the widget for.

In the following example, the user selected an area on the Proc Amps > Out 1 tab.

11. Drag the selected block over to the grid file window and drop.

This will set the grid file into PanelBuilder Edit mode. 

In some cases a dialog opens to confirm if certain components should be included or linked to. 
You can include them for now and delete later if they are not relevant.

12. If the grid file needs editing, close the device page and proceed to edit using the PanelBuilder 
feature. Refer to the DashBoard User Guide for details on editing grid files.

 Resizing the element can help determine if the widget is going to be appropriate when displayed 
on the Ultritouch panel however this a useful guide not absolute. 

13. Once editing is complete, save and close the grid file.

14. To convert and install the widget open the User Assigned Parameters database page on the BCS 
and go to the Product Catalog tab. Assuming the product is in the catalog, following the above 
instruction to add it if not, select the product the widget applies to. Click on the Import Grid 
button, navigate to and select the grid file created and click open. 

Adding a New Widget
Once created, the grid file is converted to a widget by clicking Import Grid button in the Panel 
Catalog > Add Widget dialog. This enables you to navigate to the location of the grid file, select and 
open it. The conversion to the widget, placement in BCS and update of all panels occurs 
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immediately. The name of the grid file is the subsequent name of the widget that will be inserted in 
the name field of the dialog.

To add a new widget to the Product Catalog

1. Verify that the product for the widget is listed in the Product Catalog.

2. From the Product Catalog > Widget Data toolbar, click Add.

The Add Widget dialog opens.

3. Set the Control Type and Sub-control Type fields to meaningful text. 

The text will be used to filter controls relative to a function i.e. enter audio for Control Type to 
only show audio controls to audio operators, this is not used at this time. Sub-control type is 
used to indicate the type of control, gain, timing, config, status.

 Grid files for conversion need to be cleanly contained in an <abs> or <table> tag to convert so 
care is needed, see creation notes below.

4. Click Import Grid.

5. Navigate to the grid file you created in the previous section.

6. Click Open.

The widget is added to the product it applies to. All devices based on the product will 
immediately have the new widget associated with them.

7. Click Close to exit the Add Widget dialog.

To edit a widget

1. In the Product Catalog > Widget Data area, select the row for the product to edit.

2. From the Widget Data toolbar, click Edit.

The Edit Widget dialog opens.

3. Update the required field(s).

4. Click Edit Widget to apply your changes.
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5. Click Close to exit the Edit Widget dialog.

Defining the Devices for User Assigned Parameters
The Device Manager page enables you to manage all instances (devices) of product types in the 
DashBoard client system. Each device is linked to its product type and enables you to specify its IP 
address and associated communications parameters.

 In the case of an openGear card, the IP address of the frame and the slot number in which the 
card resides. 

You can choose to import an *.xls spreadsheet that includes entries for all the devices in your 
system, or you can manually add devices to the User Assigned Parameters database. This section 
outlines both methods.

To import a device entry

1. Select the Device Manager tab.

2. From the Device Manager toolbar, click Import.

The Open dialog opens on your desktop.

3. Navigate to the *.xlsx file you wish to import.

4. Click Open.

The Device Manager page updates to display the data imported from the selected file.

Manually Adding a Device Entry
Before proceeding, ensure that you have the IP Address, port number, and OGP DeviceID for each 
device. This information can be obtained by locating the device in the DashBoard Tree View and 
right-clicking its node and selecting View Frame Information.

To add a new device entry to the Device Manager

1. From the Device Manager toolbar, click Add.

The Add Device dialog opens.
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2. Use the Enter Device Name field to assign a unique identifier for the device within User 
Assigned Parameters. This does not impact the device name reported in the main Database 
system. 

The Device Name is to identify which device is being associated with a signal path and should 
be meaningful in the context of your system. All other data, IP address, Port number, OGP/node 
ID and slot number are specific to and required to properly communicate with the device in 
question. 

3. Use the Select Product menu to assign the device to a product type as defined in the Product 
Catalog. 

 The Product Catalog entries determine the list available in the Select Product menu.

4. Use the Enter Device IP field to specify the IP Address assigned to the specific device you want 
to add.

 If the device is an openGear card in a frame, you must enter the IP Address of the frame.

5. If the device is accessible to the Ultricore BCS, click Get Details to auto-fill the remaining fields.

6. Click Add Device.

The Device Data table updates to display a row for the new device.

7. Repeat steps 2 to 6 for each device you want to add.

 After adding the details from the frame information, each card can be added by changing the 
Device Name, selecting the product from the Select Product menu, entering the slot number of 
the card, and clicking Add Device. 

8. When all cards and frames are added, click Close to exit the Add Device dialog.

Editing a Device Entry
 Use the Filter field, located in the top right corner of the page, to display entries with the 

specified text (searches all fields in the page). For example, typing “GATOR” would display 
instances in the Device Name and Product fields of the Device Data table.

To edit a device entry

1. In the Device Manager > Device Data table, select the row for the device to edit.

2. From the Device Data toolbar, click Edit.

The Edit Device dialog opens. 
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3. Edit the field(s) as required.

4. Click Edit Device to apply your changes.

5. Click Close to exit the Edit Device dialog.

Defining the Signal Path
The Signal Path Manager is where devices configured in the previous section are associated with 
signal paths (logicals). This allows you to filter only those devices relevant to the current panel 
routing context as configured in the current database.

The Signal Path data is an association to ensure the correct device is controlled when a source or 
destination is selected. Since this is dynamically assigned (or removed), openGear cards that might 
be patched into a path even for a single production, can be easily added to the signal they are 
patched into for the duration of the production and removed immediately after. With this in mind, it 
may be advantageous to add all devices that might be used in this way to the Device Data table in 
advance, not just those hard wired into router I/O paths.

To assign a device to a signal path

1. From the Signal Path Manager > Signal Paths area, select the logical you want to assign the 
device to.

2. From the Panel Data toolbar, click Assign.

The Assign Device dialog opens.

3. Use the Select Device menu to specify the device.

4. Specify the Product Type that the device belongs to.

5. If the device has multiple processing paths through it that are independently addressable, 
select the appropriate channel in the Select Channel menu. 
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 The channel selection is a 0 based index derived from the number of channels set for the product 
in the Product Catalog interface.

6. Click Assign Device.

7. Click Close.

The Assign Device dialog closes and the Signal Path Manager table updates.

Exporting User Assigned Parameters Data
Use the Data Export interface to create a backup of User Assigned Parameters data. This data is 
captured in an *.xlsx file that can be imported to the corresponding User Assigned Parameters 
interface. 

 A list of available files (databases) is provided in each page of the Data Export interface. It should 
be noted that this is just an association by name, User Assigned Parameters data and system 
data are not automatically created or restored together, i.e. they need to be managed separately 
at all times.

To export a database to an *.xlsx file

1. From the Data Export toolbar, select the data type you wish to export. Choose from the 
following:

• Device Data
• Signal Path Data

2. To create a new file:

a. In the Save As field, specify the name for the *.xlsx file.

By default, the filename includes a suffix that helps to identify the data type. For example, 
*-DeviceData.xlsx would capture data from the Device Manager.

b. Click Browse.

c. Navigate to the location to save the file to.

d. Click Save.

e. Click Apply.

3. To replace a current file:

a. Select a file from the Database: table. 

b. Click Apply.

Operating an Ultritouch Soft Panel with User Assigned Parameters
User Assigned Parameters enables a user to customize the window and drawer contents of an 
Ultritouch soft panel. This enables you to easily configure custom panels that associate channel 
control parameters to the devices in the signal. Panels can include or restrict controls for audio 
and/or video based on the source type or operator requirements, and can be re-used on multiple 
signal paths to reduce configuration effort.

Creating a Soft Panel
The process of creating an Ultritouch Push Button soft panel does not change. The User Assigned 
Parameters data is added to the drawer(s) during the soft panel configuration.

By default, an Ultritouch soft panel includes one drawer on the right. Figure 31 displays the On-Air 
Controls of an MC1-UHD.
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Figure 31  Example of a Soft Panel with the Right Drawer Configured with User Assigned Parameters

When creating the soft panel, adding the User Assigned Parameters data on the left side for 
instance will present the parameters on the left side. Figure 32 shows the control options for SRC 2 
which is linked to DST 1 on an Ultrix router.

Figure 32  Example of a Soft Panel with the Left Drawer Configured with User Assigned Parameters

You can also create separate drawers, each with different User Assigned Parameters data. Figure 
33 shows the left drawer with audio sliders, and the right drawer displays the On-Air Controls of an 
MC1-UHD.

Figure 33  Example of a Soft Panel with Two Drawers Configured with User Assigned Parameters

For More Information on...
• creating soft panels, refer to the Ultrix and Ultricore Database Guide.
• UltriProc, refer to the ULTRIX-FR1, ULTRIX-FR2, and ULTRX-FR5 User Guide or the ULTRIX-FR12 

User Guide.
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Ultricore-Tally Setup
This chapter provides information on the Ultricore-Tally licensed feature for the Ultricore BCS.

 Ultricore-Tally requires Ultricore BCS software version 6.1 or higher.

Overview
In professional broadcasting, the high volume of video signals requires the reliable and accurate 
identification of signal origin and utilization to ensure the seamless operation of productions and 
network distribution. This crucial role is filled by the tally display system. Everyone involved, in the 
control room, in the studio, in remote locations, and in front of a camera, relies on the tally display 
system to know what is really happening moment to moment. This is especially true where multiple 
simultaneous productions share resources and conflicting usage can make a production look 
unpolished or lead to delays.

The tally system gathers information from equipment all over a facility and presents it so as to 
maximize assistance and minimize clutter, bringing order to an intricate production landscape. The 
Ultricore-Tally licensed feature makes this happen. It tells control room staff what they are sending 
to air now, how it is getting there, what they expect to send next, what other productions are 
sending to air, and when their production's images are leaving the facility. It tells people in front of 
and behind the camera when they are directly contributing their image and, just as importantly, 
when they are not.

Features
Ultricore-Tally offers the following features:

• Dynamic tracking of routed switcher inputs 
• Tallying sources through router re-entry
• Utilizing tallies across router tielines
• Applying UMD and Switcher Button Aliases independently from the router name, with support 

for Unicode characters in aliases
• Controlling Ross GPI devices like the TXI-48 and GPI-8941
• Transmitting tallies to other Ross devices, such as Tria® and XPression®
• Generating advanced triggering events, such as activating non-video widgets or initiating 

start/stop clocks via GPIs

Interfaces
The following interfaces are used for the Ultricore-Tally setup:

• Tally System Console — the commissioning interface that operates as a Microsoft® Windows® 
application separate from DashBoard. The Tally System Console communicates with the 
Ultricore-Tally feature of the Ultricore BCS on ports 10024 and 10015. Use this interface to 
configure the Ross Tally System devices in your routing matrix. Once configured, each device is 
available to include in the Ultricore-Tally via the Ultricore-Tally Web Console.

• Ultricore-Tally Web Console — the production interface displays as a node in the Ultricore BCS 
Basic Tree View of DashBoard. Use this interface to configure the Ultricore-Tally feature.
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System Integration
The Ultricore-Tally licensed feature engages in real-time communication with switching and routing 
equipment, generating a comprehensive overview of the flow of video signals to monitors. It also 
assesses whether these signals successfully reach on-air programs or transmission feeds.

Figure 34 shows a possible Ultricore-Tally in a workflow with Ross devices.

 This is provided as an example integration only. Your needs may differ from what is presented 
here.

Figure 34  Example Workflow with Ultricore BCS with Ultricore-Tally and Ross Devices

1. Ultricore BCS with Ultricore-Tally

You need at least one Ultricore BCS equipped with the Ultricore-Tally license. The Ultricore BCS is 
responsible for monitoring the latest Tally Status messages sent by a controller through Tally 
Display IDs linked to router sources. Whenever a source, identified by a Tally ID, is routed to a 
destination also marked with a Tally ID, the router will generate Tally Status messages. These 
messages indicate the current tally status of the Tally ID connected to the source but are directed 
towards the Display ID linked to the destination.

 The Ultricore-Tally settings are not captured in the routing system database.

2. DashBoard Client Computer

The DashBoard client software allows you to oversee and manage Ross devices using a 
computer. Within the Ultricore BCS, there are DashBoard interfaces designed for both 
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configuration and operation. To access these interfaces, simply expand the Ultricore BCS node in 
the DashBoard Tree View and choose the relevant sub-node. 

3. ULTRIX-NS-FR5 with a Multiviewer

The ULTRIX-NS-FR5 is capable of accepting TSL UMD tally messages and relaying tally status 
notifications to designated Ultriscape Heads. Tally messages linked to a router source can also be 
forwarded to the corresponding destination tally status. Tally information can be associated with 
either the sources or destinations in the routing system.

For all sources or destinations with a configured Tally ID, the ULTRIX-NS-FR5 will monitor the 
current tally status. In cases where Ultriscape Picture-in-Picture (PiP) features enabled tally 
display objects such as borders, labels, and lamps, the PiP determines the content displayed on 
the screen based on the configured Tally IDs for both the source and destination, along with the 
Tally mode setting.

Ultriscape PiPs can be set to either follow the Tally ID of the presently displayed source or 
operate in a direct Tally mode, overriding any information from the currently displayed source.

4. TXP-16

The TXP-16 serves as a tally expansion interface featuring 16 customizable inputs/outputs. It 
functions as an ethernet-enabled GPI I/O frame designed for the Ultricore-Tally System 
Controller. The TXP-16 includes the following:

› 16 binding posts on the front, adaptable as either input or output.
› Configure each input and output as wet or dry as needed.
› Polarity insensitivity for wet inputs. 
› Choose between internal or external (front or rear) wet voltage sources.
› LED indicators show GPI status for both inputs and outputs.
› TCP/IP connectivity enables the TXP frame to be positioned at significant distances from the        

Tally controller.
› Optional expansion to 48 I/O (32 via rear panel).

5. TXI-48

The TXI-48 is a tally expansion interface with 48 configurable I/O. It is controlled through either 
the ethernet port or the RS-485 serial port. The TXI-48 includes the following:

› 48 I/O in 1 RU frame.
› 16 input or outputs per I/O connector.
› Tri-color LED indicates system status.
› Jumper-configurable input voltage (wet) or pull to ground (dry).
› Isolated dry contact closure (relay) outputs.

6. RCP-QE18

Remote control panels provide a physical switching surface to control the router switching. Each 
panel uses data derived from the routing system database to display text on monitors and assign 
functions to the buttons. The RCP-QE18 is used when you require advanced control functions 
from a single point. The RCP-QE18 communicates with Ross routing systems via standard 
10/100/1000 ethernet network. The RCP-QE18 sends a switch request message, and receives 
acknowledgments and status updates, via ethernet to the configured routing system server IP 
address device.

7. OGX-FR with GPI-8941

The OGX-FR frame comes standard with ethernet connectivity for basic configuration and 
monitoring of openGear cards through the DashBoard control system. The GPI-8941 openGear 
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card provides an interface between openGear agents, such as DashBoard, and tally devices that 
communication via the General Purpose Interface (GPI).

Before You Begin
Ensure the following:

• The Ultricore BCS is installed and fully configured in your routing system.
• The Ultricore BCS and Ultrix routers are running software version 6.1 or higher.
• The tally system devices are installed and configured as per their user documentation.

Installing an Ultricore-Tally License
The Ultricore-Tally license must first be installed on the Ultricore BCS before it can be used in a tally 
control system.

Ross Video uses license keys to control user access to specific features. You can obtain a key for a 
licensed feature from Ross Video Technical Support. Use this key to assign an Ultricore-Tally license 
to a specific Ultricore BCS.

To install the base Ultricore-Tally license key

1. Locate the Ultricore BCS in the Tree View of DashBoard.

2. Expand the Ultricore BCS node to display a list of sub-nodes in the Tree View.

3. Expand the Systems sub-node.

4. Expand the Configuration sub-node.

5. Double-click the Ultricore BCS node.

The Device Configuration interface opens.

6. Click Licenses.

7. Make a note of the character string in the Request Code field for the feature you wish to 
enable.

8. Contact Ross Video Technical Support using the information found in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility 
name, and the Request Code from the Licenses table.

b. You will be given a License Key that must be entered in the applicable field in the Licenses 
table.

9. Enter the provided License Key in the applicable License Key field in the Licenses table.

 You can also right-click on the row for the License Key you are installing, and copy the Request 
Code to or paste the License Key from the Microsoft® Windows® clipboard.

10. Click Apply in the row for the License Key you entered in step 9.

11. Verify that the Count field is updated to report each installed License Key.

Using the Tally System Console
This section outlines how to install and use the Tally System Console to configure a new 
Ultricore-Tally system.
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To install the Tally System Console on a PC

1. Download the Tally System Console software from the Ross Video website.

 The file name will be Tally System Console 3.8-Redis-on.msi.

2. Right-click the *.msi install file.

3. Select Install.

4. Launch the Tally System Console.

5. Select Management > Configuration > General.

6. Select the Send configuration to TSI database box.

7. Click OK.

8. Select File > Merge Libraries.

9. Select the file named Library10.lib.

10. Click OK.

To define the Ultricore BCS settings

1. Click Management > Edit TSI List.

2. Click Add.

3. For each Ultricore BCS:

a. Enter a Name.

b. Use IP Address A field to assign a valid IP address for the Ultricore BCS.

c. If the Ultricore BCS is a redundant system, enter the IP address for the backup Ultricore BCS, 
otherwise leave this field blank.

d. Select BCS.

e. Select Assume Online.

f. Click OK.

g. Click Done.

4. Select Hardware > Tally System Interface Units.

5. For each Ultricore BCS system:

a. Enter an arbitrary Name.

b. Enter an Interface Number (usually 2). 

c. Enter an IP address for each Ultricore BCS system.

 For Ultricore BCS systems that are redundantly paired the Interface Number value will be the 
same for paired units but the IP addresses will differ. Interface Numbers for non-paired Ultricore 
BCS systems must differ.

Adding External Devices
This section outlines how to add devices, specify their communication protocols and IP addresses 
as needed. 

To add a router

1. In the Tally System Console, select Hardware > Comm Port Setup > Router.

The Router Device Editor dialog opens on the right-side of the application. 
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2. Specify a unique name/identifier that is short in length.

Shorter names help prevent overflows in other areas of the system where the name could be 
used multiple times in the same area. For example, use RTR to represent a router.

3. Select the TSI System that will be communicating with the router. 

4. Select the router protocol. 

 For Ross Video Ultrix routers, select Ross Ultrix Router (SW-P-08 TCP/IP port).

5. Set the router level.

 For Ross Video Ultrix routers set this value to 0. To specify more than one router level, separate 
the levels with a comma. For example, 0,1,2 or SD,HD.

6. Verify that the IP address of the router is set in the IP Addr #1 field of the Device 
Configuration dialog (located at the right edge of the application). 

7. In cases where the router operates in a redundant system, a second IP address may be entered 
in the IP Addr #2 field.

8. For Ultrix routers (only):

a. Locate the Resource Device Options area of the Device Configuration dialog.

b. Select the Use as configuration source box. 

c. Set the #Inputs field according to the input size of the Ultrix router.

To add a switcher

1. In the Tally System Console, select Hardware > Comm Port Setup > Production & M/C 
Switchers.

2. For each switcher:

a. Specify a unique name/identifier that is short in length. 

Shorter names help prevent overflows in other areas of the system where the name could 
be used multiple times in the same area. For example, use SWR to represent a switcher. 

b. Select the TSI system that will communicate with the switcher. 

c. Select the switcher protocol. 

• Ross Video Acuity switchers — select Ross Acuity Switcher TSL 5.0 / IP (Switcher is TCP 
Server). 

• Ross Video Carbonite switchers — select Ross Carbonite Series auto-detecting switcher 
(the switcher is TCP/IP Client).

d. If you are using a Ross Video Acuity switcher: verify that the IP address of the switcher is set 
in the IP Addr #1 field of the Device Configuration dialog (located at the right edge of the 
Tally System Console application). 

e. If you are using a Ross Video Carbonite switcher, verify that the IP address of the controller 
was set when adding a tally port to Carbonite.

To add a Multiviewer

1. In the Tally System Console, select Hardware > Comm Port Setup > Displays.

2. For each Multiviewer system:

a. Specify a short name/identifier such as “MV1”. Depending on the location of the Multiviewer 
system, the name might reflect the name of a control room, such as “PCR1”.

b. Select the TSI system that will communicate with the Multiviewer.
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c. Select the Multiviewer protocol. 

• Ultrix-based Multiviewers — select Ross Ultrix Multiviewer (TSL v5.0-Wrapped: MV is TCP 
Server).

• Switcher-based for Ultrix-based Multiviewers — select Ross Ultrix Multiviewer (TSL 5.0: MV 
is TCP Server). 

d. Verify that the IP address of the Multiviewer is set in the IP Addr #1 field of the Device 
Configuration dialog (located at the right edge of the Tally System Console application).

To define UMDs and UMD monitoring styles

1. In the Tally System Console, select UMDs > Display Devices. 

This editor will contain a list of Multiviewer PiPs, one per line. Each PiP is associated with a 
Multiviewer system as defined in “To add a Multiviewer”.

2. For each PiP within a Multiviewer:

a. Specify a short name/identifier for the PiP.

b. Use the Port menu to select the Multiviewer with which this PiP is associated. 

c. Enter a Tally ID into the Serial # column. 

In the Ultricore BCS database systems, this Tally ID will typically match a value in the router 
Destination > Tally ID column of the active database.

d. For Ross (and most) Multiviewer systems, enter a value of 1 in the Section# column.

e. From the Monitoring Style column, select Destination.

f. From the Tally Area menu, select a Tally Area (typically a Control Room). 

The Tally Area determines which production switcher will generate tally information for a 
given Multiviewer PIP.

 An error icon displays in the Monitoring Description column of each PIP because a router 
destination is not yet assigned to the PiPs. This will be addressed later in the configuration 
workflow.

To save the tally system configuration

1. In the Tally System Console, select File > Save as Remote Session. 

The Save TO TSI dialog opens.

2. Select BCS system from the provided list

3. Edit the Filename as needed.

4. Perform one of the following:

• Clear the Upload as current config and reboot box if the currently running configuration 
must remain unchanged; or

• Make this configuration the newly effective current configuration by selecting the Upload as 
current config and reboot option.

5. Click Save to TSI.

Extract the I/O Matrix from the Router
Once the running Tally System Console includes the Ultrix router settings and communication with 
the router is established, the router I/O names configuration may be downloaded from the Ultrix 
router. 
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To download the I/O matrix from the Ultrix router

1. In the Tally System Console, select Tools > Import Router Configurations.

2. Select the I/O and Signals tab at the top left of the application.

3. Select the Source Definitions menu bar in the menu tree left part of the application.

• The router source names display in the Source Name column of the Source Definitions Editor. 
• The router input numbers display in the Router Device column.

4. Fill in Multiviewer-friendly source names into the Long Names and Short Names column.

• Router inputs are reported in the Source Definitions Editor and the Router - Input Names 
Editor. 

• Router destination names are reported in the Router - Output Names Editor. 
• Router I/O labels may also be filled into the configuration by hand. 
• All router I/O labels are available in drop-downs in the menu tree (in the left pane of the 

application).

To assign router destinations to UMDs/PiPs

1. In the Tally System Console, select UMDs > Display Devices.

2. In the menu tree in the left pane of the configuration, select I/O and Signals > Router - Output 
Names.

3. Select + to display a list of router destinations.

4. Select the required destinations from the menu tree.

5. Drag and drop the selected destinations into the Monitoring Description column of the 
Display Devices Editor.

6. Select Assign a single parameter to each row from the dialog.

Each PIP will now contain a Monitoring Description reflecting the destination that is now 
assigned to each PIP.

Recalling Operational Configurations
See also document on Tally Web Console for a production method of changing the operational 
configuration.

1. From the top-level menu bar, select File > Open Remote Configuration Manager.

The Remote Configuration Manager opens.

2. Select an Ultricore BCS system from the list on the left side.

3. Select a configuration file name from the list on the right side.

4. Click Make Current.

5. Click Done.

The Set running configuration to <configuration file name> prompt displays.

a. Choose one of the following:

• No — no action is taken.
• Yes — a second prompt appears: “Reboot System?”. Proceed to step b.
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b. Choose one of the following from the reboot prompt:

• No — the change of running configuration is deferred until the next manual reboot. 
• Yes — the running configuration is changed and the Tally Process running on the Ultricore 

BCS is rebooted. This does not affect other (non-tally) operations running on the Ultricore 
BCS. 

Basic Editing Overview
The Tally System Console application consists of the following interfaces (from left to right):

1. A menu tree which provides access to:

• Database Editors. Select an editor to display it in the right side of the application.
• Lists of items created by each editor. This allows items created in one editor to be assigned to 

items in a different editor using a drag and drop method described below.

2. Navigation tabs at the top of the menu tree, to select menu tree subsections.

3. The right side of the application is dedicated to Database Editors.

4. The standard horizontal menu bar that is present in any Microsoft® Windows® application.

To navigate between Database Editors

1. Click on the row of tabs in the top left corner of the application to select one of the following:

• Hardware
• UMDs
• GPI & Interface Devices
• I/O & Signals
• Plant Layout
• Tally Logic

This displays a series of menu bars, each of which contains an Editor title. The + icon displays if 
the table is populated.

2. Select one of the menu bars to display a Database Editor in the right half of the application.

To assign database items using drag and drop

1. In the left side menu tree, navigate to one of the Database Editors as described above, from 
which database one or more items will be dragged.

2. Also in the left side menu tree, navigate to different Editor to which we drag database items, but 
(instead of clicking the menu bar) click the “+“ icon on the menu bar to display a list of items 
created by the given second menu bar.

3. Press Ctrl + Shift to select multiple items from the left side menu bar.

4. Drag the multi-selected items from the menu tree to the Monitoring Description or the Control 
Style Description column of the Editor that is open on the right. 

5. When moving multiple items, answer the prompt as to whether to “Assign as parameter to 
single row only” or “Assign a single parameter to each row”. 

6. Drop the item(s) onto the Monitoring Description column. 

The Monitoring Description column updates to report the name of the database item that was 
assigned to each row.
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To add a record to the middle of an Editor

1. Go to the line which will follow the new line.

2. Press Ctrl + Insert.

A new line displays above the current line. 

To add a record to the end of an Editor

1. Go to the last line of the Editor, which will be empty.

2. Type a unique name/identifier in the Name column. 

A new line is created. Notice that a new empty line displays below the new line.

To perform a single-keystroke drop-down select

1. Go to a drop-down cell below an already-selected cell.

2. Press Ctrl + Enter to copy the above select into the current cell.

3. Press Ctrl + Enter repeatedly to quickly fill in a column.

To perform a single-keystroke mnemonic name copy and increment

1. Go to a text edit cell below any non-blank text cell.

2. Press Ctrl + Enter.

The name from the above cell is copied into the current cell.

The numeric end of the name is incremented. For example CAM1 from the above cell is copied 
to the current cell as CAM2. 

If name ends in a letter, it is incremented (A, B, C, etc.). For example, CAM_A is copied to the next 
cell as CAM_B.

To fill in rows of a column with a mnemonic series of names

1. Press F1.

A text edit field displays.

2. Fill in an expression that denotes a range of mnemonic names, using the syntax of: 
<name><start number>-<end number>.

The range of mnemonic names will be created, one per line in the current column.

3. Click OK or press Enter.

For example, the range expression “CAM1-5” will create name set CAM1, CAM2, CAM3, CAM4, 
CAM5.

To fill in a range of mnemonic names of a given length

1. Click on a text cell below a populated text cell.

2. Press Ctrl + Shift + Enter.

3. Enter a range length value into the resulting prompt.

The range of mnemonic names will be created, one per line in the current column, starting with 
a mnemonic incremented from the previous row, of range length value in length.

For example, press Ctrl + Shift + Enter below the CAM1 cell, then enter 9 as the length value. 
The Mnemonic series CAM1-CAM10 is created.

Saving the Configuration Sessions
This section outlines how to save your configuration for remote or local sessions.
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To enable configurations to save to tally controller (remote sessions)

1. Select Management > Configuration > General.

2. Select the Send Configuration to TSI Database box.

3. Click Close.

The Set Active TSI-4000s to TC3 Mode? dialog opens.

4. Click Yes.

5. Close and reopen the Tally System Console application.

To enable configurations to save to local PC (local sessions)

1. Select Management > Configuration > General.

2. Clear the Send Configuration to TSI Database box.

3. Click Close.

The Set Active TSI-4000s to TC2 Mode? dialog opens.

4. Click Yes.

5. Close and reopen the Tally System Console application.

To save a local session to a remote session, but not as the current configuration

1. Select File > Save As Remote Session.

The Save to TSI dialog opens.

2. Edit the Filename as needed.

3. Clear the Upload as current configuration and reboot box.

4. Click Save to TSI.

5. On the Reboot System dialog, choose one of the following:

• Click Reboot immediately; or
• Click No to defer the reboot.

To save a local session to remote session, as the current configuration

1. Select File > Save As Remote Session

The Save to TSI dialog opens.

2. Edit the Filename as needed.

3. Select the Upload as current configuration and reboot box.

4. Click Save to TSI.

5. On the Reboot System dialog, choose one of the following:

• Click Reboot immediately; or
• Click No to defer the reboot.

Managing the Configuration Sessions
This section outlines how to open, download, and restore your remote sessions.

To open the current remote session

• Select File > Open Current Remote Configuration.
The file loads to the Tally System Console.
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When viewing the current configuration, the file name in the title bar is appended with the suffix 
of (current).

To download all the remote sessions

• Select Tools > Backup Configurations from TSIs.
The files are exported to the User Documents folder in the following location:
Tally System 3.8\TC2Backups\<TSI IP address>

To restore the remote sessions from backup sessions

• Select Tools > Backup Configurations from TSIs.
The files will be restored to TSIs from the User Documents folder in the following location: 
Tally System 3.8\TC2Backups\<TSI IP address>

Using the Ultricore-Tally Web Console
The Ultricore-Tally Web Console allows production staff to change source names as displayed in 
UMDs, override the text in individual UMDs, monitor the on/off state of each GPIO, monitor the text 
and tally for each UMD, create tally maps used to map the operation of GPI outputs and UMDs, and 
control router crosspoints. 

The console is organized into a series of pull-down menus in the top toolbar. Selecting an option 
displays those settings in the console interface.

This section briefly outlines how to display the Ultricore-Tally Web Console and provides a brief 
overview of the available functions.

 Access to the Ultricore-Tally Web Console requires a username and password. 

To log into the Ultricore-Tally Web Console from a browser

1. Browser to the Ultricore BCS IP address at port 4000. For example, 123.123.12.23:4000.

2. Answer the login prompt page with a user and password.

To log into Tally Web Console from DashBoard

1. Launch DashBoard on your PC.

2. Click File > New > TCP/IP DashBoard Connect or openGear device

3. In the IP address field, enter <IP address>:4000. For example 123.123.12.23:4000.

4. Log Answer the login prompt page with a user and password.

To log into the Ultricore-Tally Web Console (first time)

1. Log into the Ultricore-Tally Web Console from a browser or DashBoard.

The default login credentials are:

• User: admin
• Password: admin
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2. Select the User profile menu near the top-right corner of the Ultricore-Tally Web Console.

3. Select Administrate users.

4. Click New User.

5. Enter a new username.

6. Enter a new password.

7. Confirm the new password.

8. Select Admin privilege.

9. Click Add.

The new admin user replaces the default administrator. From here new administrators and 
users can be created.

To set the permissions for a new user

1. From the top toolbar on the Ultricore-Tally Web Console, select the User menu.

2. Select Administrate users.

3. Select the required user account from the provided drop-down.

The Ultricore-Tally Web Console reports [Editing <User name>] in the menu bar.

4. To hide a column from the user:

a. From the Tally Configuration menu, select one of the editors.

b. Click the header downward carat icon.

c. Select Hide Column.

d. Repeat for other editors and columns. 

5. To hide a row from the user:

a. From the Tally Configuration menu, select one of the editors.

b. To hide a row from the user, clear the leftmost column of the row.

c. Repeat for other editors and rows.

6. To hide multiple rows from the user:

a. Locate the editable field at the top of the Name column.

b. Type a filter word into this field. 
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This will reduce visible rows to rows with Names matching the filter word. For example, 
typing CAM into the filter box will display rows with names CAM1, CAM 2, CAM-3, etc. and hide 
all other rows.

c. Use the box beside the Name header to select the visible rows for user access. If a box is 
cleared (unselected), the specific row will not display.

d. Type a different filter word to control a different series of rows for user access.

e. Clear the filter word to see all rows and review which are checked or unchecked for access.

7. When finished editing, log out of the admin account.

To reload the current configuration (admin only)

 This may refresh UMDs and momentarily stop tally operations.

1. Select the User profile menu near the top-right corner of the Ultricore-Tally Web Console.

2. Click Reload Current Configuration.

The Reload Current Configuration dialog opens.

3. Click Yes.

The tally process restarts and the configuration is reloaded. 

Selecting a new current configuration (admin only)

 This will refresh UMDs and momentarily stop tally operations.

1. Select the User profile menu near the top-right corner of the Ultricore-Tally Web Console.

2. From the provided drop-down menu, select a configuration file.

The Change Current Configuration dialog opens.

3. Click Yes.

The tally process will restart and a new configuration will be reloaded.

To filter the configuration pages

• Type a filter word into the Edit field at the head of the Name column. 
This will reduce the visible rows to only those rows with Names matching the filter word.
For example typing CAM into the filter box will show rows with names CAM1, CAM 2, CAM-3, etc. 
and hide all other rows.

To override the source names

1. From the top toolbar on the Ultricore-Tally Web Console, select Tally Configuration.

2. Select Source Names.

The Ultricore-Tally Web Console workspace displays the Source Names Editor. Each row 
represents an available source.

3. For a given Source, enter the new text into the Long column. 

In the following example, the user entered AIRSPEED LONG for the first source.

For all UMDs displaying the given source, the name that is displayed from the Name column is 
immediately replaced with the new text from the Long column.
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4. To restore a source to its default source name, delete the text from the Long column.

For all UMDs displaying the given source, the displayed name will revert to the default source 
name.

To override the UMD displays

1. From the top toolbar on the Ultricore-Tally Web Console, select Tally Configuration.

2. Select UMD Displays.

The Ultricore-Tally Web Console workspace displays the UMD Displays Editor. Each row 
represents an available UMD.

3. For a given UMD, enter the new text into the Text Override column. 

• The name displayed in the given UMD is immediately replaced with the new text from the 
Text Override column. Tally effects in the UMD will continue to operate as before.

• The text override name is unaffected by various routes into the UMD, but tally effects will 
obey the normal rules depending on the sources routed to the UMD.
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4. To restore normal operation to the UMD, delete the text from the Text Override column.

Creating and Using Tally Maps
Tally maps allow you to easily assign tally device inputs to tally device outputs by clicking the 
crosspoints of a control grid UI. 

Figure 35  Example of a Tally Map 

1. TSI Resources

The TSI Resources area, the tree in the left pane, lists the tally device inputs and outputs. These 
resources were defined in the Tally System Console during the tally system commissioning 
process.

2. Tally Device Outputs

Using a drag and drop method, the horizontal axis of a tally map may be assigned with tally 
device outputs, which include:

› GPI outputs
› UMD Displays
› Router output controls

3. Tally Device Inputs

Using a drag and drop method, the vertical axis of a tally map may be assigned with tally device 
inputs, which include:

› Source definitions
› Resource inputs
› GPI inputs

Creating Tally Maps
Tally device inputs and outputs are assigned by dragging and dropping items from the TSI 
Resources tree into either the horizontal axis or vertical axis of a tally map.

To create a new tally map

1. From the top toolbar on the Ultricore-Tally Web Console, select Tally Maps.

2. Select Editor.

1) TSI Resources 2) Tally Device Outputs 3) Tally Device Inputs
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3. Select + (on the far right of the menu bar) to create a new tally map stub.

4. To assign tally device outputs:

a. Expand the TSI Resources tree.

b. Expand the folders to reveal the required tally device outputs (GPI Outputs, UMD Displays, or 
Router output controls).

c. Select one or more items from the menu tree folder.

d. Drag the selected items over to the tally map horizontal axis. 

5. To assign tally device inputs:

a. Expand the TSI Resources tree.

b. Expand the folders to reveal the required tally device inputs (Source Definitions, Resource 
Inputs, or GPI Inputs). 

c. Select one or more items from the menu tree folder.

d. Drag the items over to the tally map vertical axis.

6. At the far right of the Web Console menu bar, select Configuration File.

7. Click Save Current Config Files.

To set the control logic for each type of tally device output

1. Double-click an item in the horizontal row of the tally map.

2. On a row of the resulting output logic editor, select the Control Style menu.

3. Select a Control Style as per the second column of Table 39.

4. Repeat for each row of the output logic editor.

To set control logic for each type of tally device input

1. Double-click an item in the vertical row of the tally map.

2. On a row of the resulting input logic editor, select the Control Style menu.

3. Select a Control Style as per the third column of Table 39. 

4. Repeat for each row of the input logic editor.

Table 39  Tally Map Logic

Tally Output Device Type
Tally Map Logic

Tally Device Output Logic Tally Device Input Logic
GPI Outputs

Program tally of sources (red tally) (Tally Map) GPI single Source on air

Preset tally of sources (green tally) (Tally Map) GPI single Source next to air

UMD

UMD Displays (Tally Map) UMD single Source

Router Output Control

Control of broadcast router TAKE (nothing to select)

Virtual, single crosspoint (Tally Map) Take single in Take virtual

Virtual, multiple crosspoints (Tally Map) Take multiple in Take virtual
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Using a Tally Map
For example, in a Source to GPO tally map, clicking a crosspoint will assign a particular broadcast 
Source to a particular GPO for on-air tally purposes.

To use a tally map

1. From the top toolbar on the Ultricore-Tally Web Console, select Tally Maps.

2. Select a tally map from Tally Maps menu.

3. To assign a tally input device item to a tally output device item, select a crosspoint on the map.

In the following example, the user selected one crosspoint.

4. On the far right of the Web Console menu bar, select Configuration File.

5. Click Save Current Config Files. 
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Ultricore-Tally and Ultriscape
This chapter outlines how to configure the Ultricore-Tally to work with Ultriscape UMD tallies.

 The procedures in this chapter assume you have a working knowledge of the Tally System 
Console. Refer to the Tally System Console User Guide and the Ultricore-Tally Device Setup 
Guide for information on navigating this application and configuring your tally system. 

Setup for Destination Based Tallies
This section outlines the required steps for configuring destination-based tallies:

1. Create a Comm Port for the Ultricore BCS in the Tally System Console.

2. Create a Comm Port for the Router.

3. Verify the Remote Controller Mode on the Router.

4. Enable the Protocols on the Ultricore BCS.

5. Confirm that TSL UMD v5 Wrapping is Enabled.

6. Verify the Connection to the Ultrix Router.

7. Configure the PiP Destinations for the Database.

8. Configure the Multiviewer Heads.

9. Define the PiP Destinations in the Tally System.

10. Define the UMD Tallies in the Tally System.

11. Assign the Ultricore BCS Tally IDs to the Tally System UMD.

Create a Comm Port for the Ultricore BCS in the Tally System Console
This section outlines how to navigate the Tally System Console to create a new Comm Port 
connection for the Ultricore-Tally that will communicate with the Ultriscape Multiviewer.

To create a new Comm Port in the Tally System Console for the Ultricore-Tally

1. Launch the Tally System Console on your computer. 

2. In the Tally System Console, select Hardware > Comm Port Setup > Displays.

3. Create a new port for the Ultricore-Tally:

a. Use the Port Name field to specify a name to the port. 

In the following example, the user is configuring BCS-Tally-rtr.

b. Set the TSI Tally Controller Unit to BCS-Tally-A.

c. Set the Protocol to Ross Ultrix Multiviewer (TSL v5.0-Wrapped: MV is TCP Server). 

TSL-5.0 'wrapped' protocol is recommended, to follow default 'wrapped' option in BCS.

d. Use the Device Configuration dialog to specify the IP Address assigned to your Ultricore 
BCS (do not enter the Ultrix IP address) in the IP Addr #1 field. 
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Create a Comm Port for the Router
Next you will set up a Comm Port for the Ross Ultrix Router that includes the Ultriscape Multiviewer.

To create a new Comm Port in the Tally System Console for the Router

1. In the Tally System Console, select Hardware > Comm Port Setup > Routers.

2. Create a new port for the router:

a. Use the Port Name field to specify a name to the port. 

In the following example, the user is configuring RTR.

b. Set the TSI Tally Controller Unit to BCS-Tally-A.

c. Set the Level to 0.

d. Set the Protocol to Ross Ultrix Router (SW-P-08 TCP/IP port). 

e. Use the Device Configuration dialog to specify the IP address assigned to your Ultricore 
BCS (do not enter the Ultrix IP address). Ensure to enter the same value in both IP Addr 
fields.
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Verify the Remote Controller Mode on the Router
You must enable Remote Controller Mode on the router for the Ultriscape Multiviewer you wish to 
connect to.

To verify the remote control mode on the router

1. Locate the Ultrix node in the Tree View of DashBoard.

2. Expand the main Ultrix node.

3. Select Product Info > Setup.

4. Locate the Control Mode area of the tab.

5. Verify that the Remote Control Mode box is selected.

Enable the Protocols on the Ultricore BCS
Confirm that the SW-P-08 and TSL protocols are enabled on the Ultricore BCS. This will allow the 
Ultricore-Tally to communicate via these protocols to the Tally System devices.

To enable the protocols on the Ultricore BCS

1. Locate the Ultricore BCS node in the Tree View of DashBoard.

2. Expand the main Ultricore BCS node.

3. Expand the Ultricore BCS sub-node to display a list of sub-nodes in the Tree View.

4. Select System > Configuration > Connections.

5. Select the Services tab.
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6. Verify the Enable Probel SW-P-08 box is selected.

7. Verify the Enable TSL box is selected.

8. Click Apply if you edited the settings on this tab.

Confirm that TSL UMD v5 Wrapping is Enabled
Confirm that the TSL-5 UMD Wrapping option is enabled in both the Ultricore BCS and the Tally 
System Console.

To confirm on the Ultricore BCS

1. From the Ultricore BCS tree in DashBoard, select System > Configuration > Connections.

2. Select the Protocol Servers tab.

3. Click Options.

The Server Options dialog opens.

4. In the TSL UMD v5 area, confirm the Wrapping box is selected. 

5. Click Apply.
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To confirm on the Tally Console

1. In the Tally System Console, select Hardware > Comm Port Setup > Displays.

2. Locate the row for the Comm Port you created in “To create a new Comm Port in the Tally 
System Console for the Ultricore-Tally”.

3. Locate the Protocol column.

4. Verify that the cell reports Ross Ultrix Multiviewer (TSL v5.0-Wrapped: MV is TCP Server).

Verify the Connection to the Ultrix Router
It is recommended to verify the connection between the Ultricore BCS and the Ultrix router running 
the Ultriscape Multiviewer.

To verify the connection

1. From the Ultricore BCS tree in DashBoard, select Database > Configuration > Routing 
Devices.

2. In the left pane, select the row for the Ultrix router with Ultriscape that is connected to the 
Ultricore BCS. 

The Communication tab in the right pane now displays the settings for the selected router. 

3. Locate the Communication area of the tab.

4. Make a note of the router IP Address.

To verify the Ultriscape is enabled on your Ultrix router

1. Display the Ultrix router in the Tree View of DashBoard.

 If the Ultrix router is not already in the Tree View, refer to “To manually add the Ultricore BCS 
to the Tree View in DashBoard” using the IP Address from step 4 in the previous procedure.

2. Expand the Ultrix node to display a list of sub-nodes.

3. Select System > Configuration > Ultrix.

The Device Configuration Interface displays.

4. Select 

5. Select the UltriScape tab.

6. Locate the row for the slot and head that will provide the Ultriscape Multiviewer.

7. Identify slot and head includes an active Ultriscape license. If it does not, refer to the Ultriscape 
User Guide for details on enabling a license.

Configure the PiP Destinations for the Database
This section outlines how to define the PiP destinations in your Ultricore BCS database for inclusion 
in the Tally System.

To assign Tally IDs and the Tally Mode to the PiP destinations

1. Display the Ultricore BCS tree in DashBoard. 

2. Select Database > Configuration > Destinations.

3. Identify the PIP destinations that match the Slot / Head of interest found in step 7 of the 
previous procedure. 

In the following example, the user is verifying the destinations assigned to Slot 1 Head 1. 
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4. For each PiP Destination: 

a. In the Tally column, set the Tally ID. A range starting from 1001 is recommended. 

b. Set the Tally Mode to Normal. 

 This step is for destination-base UMD setup. For source based UMD setup, refer to “Setup for 
Source Based Tallies”.

Configure the Multiviewer Heads
This section provides a brief overview of how to configure an Ultriscape Multiviewer Head for tallies 
in your routing system. Refer to the Ultriscape User Guide for more details.

To configure the Multiviewer Head for tallies

1. Display the same Ultrix router in DashBoard that you accessed in “To verify the Ultriscape is 
enabled on your Ultrix router”.

2. Select Ultriscape > Head Selection.

The Head Selection interface displays in DashBoard.

3. From the top row, select the tab for the required Multiviewer Head.

4. Assign all PIP # Source fields to a database source. 

 Do not select any Destination Follow entries.

5. Click Apply. 

6. From the Ultriscape tree view, double-click the Layout Editor node.

The Layout Editor interface displays in DashBoard.

7. Load the layout you wish to configure for tallies.

a. From the main toolbar, select File > Load Layout Template from Ultricore.

The Load Layout Template dialog opens.

b. Select a layout from the provided list.

c. Click OK.

The Layout Editor now displays the selected layout.
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8. For each PIP of the layout:

a. Set the Type to PiP Sources. 

b. Select the Tally box.

c. Select the Use Tally Label box.

9. To save your layout to the system, select File > Save to Ultricore.

Define the PiP Destinations in the Tally System
Once you defined the tally settings for the PiP Destinations and Multiviewer Head, you will add this 
information to the Tally System Console.

To define the PiP Destinations within the tally system

1. In the Tally System Console, select the I/O & Signals tab.

2. Select Destination Definitions.

3. Locate the row for the first PiP Destination.

4. In the Output Name column, enter the ID values of the PIP Destinations from “To assign Tally 
IDs and the Tally Mode to the PiP destinations”. 

In the following example, the Output Name value range starts with a Destinations ID of 037.

Define the UMD Tallies in the Tally System
Define the UMD tallies in the tally system using the information from the router destinations 
configuration. This will link the UMD tallies with the destinations in your database.

To define the UMD tallies in the Tally System

1. In the Tally System Console, select UMDs > Display Devices (UMDs).

2. Locate the ID / Serial# column.
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3. Enter the values from the Ultricore BCS > Database > Configure > Destinations > Tally column in 
“To assign Tally IDs and the Tally Mode to the PiP destinations” (where in this example the 
values of 1001, 1002, etc. were used). 

4. Locate the Monitoring Style column.

5. Set a destination-based monitoring style (for example Destination Long or Dest:Source).

Assign the Ultricore BCS Tally IDs to the Tally System UMD
Next you will define the destination-based UMD setup in the tally system. 

To assign the PiP Destinations to the Display Devices in the tally system

1. In the Tally System Console, select Display Devices (UMD) > Destination Definitions.

2. Multi-select the required PiP destinations from the router database. 

3. Drag the selections into the Monitoring Description column. 
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4. When prompted, select Assign a single parameter to each row.

 This step is for destination-base UMD setup. For source-based UMD setup, refer to “Setup for 
Source Based Tallies”.

Setup for Source Based Tallies
The setup for source-based tallies is similar to destination-based tallies except for the following:

1. In the Ultricore BCS > Database > Destinations, ensure for each PiP destination that the:

a. Tally ID column is empty.

b. Tally Mode column is set to Redirect.

2. In the Ultricore BCS > Database > Sources that the Tally IDs are filled in to correspond to the 
Tally System Console > UMDs > ID / Serial # column (usually 1, 2, 3, etc.).

3. In the Ultrix > Ultrix > System > Configuration > Tally Settings tab:

a. Locate the Tally Label Text Settings area.

b. Set the Source Mode to overwrite.

4. In the Ultrix > Ultrix > System > Configuration > Label Settings tab:

a. Locate the Label Settings area.

b. Set the Dest Follow Label Displays to SRC.

5. To verify whether the UMDs are updated in the Ultriscape controlled monitor wall:

a. Navigate to the Ultrix > Ultriscape > Head Selection interface.

b. Select a different layout.

c. Click Apply.
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d. Wait a moment to ensure the new layout is loaded.

e. Return to the layout of interest.

f. Click Apply. 

g. Verify that the Ultriscape loaded the edited version of the layout.

6. In the Tally System Console, select Display Devices and perform the following:

a. Set the Monitoring Styles column to Source. 

b. Set the ID / Serial # column to correspond to the Tally IDs set in step 2 of this section 
(typically 1,2,3 etc.). 

c. In the left menu tree, select the I/O & Signals > Source Definitions.

d. Multi-select the required Source Definitions to be assigned to UMDs. 

e. Drag the selected sources to the Display Devices (UMDs) > Monitoring Description 
column. 

f. When prompted, select Assign a single parameter to each row.

 To access the Source Definitions list in the left menu tree, select the + icon beside the Source 
Definitions title (not the Source Definitions title itself).
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Operation with Ross Devices
This chapter provides additional information when connecting the Ultricore BCS to Ross devices 
such as the Ultrix routers, the NK series routers, and Remote Control Panels (RCPs).

For More Information on...
• setting up communications between Ultricore BCS and devices, refer to “Enabling a Service”.

Operation with an Ultrix Router
The Ultricore BCS provides support for larger routing databases, greater client connections as well 
as enhanced control and connectivity capabilities. Ultricore BCS allows you to scale your control to 
include multiple frames, tielines, IP routing, and distributed routing systems.

Figure 36  Example Setup Using an Ultricore BCS with Multiple Ultrix Routers and Panels

1
4

1
4

1
4

1
4

EN
ET

 1
EN

ET
 2

AL
AR

M
LT

C
m

ic
ro

 S
D

R
-O

U
T

SF
P 

1
SF

P 
2

LO
O

P 
   

   
   

 

TE
R

M

A 
   

   
   

 B 
   

   
   

 

2 3 4 5 6 7 8 91 10 11 13 14 15 1612

1

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

R
EF

 A
B

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

C
D

A
B

U
ltr

ix
 H

D
X-

IO
!

9
10

11
12

13
14

15
16

O
U

T
5

6
7

8
1

3
2

4
9

10
11

12
13

14
15

16
IN

5
6

7
8

3
2

4

U
ltr

ix
-S

FP
-IO

A
U

X
 A

A
U

X
 B

1
2

3
4

5
6

7
8

9
10

11
12

13
14

15
16

!

U
ltr

ix
-IP

-IO
!

P
O

R
T

 1
P

O
R

T
 2

A
U

X
 2

P
O

R
T

 3
P

O
R

T
 4

U
ltr

ix
 IP

X-
IO

C
D

A
B

!

1
3

2
4

10
0G

1 1 1 1 1 1 1 1 1 11 11 1

ENET 2

ENET 1

1 4 A B 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN
REF

C DA B

Ultrix HDX-IO !
9 10 11 12 13 14 15 16

OUT
5 6 7 81 32 4 9 10 11 12 13 14 15 16

IN
5 6 7 8321 4

C DA B

Ultrix HDX-IO !
9 10 11 12 13 14 15 16

OUT
5 6 7 81 32 4 9 10 11 12 13 14 15 16

IN
5 6 7 8321 4

PORT 1 PORT 2 AUX 2AUX 1 PORT 3 PORT 4

Ultricore BCS
System Control and Interface

Internet / LAN / VPN

PC running DashBoard

ULTRIX-NS-FR2
64x64 3G/HD/SD SDI Router

MultiViewer

GbE Network

IP Media Network

PORT 2 PORT 3 PORT 4 PORT 5 PORT 6 PORT 7 PORT 8PORT 1

PORT 14 PORT 15 PORT 16 PORT 17 PORT 18 PORT 19 PORT 20PORT 13

RCP-QE18
Remote Control Panel

+5V ETHERNET

NK-3G-16
16x16 3G/HD/SD SDI Router

T-BUS VID REF

1 3 5 7 9 11 13 15

2 4 6 8 10 12 14 16
INPUTS

1 3 5 7 9 11 13 15

2 4 6 8 10 12 14 16
OUTPUTS

NK-NET
T-BUS to Ethernet Adapter

NK-NET

TB
U

S

ET
H

ER
N

ET

Server 2

PORT 9 PORT 10

PORT 22 PORT 23 PORT 24

PORT 11 PORT 12

PORT 21

RCP-NKM
Remote Control Panel

PSU
T-BUS

Server 1

Ultrix IPX-IO

C DA B

!

1 32 4100G

C
D

A
B

U
ltr

ix
 IP

X-
IO

!

A
R

EF
B

1
2

3
4

5
6

10
0G

20
0G



142 • Operation with Ross Devices Ultricore BCS User Guide (v11-rev8)

Operation Notes
Keep the following in mind when operating an Ultrix router within the Ultricore BCS routing system:

• The Ultrix hardware is configured on the Ultrix router in DashBoard. 
• Device specific functions such as hardware setup, installed license keys, and Ultriscape setup 

remain in the DashBoard node of the Ultrix router. 
• The Ultriscape (Multiviewer) licensed feature is configured on the Ultrix router in DashBoard.
• All crosspoint changes (including salvos) must originate from the master Ultricore BCS database.
• All routing commands are sent to and executed by the master Ultricore BCS. This includes any 

third-party communications (GVG, Probel, TSL, etc.). The Ultrix router will ignore any routing 
commands not originating from the master Ultricore BCS database while in this connected mode.

• If more than one Ultrix router is to be controlled from the Ultricore BCS, ensure that you assign 
unique device names for the Ultrix routers via the front panel. This will help to quickly identify the 
routers within the Ultricore BCS system. Refer to the Ultrix User Guide for your router.

• Each Ultrix router must be configured for remote control mode. Refer to the Ultrix User Guide for 
your router.

• All Remote Control Panels (RCP) must be configured to connect with the master Ultricore BCS.

For More Information on...
• configuring your database, refer to the Ultrix and Ultricore Database Guide.

Using Tielines
A tieline is a method of connecting two routers together so that they may share sources and 
destinations. How many inputs and outputs that can be shared depends on how many tielines have 
been provisioned, if the tielines are in use, or if a user has permissions to use them. 

Figure 37 represents a two-way tieline connection between routers where one (or more) outputs of 
Ultrix 1 are connected to the inputs of Ultrix 2, and one (or more) outputs of Ultrix 2 is connected to 
the inputs of Ultrix 1. 

Figure 37  Example of a Distributed Routing System Work Flow with Tielines

Figure 38 illustrates a work flow where Ultrix 2 needs a source that is only present on Ultrix 1. The 
Ultricore BCS routes the requested source to a destination that is configured as a tieline, and on 
Ultrix 2, it will route the tieline source to the user selected Destination. 

 Tielines do not have to be bi-directional as represented in Figure 37 and Figure 38.

1 2 3 4IP: ###.###.##.### 1 2 3 4IP: ###.###.##.###

Ultrix 1
Sources

Ultrix 2
Sources

Ultrix 1 Destinations Ultrix 2 Destinations

Tielines
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Figure 38  Example of Tielines in a Work Flow

In Figure 38 the following occurred:

1. An RCP-QE36 panel, with access rights, made a request for a source on Ultrix 1 to be connected 
to a destination on Ultrix 2.

2. The Ultricore BCS determined the ‘path’ knowing it has to use a tieline. 

3. The Ultricore BCS had a free tieline and enabled:

a. The Ultrix 1 requested source to switch to the tieline.

b. The Ultrix 2 tieline input to switch to the requested destination.

For More Information on...
• using the Tieline Builder feature, refer to the Ultrix and Ultricore Database Guide.

Operation with Ross NK Series Routers
Ross NK series routers and RCP devices may connect to the Ultricore BCS via an NK-IPS/NK-NET 
over Ethernet.

 It is recommended for optimum performance to minimize device connections to the NK-NET.

Figure 39 provides an example of a routing system with an Ultricore BCS, an NK-IPS, and several 
Ross NK devices. Communication between the NK-IPS and the Ross NK devices is over T-Bus, while 
the Ultricore BCS communicates with the NK-IPS via Ethernet.
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Figure 39  Connection Example with an NK-IPS

Introducing an Ultricore BCS to an existing Ross NK system requires specific configuration to enable 
the Ultricore BCS to manage the devices in the routing system. All Ross NK routers are automatically 
discovered1 and appear in the available matrix list ready for label assignment.

Ross NK Series routers can utilize two methods of connection to the Ultricore BCS: Direct T-Bus 
connection and Ethernet connection via an NK-IPS or NK-NET.

Keep the following in mind:

• The NK-IPS requires version 2.23 or greater to communicate with an Ultricore BCS.
• The SCP/A is not supported.
• The SCP/K2 is not supported.
• NK-A64 control level is not supported.
• Ross NK router partitioning not supported. The logical mapping of the Ultricore BCS control 

system is far more capable and should be implemented there if required

1. Once an Ethernet connection point has been established for Ethernet connections.

Network Switch

PORT 2 PORT 3 PORT 4 PORT 5 PORT 6 PORT 7 PORT 8PORT 1

NK-IPS
Network Bridge

ETHERNET

POWER Service
PortT-BUS

RCP-NKM
Remote Control Panel

PSU
T-BUS

RCP-NKQ
Remote Control Panel

PSU
T-BUS

NK-A64
32x32 Stereo Analog Audio Router

T-BUS

T-BUS VID REF

AUDIO
INPUTS

1-4

9-12

17-20

25-28

5-8

13-16

21-24

29-32

1-4

9-12

17-20

25-28

5-8

13-16

21-24

29-32

AUDIO
OUTPUTS

NK-MD32
Machine Control / Data Router

POWER

18

2

19

3

17

1

20

4

21

5

22

6

23

7

24

8

25

9

26

10

27

11

28

12

29

13

31

15

30

14

32

16

Ultricore BCS
System Control and Interface

Internet / LAN / VPN

PC running DashBoard



Ultricore BCS User Guide (v11-rev8) Operation with Ross Devices • 145

Table 40 outlines the nomenclature that Ultricore BCS automatically uses for Ross NK devices.

Using Ross Analog Audio Devices (NK-A16, NK-A32, NK-A64)
The Ross NK Analog Audio devices (NK-A16, NK-A32, NK-A64) will present as two matrices: Left and 
Right respectively.

Adding Ross NK Series Routers to the Ultricore BCS
Add a Ross NK series device to the Ultricore BCS requires the following steps:

1. Define a connection point between Ultricore BCS and each NK-IPS or NK-NET. 

2. Review the port label matrices for the Ultricore BCS database.

3. Assign outputs to the logical destinations in the database.

4. Assign inputs to the logical sources in the database.

For More Information on...
• configuring a database, refer to the Ultrix and Ultricore Database Guide.

Integrating RCP-NK Series Panels with an Ultricore BCS
When adding the Ultricore BCS router to an existing system with one or more RCP-NK devices, each 
remote control must:

• have the Virtual routing enabled on their Configuration page;
• have the Comms Retry Delay Factor set to 80ms or greater;
• ensure that the level numbers correspond to the Ultricore BCS Level ID number in the database;

Be aware that the RCP-NK devices do not:

• support Ultricore BCS salvos;
• automatically retrieve source and destination labels from the Ultricore BCS. The labels must be 

entered manually or via a global labels file.

Table 40  Default Ultricore BCS Naming for Ross NK Devices

Ross NK Device Matrix Name Port Name
NK-3Gxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Axxx deviceName.An Aud L deviceName.slot1.in/out[socket number].An Aud 
L.ch1

deviceName.An Aud R  deviceName.slot1.in/out[socket number].An Aud 
R.ch1

NK-Dxxx deviceName.AES deviceName.slot1.in/out[socket number].AES.ch1

NK-Mxx deciceName.Machine 
Control

deviceName.slot1.in/out[socket number].Machine 
Control.ch1

NK-MDxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Vxxx deviceName.An Vid deviceName.slot1.in/out[socket number].An Vid.ch1
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Integrating Ross RCP-ME/RCP-QE Panels with an Ultricore BCS
RCP-QE and RCP-ME Ethernet series remote control panels connect to Ultricore BCS via the facility 
network. The panels offer some extra features not available to RCP-NK series control panels;

• automatic source and destination labeling
• automatic level and salvo labeling
• the ability to trigger system wide salvos
• Category index source/destination selection method

Adding a Ross RCP-ME or RCP-QE Panel to the Ultricore BCS
The Connection Editor interface for an RCP-ME or RCP-QE enables you to configure the connection 
point from the panel to Ultricore BCS. You will need DashBoard installed and running to access the 
Connection Editor interface.

To add an RCP-ME or RCP-QE

1. Connect the RCP to facility network and configure the network settings as outlined in the user 
guide for your remote control panel.

2. Open the Connection Editor in DashBoard for your panel as follows:

a. In the Basic Tree View of DashBoard, expand the tree view for the remote control panel.

b. Double-click the Connection icon within the device tree.

The Connection Editor opens.

3. Locate the Servers to connect to area.

4. In a row of the provided table:

a. Type the IP Address of the Ultricore BCS you want to establish a connection to.

b. Press Enter to confirm the new value.

 Ultricore BCS may operate in a dual redundant controller mode. When operating in this mode, 
the IP address of the secondary Ultricore BCS is entered in the second row of the Servers to 
Connect to table. This enables the RCP to fail over to the secondary Ultricore BCS unit if the 
primary goes off-line.

5. Upon a successful connection and a refresh of the current DashBoard view (click the Refresh 
button), a check mark displays next to the successful connection. In the above example, an IP 
Address is entered for Server 1.

6. Verify in the Connections area that a connection is establish.

7. Configure the Remote Control Panel layout as outlined in the user guide for your panel.
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Machine-Control (RS-422) Logical Mapping
Connecting an NK-M series router to Ultricore BCS requires some special consideration.

Machine control routing requires two crosspoints for a point to point connection due to the 
bi-directional nature of the signal. Each physical socket contains a transmit/receive pair. This can be 
thought of as a source-destination combination and is known as a port. 

It is necessary to configure the input and output of the machine control port on the same row ID on 
the logical mapping tables.

Figure 40  Database — Destination Mapping

Figure 41  Database — Source Mapping

It does not matter where the machine control is mapped (either row 3 or 300), but the input and 
outputs physical ports must be mapped to the same row ID.

Conditions for Machine Control
Three conditions must be met before machine control can be switched.

1. The NK machine control router is attached and configured within the Ultricore BCS database 
(level, destination, and source maps). Refer to the Ultrix and Ultricore Database Guide.

2. Selected breakaway or level must include the machine control level.

3. Machine control reciprocal must be enabled on the controller.
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Setting up a Redundant System
This chapter outlines how to configure two Ultricore BCS panels into a single standby redundant 
system.

General Overview
The Ultricore BCS includes an option to set up a standby (backup) redundant system with two 
identical Ultricore BCS panels. The second panel backs up the first panel when it detects that the 
first panel fails. This enables reliable switching. 

When configured in redundant mode, the two panels share the same IP address. 

Figure 42  Example of Two Ultricore BCS Panels in a Redundant System
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Before You Begin
Ensure you have the following before setting up your Ultricore BCS redundant system:

• two Ultricore BCS panels each configured with a unique IP address on the same network subnet, 
and both panels accessible via DashBoard

• a unique IP address is required for the units to share when in redundancy mode. This IP address 
must be on the same network subnet as the Ultricore BCS panels.

Cabling Requirements
The first Ultricore BCS must be physically cabled to the second Ultricore BCS via the ENET2 ports on 
each unit. This section briefly outlines the required cabling method.

To connect the first Ultricore BCS to the second Ultricore BCS

1. Plug one end of an RJ45 1GbE network cable into the ENET2 port of the first Ultricore BCS.

2. Plug the other end of the same cable to the ENET2 port of the second Ultricore BCS. 

 The two Ultricore BCS panels must be directly connected via their ENET2 ports. Do not use a 
network switch or router between the two panels.

Figure 43  Cabling — Connecting Two Ultricore BCS Panels for Redundancy

Notes about Connecting
 Do not disconnect the tether (ethernet connection between the Ultricore BCS panels) once a 

redundancy connection is established. Redundancy will be lost and both will try to assume the 
master/primary role resulting in unpredictable behavior. 

If the tether is disconnected:

1. Power down the secondary Ultricore BCS panel. 

2. Reconnect the tether.

3. Wait 1 minute.

4. Power on the secondary Ultricore BCS panel.

 Do NOT reconnect the tether if both Ultricore BCS panels remain active. 
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Enabling Redundancy
When BCS Redundancy is enabled via DashBoard, the two Ultricore BCS panels will share a virtual 
(third) IP address. While in redundancy mode, DashBoard will connect to both panels using the 
shared IP address but only show one panel (the primary unit) in the Tree View of DashBoard.

 Before proceeding, ensure that the Enable Web Access box is selected on the Ultricore BCS > 
Connections > Services tab on each Ultricore BCS panel. Refer to “Enabling a Communication 
Service” for details.

There are two methods of creating a redundant system:

• Configuring a new redundancy system using two newly installed Ultricore BCS panels.
• Replacing an Ultricore BCS panel in a redundancy system already configured and running.

Both methods are outlined in this section.

Configuring a New Ultricore BCS Redundant System
Configuring a new Ultricore BCS redundant system requires you to:

1. Create a new redundant pair in DashBoard using the options in the System Status > BCS 
Redundancy tab.

2. Remove each Ultricore BCS node from the Tree View and power cycle each panel.

3. Add the Ultricore BCS redundant pair to the DashBoard Tree View.

4. Verify the Ultricore BCS pair connection is valid.

To create a new Ultricore BCS redundant pair

1. Locate the node for the first Ultricore BCS in the Tree View of DashBoard.

2. Expand the first Ultricore BCS node.

3. Double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

4. Select the BCS Redundancy tab.

5. Select the BCS Redundancy Enabled box.

The Enable BCS Redundancy dialog opens.

6. Use the Create or Join Existing Pair menu to specify Create New Redundant Pair.

The options in the Enable BCS Redundancy dialog update.

7. Use the Secondary BCS IP Address field to specify the IP address of the second Ultricore BCS 
panel.

8. Use the Shared IP Address field to specify the unique IP address that the two Ultricore BCS 
panels will share.

9. Click Apply.

The Enable BCS Redundancy dialog closes.

The fields in the BCS Redundancy tab update with the new values.
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To remove the Ultricore BCS nodes from the Tree View

1. Locate the Basic Tree View pane in the DashBoard window.

2. Remove the first Ultricore BCS node as follows:

a. Right-click the node for the first Ultricore BCS.

b. Select Remove.

The Confirm tree item removal dialog opens.

c. Click OK.

The Confirm tree item removal dialog closes and the first Ultricore BCS node is deleted 
from the Tree View.

3. Repeat step 2 for the second Ultricore BCS.

4. Power cycle each Ultricore BCS panel.

To add the Ultricore BCS Redundancy System to the DashBoard Tree View

1. In the Basic Tree View toolbar of DashBoard, click .

The Add New Connections dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.
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5. Use the IP Address field to specify the Shared IP Address for the Ultricore BCS Redundancy 
System.

 The shared IP Address is the same value you entered in step 8 of the previous procedure.

6. Use the Display Name field to specify a unique name for the Ultricore BCS Redundancy 
System. 

7. Set the Protocol to JSON.

8. Set the Port to 5354.

9. Click Finish. 

The Ultricore BCS Redundancy System node displays in the Tree View. 

To verify the Ultricore BCS Redundancy System is valid using DashBoard

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. Double-click the Product Info node under the Ultricore BCS Redundancy System node.

The Product Info interface displays in the DashBoard window.

4. Select the BCS Redundancy tab.

5. Review the information reported in the read-only fields of the tab.

Replacing an Ultricore BCS Panel in an Existing Redundancy System
Use the procedures in this section should you need to replace an Ultricore BCS panel in a 
configured redundancy system.

 The replacement Ultricore BCS panel must be configured with its own IP Address and directly 
connected to the functioning panel as described in “Before You Begin”.

To replace an Ultricore BCS in an existing redundancy system

1. Disable the Redundancy Mode on the currently active master panel as described in “Disabling 
the Ultricore BCS Redundancy Mode”. 

2. Create a new redundant pair as described in “Configuring a New Ultricore BCS Redundant 
System”.

To verify the Ultricore BCS Redundancy System is valid

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

4. Select the BCS Redundancy tab.

5. Review the information reported in the read-only fields of the tab.

Monitoring the Ultricore BCS Redundancy System
An alarm may be set to trigger when Ultricore BCS redundancy fails.

To enable the Standby BCS alarm

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. In the Tree View of DashBoard:
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a. Expand the System sub-node.

b. Expand the Configuration sub-node.

c. Double-click the UltricoreBCS sub-node.

4. From the left toolbar, click Alarms.

 The Alarms table displays.

5. In the Type column of the Alarms table, select a row marked None.

A drop-down menu opens.

6. Select Standby BCS.

 

Forcing a Failover Switch
You can force a switch from one Ultricore BCS panel to the second in a redundancy system via 
DashBoard.

 Failover occurs immediately for remote control panels (RCPs) and third-party controls. All 
instances of DashBoard may take up to a minute for control to be restored.

To disable redundancy mode on the first Ultricore BCS panels

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

4. Select the BCS Redundancy tab.

5. Click Force BCS Active/Standby Failover.

6. Verify that the switch occurred by checking the values in the Shared IP Address and Active IP 
Address fields in the BCS Redundancy tab,

Disabling the Ultricore BCS Redundancy Mode
Disabling the redundancy mode between two Ultricore BCS panels requires you to:

1. Disable the redundancy mode in DashBoard.

2. Reset the IP address on each Ultricore BCS panel.

3. Manually add each Ultricore BCS panel to the Tree View in DashBoard.

To disable redundancy mode

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. In the Tree View of DashBoard, double-click the Product Info node.
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The Product Info interface displays in the DashBoard window.

4. Select the BCS Redundancy tab.

5. Clear the BCS Redundancy Enabled box.

To manually add the first Ultricore BCS to the Tree View in DashBoard

1. In the Basic Tree View toolbar of DashBoard, click .

The Add New Connections dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Enter the IP Address for the first Ultricore BCS in the IP Address field.

6. Click Detect Frame Information.

7. Click Finish. 

The first Ultricore BCS now displays in the Tree View. 

To manually add the second Ultricore BCS to the Tree View in DashBoard:

1. In the Basic Tree View toolbar of DashBoard, click .

The Add New Connections dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Enter the IP Address for the second Ultricore BCS in the IP Address field.

6. Click Detect Frame Information.

7. Click Finish. 

The second Ultricore BCS now displays in the Tree View. 

Software Upgrades
 Contact Ross Technical Support before upgrading the software for your Ultricore BCS redundant 

system. 

Upgrading your Ultricore BCS redundant system requires you to:

1. Upgrade the software on the standby Ultricore BCS.

2. Reboot the standby Ultricore BCS.

3. Wait until the standby Ultricore BCS is in sync with the primary Ultricore BCS.

4. Perform a failover to the newly upgraded standby Ultricore BCS.

5. Upgrade the software on the newly standby Ultricore BCS.

6. Reboot the newly standby Ultricore BCS.

7. Perform a failover.
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System Integration Examples
There are many aspects of Ultricore BCS that you can configure to suit the needs of your 
organization. The properties that you are able to configure depends on your user permissions. Note 
that the information provided is for illustration purposes only, and the requirements for your 
facility may differ from what is presented.

Adding Ultricore BCS to Legacy Systems
In this example, you have legacy NK routers without remote control panels but you want to add the 
Ultricore BCS as a system controller. You can use Ultricore BCS and a series of NK-NETs to provide 
Ethernet connectivity for T-Bus based legacy systems. (Figure 44)

Figure 44  Adding Ethernet Communications via an Ultricore BCS
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Integrating Third Party Routers with an Existing System
Ultricore BCS integrates supported third-party routers using GVG protocol translation. In Figure 45, 
the Ultricore BCS or the Ross router is the system master. 

Figure 45  Integrating Third-Party Routers with an Ultricore BCS
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Adding Third Party Control to Existing Systems
If you have an existing Ross routing system, you can add an external controller, such as an 
automation device, that is compatible with a supported third-party protocol. In Figure 46, the 
Ultricore BCS acts as the system controller and provides a protocol translation for the external 
third-party control device. 

To add the third-party controller to your router system, connect the external controller to Ultricore 
BCS and configure Ultricore BCS to translate between the third-party controller and the rest of your 
Ross routing system. 

Figure 46  Adding Third-Party Control with an Ultricore BCS

ULTRIX-NS-FR2
64x64 3G/HD/SD SDI Router

ENET 2

ENET 1

1 4 A B

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

Ultrix-HDBNC-IO

REF

REF

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

AUX A AUX B

OUT IN

Ultrix-HDBNC-IO

Ultrix-HDBNC-IO

NK-3G-16
16x16 3G/HD/SD SDI Router

T-BUS VID REF

1 3 5 7 9 11 13 15

2 4 6 8 10 12 14 16
INPUTS

1 3 5 7 9 11 13 15

2 4 6 8 10 12 14 16
OUTPUTS

ETHERNET

RCP-ME
Remote Control Panel

PSU

Third-Party Controller
Controlled via GVG Protocol

U
S

B

U
S

B

U
S

B

U
S

B

PORT 1

C DA B

Ultrix HDX-IO !
9 10 11 12 13 14 15 16

OUT
5 6 7 81 32 4 9 10 11 12 13 14 15 16

IN
5 6 7 8321 4

C DA B

Ultrix HDX-IO !
9 10 11 12 13 14 15 16

OUT
5 6 7 81 32 4 9 10 11 12 13 14 15 16

IN
5 6 7 8321 4

C DA B

Ultrix HDX-IO !
9 10 11 12 13 14 15 16

OUT
5 6 7 81 32 4 9 10 11 12 13 14 15 16

IN
5 6 7 8321 4N

K
-N

ET
T-

BU
S 

to
 E

th
er

ne
t A

da
pt

er

N
K

-N
ET

TBUS

ETHERNET

Series7000/SWP-08/NP166

Internet / LAN / VPN

PC running DashBoard

Ultricore BCS
System Control and Interface



160 • System Integration Examples Ultricore BCS User Guide (v11-rev8)



Ultricore BCS User Guide (v11-rev8) Monitoring • 161

Monitoring
The status of the Ultricore BCS may be monitored via its fields in the DashBoard client software or 
the LEDs located on the front panel of the chassis.

Enabling Logging for the Ultricore BCS
The Ultricore BCS records events in non-volatile memory. Each event includes a timestamp, and 
information about the event. The following events and conditions are recorded in the logs:

• Configuration changes that affect the routing path.
• Input state changes such as video presence, audio presence, video formats. In the case of audio 

inputs, the log entry also includes the associated audio cluster.
• Power-on or reboot cycles.
• Error conditions reported by DashBoard.

To enable the Ultricore BCS to log events

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Setup tab.

3. Select the Logging box.

Monitoring the Network Status
The Ethernet ports on the Ultricore BCS rear panel are used to connect to an Ethernet network for 
communications.

To verify the Ethernet redundancy status via the System Status interface

1. In the Tree View of DashBoard, double-click the Product Info node.

The Product Info interface displays in the DashBoard window.

2. Select the Network tab.

3. Refer to Table 3 for a summary of the possible messages displayed in the Network tab.

Saving the Current Settings for the Ultricore BCS
You can save the Ultricore BCS settings to a configuration file that can be used by Ross Technical 
Support for troubleshooting. 

 Use this procedure only under the guidance of Ross Technical Support.

To save your setup a new file

1. In the Tree View of DashBoard, right-click the node for the Ultricore BCS that you want to save 
the settings for.

2. Select Save Configuration to File.

The Save Configuration to File dialog opens.

3. Navigate to the folder on your DashBoard computer in which you want to save the 
configuration file. The default location is Desktop\My Documents. 

4. Click Save.
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Monitoring via DashBoard
Devices with an established and valid communication point with Ultricore BCS are reported in the 
System Monitor interface. Ultricore BCS aggregates all the devices in a system under the Monitoring 
sub-nodes to provide system wide monitoring capabilities. (Figure 47)

Figure 47  Example of the System > Monitoring Tree View

Logs Sub-node
Access this interface by expanding the Monitoring node and double-clicking the Logs sub-node. This 
interface displays the System Log, Controller Communications Log, and DashBoard 
Communications Log. The read-only information displayed in the logs is used by Ross Technical 
Support for diagnostic purposes.

Accessing the System > Logs in DashBoard

An entry in each log includes a timestamp, a code number, and a description. Messages are written 
to the log when significant changes occur in the operation of the Ultricore BCS. These could include: 
changes to video, reference, audio or time inputs; power-on or reboot cycles; configuration changes 
that can have an effect on the routing path; alarm conditions.

To access the system logs in DashBoard

1. Locate the Ultricore BCS node in the Tree View of DashBoard.

2. Expand the main Ultricore BCS node.

3. Expand the Ultricore BCS sub-node to display a list of sub-nodes in the Tree View.

4. Expand the System node.

5. Expand the Monitoring node.

6. Double-click the Logs sub-node.

7. To view the communication log for the Ultricore BCS only, select the System Log option.

8. To view the log for communications between the Ultricore BCS and other devices, select the 
Controller Communications Log option.

9. To view the log for executed tasks in DashBoard for the Ultricore BCS, select the DashBoard 
Communications Log option.

10. Click Refresh to update the entries for the currently selected log.

Health Sub-node
Access this interface by expanding the Monitoring node and double-clicking the Health sub-node. 
The Health interface enables you to check the overall health of your routing system, allowing you to 
notice when a steady increase of values in the Memory, Disk Space, and/or System

To monitor the external devices communicating with an Ultricore BCS via DashBoard

1. Locate the Ultricore BCS node in the Tree View of DashBoard.

2. Expand the main Ultricore BCS node.
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3. Expand the Ultricore BCS sub-node to display a list of sub-nodes in the Tree View.

4. Expand the System node.

5. Expand the Monitoring node.

6. Double-click the Health sub-node.

7. Notice that each row in the Incoming and Outgoing Connections area reports a count of the 
number of devices currently communicating with the Ultricore BCS in the form of x /y where x 
represents the number of connected devices and y represents the maximum number of 
connections allowed (licenses installed).

8. Use the Memory, Disk Space, and System Utilization fields to monitor traffic and 
communication between the devices in your routing system. The status bars in each field report 
when values are rising (yellow) to critical (red). 

Monitoring via the Front Panel
The Ultricore BCS front panel also reports the status information.

Figure 48  Ultricore BCS — Example of the Front Panel Display

For More Information on...
• the front panel display, refer to “Ultricore BCS System Monitoring Window”.

Memory Utilization Disk Space UltilizationDB Clients 13
RCP Panels 3
3RD Party Control 1
Ross IP-Video 3/4
Ross IP-Audio 1/2
IP-Video 1/1
IP-Audio 1/1

188_5RU        12.34.56...
145_5RU        23.45.67...
209_5RU        13.62.20...

System Utilization

IP: 12.32.123.235

Version: x.x.x

Name: UltricoreBCS-2AE75D

Uptime: 22h 38m 19s 

Redudant Mode: active

Shared IP: 12.32.123.237

default
Active Database

21% 44% 5%
Outgoing Connections

Incoming Connections
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Troubleshooting
Use the Memory, Disk Space, and System Utilization fields of either the front panel or the 
DashBoard interface to observe the routing system for a period of time when troubleshooting. 
While some variation in values is expected (Memory and System), the values should return to 
acceptable levels after a while. If the values steadily increase or remain at peak levels for extended 
periods, consider the following:

• Investigate the traffic in your network.
• Remove outdated or obsolete copies of system databases.
• If the value in the Memory field is high, you may wish to minimize size of the active system 

database by removing extra blank entries.

 Contact Ross Technical Support with a copy of the system logs if you need assistance. 

Monitoring the Ethernet LEDs on the Rear Panel
Each RJ45 connector on the Ultricore BCS rear panel include two LEDs that report the Ethernet 
communication activity and speed. Refer to Figure 49 for LED locations on the Ultricore BCS rear 
panel.

Figure 49  ENET Ports on Rear Panel — LEDs

Table 41 provides basic LED descriptions.

Table 41  ENET Port LEDs

LED Status Description
ENET # - 
Link/Activity

Green When lit green, this LED indicates a valid link is established 
on the specified ENET port.

Flashing When flashing green, this LED indicates communication 
activity is occurring on the specified ENET port.

Off When unlit, this LED indicates an invalid link is detected on 
the specified ENET port. Verify the cable connection on the 
rear module port and your network connections.

ENET # - Port 
Speed

Green When lit green, this LED indicates the ENET Port 
communication speed is at 1Gbps.

Yellow When lit orange, this LED indicates the ENET Port 
communication speed is at 100Mbps.

Off When unlit, this LED indicates the ENET Port 
communication speed is at 10Mbps.

ENET Port 1 Speed LED

ENET Port 1 Link/Activity LED

ENET Port 2 Speed LED

ENET Port 2 Link/Activity LED
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If you have any questions pertaining to the installation or operation of Ultricore BCS, please contact 
us at the numbers listed in “Contacting Technical Support”. Our technical staff is always available 
for consultation, training, or service.

Upgrading the Software
Ultricore BCS is upgraded through the DashBoard client. Contact Ross Technical Support to obtain 
the most recent upgrade package.

 Ensure that you are running DashBoard software version 9.13 or higher and that the computer 
running the DashBoard client is located on the same network as the Ultricore BCS panel.



166 • Monitoring Ultricore BCS User Guide (v11-rev8)



Ultricore BCS User Guide (v11-rev8) Panel Menu System Overview • 167

Panel Menu System Overview
There are two methods for monitoring: via a DashBoard client computer or using the Ultricore BCS 
hard panel. This chapter outlines the status field displayed on the hard panel.

Ultricore BCS System Monitoring Window
The System Monitoring window of the Ultricore BCS hard panel is organized into groups of 
read-only fields. (Figure 50) Use this window to verify the network settings for the panel, monitor 
communications with devices in your routing system, and troubleshoot system status.

 This window reflects the same information as reported on the System Monitor tab in DashBoard. 
To access this interface on a DashBoard client computer, double-click the Ultricore BCS Device 
sub-node in the Tree View and select Database > System Monitor.

Figure 50  Example of the Ultricore BCS Panel System Monitoring Window

Table 42 summarizes the options displayed in the System Monitoring window. 

Table 42  System Monitoring Window

Item Parameters Description
Active Database <text> Indicates the database currently loaded in this 

Ultricore BCS

IP #.#.#.# Indicates the IP Address assigned to this Ultricore 
BCS

Ver # Indicates the build version of the Ultricore BCS 
panel

Name <text> Indicates the unique identifier assigned to the 
Ultricore BCS

Uptime #h #m #s Indicates the number of hours, minutes, and 
seconds since the last reboot of the Ultricore BCS 
panel

Redundant Mode active Two Ultricore BCS panels are configured in a 
redundant system where they share the same IP 
address.
Refer to “Setting up a Redundant System” for 
details.

inactive The current Ultricore BCS panel is not setup in a 
redundant system

Memory Utilization Disk Space UltilizationDB Clients 13
RCP Panels 3
3RD Party Control 1
Ross IP-Video 3/4
Ross IP-Audio 1/2
IP-Video 1/1
IP-Audio 1/1

188_5RU        12.34.56...
145_5RU        23.45.67...
209_5RU        13.62.20...

System Utilization

IP: 12.32.123.235

Version: x.x.x

Name: UltricoreBCS-2AE75D

Uptime: 22h 38m 19s 

Redudant Mode: active

Shared IP: 12.32.123.237

default
Active Database

21% 44% 5%
Outgoing Connections

Incoming Connections
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Shared IP # When operating in a redundant system, this field 
indicates the IP address that the primary and 
secondary Ultricore BCS panels are currently using.

Incoming Connections

DashBoard Clients # Indicates the total number of DashBoard clients 
communicating with this Ultricore BCS 

RCP Panels # Indicates the total number of remote control panels 
communicating with this Ultricore BCS

3rd Party Control # Indicates the total number of third-party 
automation control devices communicating with 
this Ultricore BCS

Ross IP-Video # / # Indicates the total number of Ross Video IP 
Connectivity (video) devices communicating with 
this Ultricore BCS

Ross IP-Audio # / # Indicates the total number of Ross Video IP 
Connectivity (audio) devices communicating with 
this Ultricore BCS

IP-Video # / # Indicates the total number of third-party IP 
Connectivity (video) devices communicating with 
this Ultricore BCS

IP-Audio # / # Indicates the total number of third-party IP 
Connectivity (audio) devices communicating with 
this Ultricore BCS

Outgoing Connections

<device name> 
#.#.#.#

Displays the unique identifier and the assigned IP address of external 
devices (such as Ultrix routers) that the Ultricore BCS is sending 
information to.
The status indicator reports if the external device is reporting an error 
condition (red) or not (green).

Memory Utilization

# Percentage of system RAM currently in use

Disk Space Utilization

# Percentage of available storage space

System Utilization

# Measure of the communication traffic that the Ultricore BCS is 
managing

Table 42  System Monitoring Window (Continued)

Item Parameters Description



Ultricore BCS User Guide (v11-rev8) Technical Specifications • 169

Technical Specifications
This chapter provides technical information for Ultricore BCS.

 Specifications are subject to change without notice.

Physical Dimensions

Ethernet Port Connectors
Each Ultricore BCS comes standard with two ENET ports on the rear panel to interface with a local 
network, and Ross devices that use an Ethernet protocol for communications.

 The ENET 2 port is not implemented.

USB Port

Supported USB-Serial Converters
The following USB-Serial chip-sets are supported:

• FTDI
• Silicon Labs CP210x
• Prolific PL2303
• Belkin

Table 43  Technical Specifications — Physical Dimensions

Item Specification
Width 19” (48cm)

Depth 2.5” (6cm)

Height 3.5” (9cm)

Weight (approx.) 5.25lb (2.40kg)

Table 44  Technical Specifications — Ethernet Ports

Item Specifications
Number of Ports 2

Connector Type 8-pin, RJ45 1GbE network interface

Table 45  Technical Specifications — USB Ports

Item Specifications
Number of Ports 1

Connector Type USB2.0 socket
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Environmental

Power

Table 46  Technical Specifications — Environmental

Item Specifications
Maximum Ambient Temperature 
Range

0°C to 40°C (32°F to 104°F)

Humidity, non-condensing < 95%

Table 47  Technical Specifications — Power Supply Ratings

Item Specifications
Number of Ports 2

Power 15VDC @ 4A

Input 100-240Vac, 50/60Hz

Input Current 1.4A
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Software Licenses
This chapter provides third-party software license information for your Ultricore BCS. 

General Overview
Ultricore BCS includes multiple software components which are individually licensed under one or 
more of the following licenses included in this section.

BSD

Copyright (c) 1991,1993, The Regents of the University of California. All rights reserved.

This code is derived from software contributed to Berkeley by Kenneth Almquist.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

3. <BSD Advertising Clause omitted per the July 22, 1999 licensing change ftp://ftp.cs.berkeley.edu/pub/4bsd/README.Impt.License.Change> California, Berke-
ley and its contributors.

4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior 
written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CON-
SEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABIL-
ITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE.

Dual GPL

Portions of this software are copyright (C) 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

This project is also covered under the GPL v2.

GPL
GNU GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Pub-
lic License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free 
Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply 
it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distrib-
ute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces 
of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if 
you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must 
make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission 
to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL 
requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is funda-
mentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for indi-
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viduals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If 
such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the 
freedom of users. 

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose 
computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the 
GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

“This License” refers to version 3 of the GNU General Public License.

“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

“The Program” refers to any copyright able work licensed under this License. Each licensee is addressed as “you”. “Licensees” and “recipients” may be individuals 
or organizations.

To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The 
resulting work is called a “modified version” of the earlier work or a work “based on” the earlier work.

A “covered work” means either the unmodified Program or a work based on the Program.

To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copy-
right law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available 
to the public, and in some countries other activities as well.

To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network, 
with no transfer of a copy, is not conveying.

An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently visible feature that (1) displays an 
appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey 
the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in 
the list meets this criterion.

1. Source Code.

The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any non-source form of a work.

A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a partic-
ular programming language, one that is widely used among developers working in that language.

The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Compo-
nent, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface 
for which an implementation is available to the public in source code form. A “Major Component”, in this context, means a major essential component (kernel, win-
dow system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code inter-
preter used to run it.

The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code 
and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally 
available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes 
interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is spe-
cifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License 
explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, 
given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey 
covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided 
that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for 
you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material out-
side their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright 
treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by 
exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of 
enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.

4. Conveying Verbatim Copies.
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You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each 
copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code; 
keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided 
that you also meet all of these conditions:

a. The work must carry prominent notices stating that you modified it, and giving a relevant date.

b. The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies 
the requirement in section 4 to “keep intact all notices”.

c. You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along 
with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no 
permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.

d. If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not 
display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not com-
bined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an “aggregate” if the compilation and its resulting 
copyright are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work in an aggre-
gate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source 
under the terms of this License, in one of these ways:

a. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source 
fixed on a durable physical medium customarily used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at 
least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code 
either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily 
used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the 
Corresponding Source from a network server at no charge.

c. c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only 
occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.

d. d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in 
the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. 
If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that 
supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding Source. 
Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these 
requirements.

e. e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work 
are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the 
object code work.

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used for personal, family, or household pur-
poses, or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in 
favor of coverage. For a particular product received by a particular user, “normally used” refers to a typical or common use of that class of product, regardless of the 
status of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product 
regardless of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the 
product.

“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified ver-
sions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued func-
tioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which 
the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), 
the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor 
any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has 
been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modifica-
tion itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an 
implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.

“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that 
are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional 
permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License 
without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permis-
sions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a 
covered work, for which you have or can give appropriate copyright permission.
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Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supple-
ment the terms of this License with terms:

a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or

b. Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works 
containing it; or

c. Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different 
from the original version; or

d. Limiting the use for publicity purposes of names of licensors or authors of the material; or

e. Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or

f. Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual 
assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program as you received it, or any part of it, 
contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a 
further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license document, 
provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files, 
or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either 
way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will 
automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright 
holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior 
to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, 
this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after 
your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights 
have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.

9. Acceptance Not Required for Having Copies.

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a conse-
quence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to 
propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, 
you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to 
this License. You are not responsible for enforcing compliance by third parties with this License.

An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organiza-
tions. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever 
licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the 
work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, roy-
alty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging 
that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called 
the contributor's “contributor version”.

A contributor's “essential patent claims” are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be 
infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a 
consequence of further modification of the contributor version. For purposes of this definition, “control” includes the right to grant patent sublicense in a manner con-
sistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for sale, 
import and otherwise run, modify and propagate the contents of its contributor version.

In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not to enforce a patent (such as an express per-
mission to practice a patent or covenant not to sue for patent infringement). To “grant” such a patent license to a party means to make such an agreement or commit-
ment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge 
and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding 
Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the 
requirements of this License, to extend the patent license to downstream recipients. “Knowingly relying” means you have actual knowledge that, but for the patent 
license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that 
country that you have reason to believe are valid.
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If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent 
license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent 
license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or 
more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is 
in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which 
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered 
work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered 
work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under 
applicable patent law.

12. No Surrender of Others' Freedom.

If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the con-
ditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, 
then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom 
you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU 
Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the 
covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combi-
nation as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License “or any later ver-
sion” applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software 
Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software 
Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of 
a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result 
of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN 
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PAR-
TICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY 
WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT 
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE 
OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POS-
SIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local 
law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies 
a copy of the Program in return for a fee.

LGPL
GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the 
additional permissions listed below.

0. Additional Definitions.

As used herein, “this License” refers to version 3 of the GNU Lesser General Public License, and the “GNU GPL” refers to version 3 of the GNU General Public 
License.

“The Library” refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.
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An “Application” is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class 
defined by the Library is deemed a mode of using an interface provided by the Library.

A “Combined Work” is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined

Work was made is also called the “Linked Version”.

The “Minimal Corresponding Source” for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the

Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The “Corresponding Application Code” for a Combined Work means the object code and/or source code for the Application, including any data and utility programs 
needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than 
as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility 
still operates, and performs whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to that copy.

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your 
choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and 
templates (ten or fewer lines in length), you do both of the following:

a. Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the object code with a copy of the GNU GPL and this license document.

4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in 
the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a. Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the Combined Work with a copy of the GNU GPL and this license document.

c. For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a 
reference directing the user to the copies of the GNU GPL and this license document.

d. Do one of the following:

1) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under 
terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, 
in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

2) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library 
already present on the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the 
Linked Version.

e. Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to 
the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the 
Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal 
Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified 
by section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and 
are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:

a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the 
terms of this License.

b. Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying 
uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be sim-
ilar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public 
License “or any later version” applies to it, you have the option of following the terms and conditions either of that published version or of any later version published 
by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any 
version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public 
statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

MIT

Copyright 1987, 1988 by MIT Student Information Processing Board.
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose is hereby granted, provided that the names of M.I.T. and the 
M.I.T. S.I.P.B. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. and the M.I.T. 
S.I.P.B. make no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty. 

zlib

Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this soft-
ware.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the follow-
ing restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, 
an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.Jean-loup Gailly Mark Adler jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), 
rfc1951.txt (deflate format) and rfc1952.txt (gzip format).

Ultricore-Tally
Ultricore-Tally includes multiple software components which are individually licensed under one or 
more of the following licenses included in this section.

libhiredis

What is it: Minimalistic C client for Redis

Website: https://github.com/redis/hiredis

License: https://sources.debian.org/src/hiredis/0.13.3-2/COPYING/

License copy: 

Copyright (c) 2009-2011, Salvatore Sanfilippo <antirez at gmail dot com>

Copyright (c) 2010-2011, Pieter Noordhuis <pcnoordhuis at gmail dot com>

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

* Neither the name of Redis nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-
CLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPE-
CIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

libpthread

What is it: an API to allow programs to access an programming model based on execution threads.

Note: Tally processor firmware dynamically links, and does NOT statically link, this library.

Website: https://pubs.opengroup.org/onlinepubs/9699919799/

License: https://sources.debian.org/src/glibc/2.37-7/COPYING.LIB/

License copy: 
                  GNU LESSER GENERAL PUBLIC LICENSE

                       Version 2.1, February 1999
 Copyright (C) 1991, 1999 Free Software Foundation, Inc.

 51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA
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 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public Licenses are intended to guaran-
tee your freedom to share and change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of the Free Software Foundation and 
other authors who decide to use it. You can use it too, but we suggest you first think carefully about whether this license or the ordinary General Public License is the 
better strategy to use in any particular case, based on the explanations below.

 When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you wish); that you receive source code or can get it if you want it; that you can change the software 
and use pieces of it in new free programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these rights. These restrictions translate 
to certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we gave you. You must make sure that 
they, too, receive or can get the source code. If you link other code with the library, you must provide complete object files to the recipients, so that they can relink 
them with the library after making changes to the library and recompiling it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you legal permission to copy, distribute 
and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is modified by someone else and passed on, 
the recipients should know that what they have is not the original version, so that the original author's reputation will not be affected by problems that might be intro-
duced by others. 

Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company cannot effectively restrict the users of a 
free program by obtaining a restrictive license from a patent holder. Therefore, we insist that any patent license obtained for a version of the library must be consistent 
with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU Lesser General Public License, applies 
to certain designated libraries, and is quite different from the ordinary General Public License. We use this license for certain libraries in order to permit linking those 
libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking a combined work, a derivative of 
the original library. The ordinary General Public License therefore permits such linking only if the entire combination fits its criteria of freedom. 

The Lesser General

Public License permits more lax criteria for linking other code with the library.

We call this license the “Lesser” General Public License because it does Less to protect the user's freedom than the ordinary General Public License. It also provides 
other free software developers Less of an advantage over competing non-free programs. These disadvantages are the reason we use the ordinary General Public 
License for many libraries. However, the Lesser license provides advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it becomes a de-facto standard. To 
achieve this, non-free programs must be allowed to use the library. A more frequent case is that a free library does the same job as widely used non-free libraries. In 
this case, there is little to gain by limiting the free library to free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body of free software. For example, per-
mission to use the GNU C Library in non-free programs enables many more people to use the whole GNU operating system, as well as its variant, the GNU/Linux 
operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of a program that is linked with the Library has the 
freedom and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a “work based on the library” and a 
“work that uses the library”. The former contains code derived from the library, whereas the latter must be combined with the library in order to run.

             GNU LESSER GENERAL PUBLIC LICENSE
   TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

 0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other authorized party saying 
it may be distributed under the terms of this Lesser General Public License (also called “this License”). Each licensee is addressed as “you”.

 A “library” means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which use some of those func-
tions and data) to form executables.

The “Library”, below, refers to any such software library or work which has been distributed under these terms. A “work based on the Library” means either the 
Library or any derivative work under copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with modifications and/or trans-
lated straightforwardly into another language. (Hereinafter, translation is included without limitation in the term “modification”.)

“Source code” for a work means the preferred form of the work for making modifications to it. For a library, complete source code means all the source code for all 
modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running a program using the Library 
is not restricted, and output from such a program is covered only if its contents constitute a work based on the Library (independent of the use of the Library in a tool 
for writing it). Whether that is true depends on what the Library does and what the program that uses the Library does.
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1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided that you conspicuously and appro-
priately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any 
warranty; and distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute such modifications or 
work under the terms of Section 1 above, provided that you also meet all of these conditions:

    a) The modified work must itself be a software library.

    b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.

    c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

    d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses the facility, other than as an argument 
passed when the facility is invoked, then you must make a good faith effort to ensure that, in the event an application does not supply such function or table, the facil-
ity still operates, and performs whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the application. Therefore, Subsection 2d 
requires that any    application-supplied function or table used by this function must be optional: if the application does not supply it, the square root function must 
still compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library, and can be reasonably considered 
independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when 
you distribute the same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose per-
missions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it. Thus, it is not the intent of this section to claim 
rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based 
on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on a volume of a storage or distribution 
medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do this, you must alter all the 
notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a newer version than version 
2 of the ordinary GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices. 
Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all subsequent copies and derivative 
works made from that copy. This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 
above provided that you accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 
above on a medium customarily used for software interchange.   If distribution of object code is made by offering access to copy from a designated place, then offer-
ing equivalent access to copy the source code from the same place satisfies the requirement to distribute the source code, even though third parties are not compelled 
to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked with it, is called a “work 
that uses the Library”. Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a “work that uses the Library” with the Library creates an executable that is a derivative of the Library (because it contains portions of the Library), 
rather than a “work that uses the library”. The executable is therefore covered by this License. Section 6 states terms for distribution of such executables. When a 
“work that uses the Library” uses material from a header file that is part of the Library, the object code for the work may be a derivative work of the Library even 
though the source code is not. Whether this is true is especially significant if the work can be linked without the Library, or if the work is itself a library. The threshold 
for this to be true is not precisely defined by law. If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and 
small inline functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables con-
taining this object code plus portions of the Library will still fall under Section 6.) Otherwise, if the work is a derivative of the Library, you may distribute the object 
code for the work under the terms of Section 6. Any executables containing that work also fall under Section 6, whether or not they are linked directly with the 
Library itself.

6. As an exception to the Sections above, you may also combine or link a “work that uses the Library” with the Library to produce a work containing portions of the 
Library, and distribute that work under terms of your choice, provided that the terms permit modification of the work for the customer's own use and reverse engi-
neering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered by this License. You must supply 
a copy of this License. If the work during execution displays copyright notices, you must include the copyright notice for the Library among them, as well as a refer-
ence directing the user to the copy of this License. Also, you must do one of these things:

    a) Accompany the work with the complete corresponding machine-readable source code for the Library including whatever changes were used in the work (which 
must be distributed under Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the complete machine-readable “work that uses the 
Library”, as object code and/or source code, so that the user can modify the Library and then relink to produce a modified executable containing the modified Library. 
(It is understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile the application to use the modified 
definitions.)

    b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a copy of the library already present 
on the user's computer system, rather than copying library functions into the executable, and (2) will operate properly with a modified version of the library, if the 
user installs one, as long as the modified version is interface-compatible with the version that the work was made with.

    c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in Subsection 6a, above, for a charge no 
more than the cost of performing this distribution.

    d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the above specified materials from the 
same place.

    e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.
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For an executable, the required form of the “work that uses the Library” must include any data and utility programs needed for reproducing the executable from it. 
However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in either source or binary form) with the major 
components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany the operating system. Such a 
contradiction means you cannot use both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not covered by this 
License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and of the other library facilities is otherwise 
permitted, and provided that you do these two things:

    a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library     facilities. This must be distributed 
under the terms of the     Sections above.

    b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining     where to find the accompanying 
uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this License. However, parties who have received copies, or 
rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Library or its 
derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Library (or any work based on the 
Library), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on 
it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original licensor to copy, distrib-
ute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted 
herein. You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you 
(whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you can-
not distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the 
Library at all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly through 
you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply, and the section as a 
whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the 
sole purpose of protecting the integrity of the free software distribution system which is implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if 
he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places 
the Library under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among 
countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such new versions will be simi-
lar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to it and “any later version”, you have 
the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Library does not spec-
ify a license version number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our 
decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software gener-
ally.

                            NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY 
APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE 
LIBRARY “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFOR-
MANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER 
PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING 
ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY 
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PAR-
TIES OR AFAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

                     END OF TERMS AND CONDITIONS

           How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making it free software that everyone can redistribute and 
change. You can do so by permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach them to the start of each source file to most effectively convey the exclusion of 
warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.
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<one line to give the library's name and a brief idea of what it does.>

Copyright (C) <year>  <name of author>

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as published by the Free Software 
Foundation; either version 2.1 of the License, or (at your option) any later version. This library is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU     Lesser General Public 
License for more details.

You should have received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin 
Street, Fifth Floor, Boston, MA  02110-1301 USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright disclaimer” for the library, if necessary. Here is a sam-
ple; alter the names:   Yoyodyne, Inc., hereby disclaims all copyright interest in the   library `Frob' (a library for tweaking knobs) written by James Random Hacker.   
<signature of Ty Coon>, 1 April 1990 Ty Coon, President of Vice That's all there is to it!

libevent

What is it: Event notification library

Website: https://libevent.org/

License name: 3-clause BSD license

License: https://libevent.org/LICENSE.txt

License copy: 

Libevent is available for use under the following license, commonly known as the 3-clause (or “modified”) BSD license:

==============================

Copyright (c) 2000-2007 Niels Provos <provos@citi.umich.edu>

Copyright (c) 2007-2010 Niels Provos and Nick Mathewson

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright    notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.

IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAM-
AGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSI-
NESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGE.

==============================

Portions of Libevent are based on works by others, also made available by them under the three-clause BSD license above. The copyright notices are available in the 
corresponding source files; the license is as above. Here's a list:

log.c:

   Copyright (c) 2000 Dug Song <dugsong@monkey.org>

   Copyright (c) 1993 The Regents of the University of California.

strlcpy.c:

   Copyright (c) 1998 Todd C. Miller <Todd.Miller@courtesan.com>

win32select.c:

   Copyright (c) 2003 Michael A. Davis <mike@datanerds.net>

evport.c:

   Copyright (c) 2007 Sun Microsystems

ht-internal.h:

   Copyright (c) 2002 Christopher Clark

minheap-internal.h:
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   Copyright (c) 2006 Maxim Yegorushkin <maxim.yegorushkin@gmail.com>

==============================

The arc4module is available under the following, sometimes called the “OpenBSD” license:

   Copyright (c) 1996, David Mazieres <dm@uun.org>

   Copyright (c) 2008, Damien Miller <djm@openbsd.org>

   Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby granted, provided that the above copyright notice and this 
permission notice appear in all copies.

   THE SOFTWARE IS PROVIDED “AS IS” AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE INCLUDING 
ALL IMPLIED WARRANTIES OF    MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY SPECIAL, 
DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE 
OR PERFORMANCE OF THIS SOFTWARE. 

librt

Used by Ultricore-Tally.

What is it: POSIX.1b - The RealTime extensions library

Note: Tally processor firmware dynamically links, and does NOT statically link, this library.

Website: https://www.gnu.org/software/libc/manual/html_node/POSIX.html

License: https://elixir.bootlin.com/uclibc-ng/latest/source/COPYING.LIB

License copy: 
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999
 Copyright (C) 1991, 1999 Free Software Foundation, Inc.

     51 Franklin St, Fifth Floor, Boston, MA  02110-1301  USA

 Everyone is permitted to copy and distribute verbatim copies f this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public Licenses are intended to guaran-
tee your freedom to share and change free software--to make sure the software is free for all its users.

 This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of the Free Software Foundation and 
other authors who decide to use it. You can use it too, but we suggest you first think carefully about whether this license or the ordinary General Public License is the 
better strategy to use in any particular case, based on the explanations below.

 When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you wish); that you receive source code or can get it if you want it; that you can change the software 
and use pieces of it in new free programs; and that you are informed that you can do these things.

 To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these rights. These restrictions translate 
to certain responsibilities for you if you distribute copies of the library or if you modify it.

 For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we gave you. You must make sure that 
they, too, receive or can get the source code. If you link other code with the library, you must provide complete object files to the recipients, so that they can relink 
them with the library after making changes to the library and recompiling it. And you must show them these terms so they know their rights.

 We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you legal permission to copy, distribute 
and/or modify the library.

 To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is modified by someone else and passed on, 
the recipients should know that what they have is not the original version, so that the original author's reputation will not be affected by problems that might be intro-
duced by others.

 Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company cannot effectively restrict the users of a 
free program by obtaining a restrictive license from a patent holder. Therefore, we insist that any patent license obtained for a version of the library must be consistent 
with the full freedom of use specified in this license.

 Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU Lesser General Public License, 
applies to certain designated libraries, and is quite different from the ordinary General Public License. We use this license for certain libraries in order to permit link-
ing those libraries into non-free programs.

 When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking a combined work, a derivative of 
the original library. The ordinary General Public License therefore permits such linking only if the entire combination fits its criteria of freedom. The Lesser General 
Public License permits more lax criteria for linking other code with the library.

 We call this license the “Lesser” General Public License because it does Less to protect the user's freedom than the ordinary General Public License. It also provides 
other free software developers Less of an advantage over competing non-free programs. These disadvantages are the reason we use the ordinary General Public 
License for many libraries. However, the Lesser license provides advantages in certain special circumstances.
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 For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it becomes a de-facto standard. To 
achieve this, non-free programs must be allowed to use the library. A more frequent case is that a free library does the same job as widely used non-free libraries. In 
this case, there is little to gain by limiting the free library to free software only, so we use the Lesser General Public License.

 In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body of free software. For example, per-
mission to use the GNU C Library in non-free programs enables many more people to use the whole GNU operating system, as well as its variant, the GNU/Linux 
operating system.

 Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of a program that is linked with the Library has the 
freedom and the wherewithal to run that program using a modified version of the Library.

 The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a “work based on the library” and a 
“work that uses the library”. The former contains code derived from the library, whereas the latter must be combined with the library in order to run.

 GNU LESSER GENERAL PUBLIC LICENSE 
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

 0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other authorized party saying 
it may be distributed under the terms of this Lesser General Public License (also called “this License”). Each licensee is addressed as “you”. 

 A “library” means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which use some of those func-
tions and data) to form executables.

 The “Library”, below, refers to any such software library or work which has been distributed under these terms. A “work based on the Library” means either the 
Library or any derivative work under copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with modifications and/or trans-
lated straightforwardly into another language. (Hereinafter, translation is included without limitation in the term “modification”.)  

“Source code” for a work means the preferred form of the work for making modifications to it. For a library, complete source code means all the source code for all 
modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the library.

 Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running a program using the 
Library is not restricted, and output from such a program is covered only if its contents constitute a work based on the Library (independent of the use of the Library 
in a tool for writing it). Whether that is true depends on what the Library does and what the program that uses the Library does.

   1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided that you conspicuously and appro-
priately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any 
warranty; and distribute a copy of this License along with the Library.

 You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

 2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute such modifications or 
work under the terms of Section 1 above, provided that you also meet all of these conditions:

    a) The modified work must itself be a software library.

    b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.

    c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

    d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses the facility, other than as an argument 
passed when the facility is invoked, then you must make a good faith effort to ensure that, in the event an application does not supply such function or table, the facil-
ity still operates, and performs whatever part of its purpose remains meaningful.

    (For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the     application. Therefore, Subsection 2d 
requires that any application-supplied function or table used by this function must be optional: if the application does not supply it, the square root function must still 
compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library, and can be reasonably considered 
independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when 
you distribute the same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose per-
missions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the dis-
tribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on a volume of a storage or distribution 
medium does not bring the other work under the scope of this License.

 3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do this, you must alter all 
the notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a newer version than ver-
sion 2 of the ordinary GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any other change in these 
notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all subsequent copies and derivative 
works made from that copy. This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

 4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 
above provided that you accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 
above on a medium customarily used for software interchange.

 If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place 
satisfies the requirement to distribute the source code, even though third parties are not compelled to copy the source along with the object code.
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 5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked with it, is called a “work 
that uses the Library”. Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

 However, linking a “work that uses the Library” with the Library creates an executable that is a derivative of the Library (because it contains portions of the Library), 
rather than a “work that uses the library”. The executable is therefore covered by this License. 

Section 6 states terms for distribution of such executables.

 When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the work may be a derivative work of the Library 
even though the source code is not.

Whether this is true is especially significant if the work can be linked without the Library, or if the work is itself a library. The threshold for this to be true is not pre-
cisely defined by law. If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline functions (ten 
lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object code plus 
portions of the Library will still fall under Section 6.) Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the 
terms of Section 6.

Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a “work that uses the Library” with the Library to produce a work containing portions of the 
Library, and distribute that work under terms of your choice, provided that the terms permit modification of the work for the customer's own use and reverse engi-
neering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered by this License. You must supply 
a copy of this License. If the work during execution displays copyright notices, you must include the copyright notice for the Library among them, as well as a refer-
ence directing the user to the copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including whatever changes were used in the work (which 
must be distributed under Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the complete machine-readable “work that uses the 
Library”, as object code and/or source code, so that the user can modify the Library and then relink to produce a modified executable containing the modified Library. 
(It is understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile the application to use the modified 
definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a copy of the library already present on 
the user's computer system, rather than copying library functions into the executable, and (2) will operate properly with a modified version of the library, if the user 
installs one, as long as the modified version is interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in Subsection 6a, above, for a charge no more 
than the cost of performing this distribution. 

d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the above specified materials from the same 
place.

    e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

 For an executable, the required form of the “work that uses the Library” must include any data and utility programs needed for reproducing the executable from it. 
However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in either source or binary form) with the major 
components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

 It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany the operating system. Such a 
contradiction means you cannot use both them and the Library together in an executable that you distribute.

 7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not covered by this 
License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and of the other library facilities is otherwise 
permitted, and provided that you do these two things:

    a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities. This must be distributed 
under the terms of the Sections above.

    b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where to find the accompanying uncom-
bined form of the same work.

 8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this License. However, parties who have received copies, or 
rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

 9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Library or its 
derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Library (or any work based on the 
Library), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on 
it.

 10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original licensor to copy, dis-
tribute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights 
granted herein.

You are not responsible for enforcing compliance by third parties with this License.

 11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you 
(whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you can-
not distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the 
Library at all. For example, if a patent

license would not permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly through you, then the only way you could sat-
isfy both it and this License would be to refrain entirely from distribution of the Library.
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If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply, and the section as a 
whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the 
sole purpose of protecting the integrity of the free software distribution system which is implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if 
he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

 12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who 
places the Library under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or 
among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

 13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such new versions will be sim-
ilar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to it and “any later version”, you have 
the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Library does not spec-
ify a license version number, you may choose any version ever published by the Free Software Foundation.

 14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our 
decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software gener-
ally.

NO WARRANTY

 15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY 
APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE 
LIBRARY “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFOR-
MANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION.

 16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER 
PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING 
ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY 
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PAR-
TIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

 If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making it free software that everyone can redistribute 
and change. You can do so by permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General Public License).

 To apply these terms, attach the following notices to the library. It is safest to attach them to the start of each source file to most effectively convey the exclusion of 
warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.

    <one line to give the library's name and a brief idea of what it does.>

    Copyright (C) <year>  <name of author>

    This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as published by the Free Software 
Foundation; either version 2.1 of the License, or (at your option) any later version.

    This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or 
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details.

    You should have received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin 
St, Fifth Floor, Boston, MA  02110-1301  USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright disclaimer” for the library, if necessary. Here is a sam-
ple; alter the names: Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for tweaking knobs) written by James Random Hacker.   
<signature of Ty Coon>, 1 April 1990 Ty Coon, President of Vice That's all there is to it! 

libwebsockets

What is it: Websockets 'C' library

Website: https://libwebsockets.org/

License: https://libwebsockets.org/git/libwebsockets/tree/LICENSE

License copy: 

Libwebsockets and included programs are provided under the terms of the MIT license shown below, with the exception that some sources are under a similar per-
missive license like BSD, or are explicitly CC0 / public domain to remove any obstacles from basing differently-licensed code on them.

Original liberal license retained:
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 - lib/misc/sha-1.c                     

- 3-clause BSD license retained, link to original [BSD3]

 - win32port/zlib

 - lib/drivers/display/upng.* 

- ZLIB license (see zlib.h) [ZLIB]

 - lib/tls/mbedtls/wrapper              

- Apache 2.0 (only built if linked against mbedtls) [APACHE2]

 - lib/tls/mbedtls/mbedtls-extensions.c

 - lib/misc/base64-decode.c             

- already MIT

 - contrib/mcufont/encoder

 - lib/misc/ieeehalfprecision.c         

- 2-clause BSD license retained [BSD2]

 - contrib/mcufont/fonts - Open Font License [OFL]

Relicensed to MIT:

 - lib/misc/daemonize.c               

- relicensed from Public Domain to MIT, link to original Public Domain version

 - lib/plat/windows/windows-resolv.c  

- relicensed from “Beerware v42” to MIT

Public Domain (CC-zero) to simplify reuse:

 - test-apps/*.c

 - test-apps/*.h

 - minimal-examples/*

 - lwsws/*

Although libwebsockets is available under a permissive license, it does not change the reality of dealing with large lumps of external code... if your copy diverges it 
is guaranteed to contain security problems after a while and can be very painful to pick backports (especially since historically, we are very hot on cleaning and refac-
toring the codebase). The least painful and lowest risk way remains sending your changes and fixes upstream to us so you can easily use later releases and fixes.

## MIT License applied to libwebsockets

https://opensource.org/licenses/MIT 

 Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Soft-
ware without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions:

 The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

 THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS 
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

## BSD2

 * Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

 * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution

 * THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DIS-
CLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPE-
CIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

## BSD3
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For convenience, a copy of the license on `./lib/misc/sha-1.c`. In binary distribution, this applies to builds with ws support enabled, and without `LWS_WITH-
OUT_BUILTIN_SHA1` at cmake.

 * Copyright (C) 1995, 1996, 1997, and 1998 WIDE Project.

 * All rights reserved.

 * Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

 * 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

 * 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

 * 3. Neither the name of the project nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior 
written permission.

 * THIS SOFTWARE IS PROVIDED BY THE PROJECT AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE PROJECT OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CON-
SEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABIL-
ITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH

## ZLIB

For convenience, a copy of the license on zlib. In binary distribution, this applies for win32 builds with internal zlib only. You can avoid building any zlib usage or 
copy at all with `-DLWS_WITH_ZLIB=0` (the default), and so avoid needing to observe the license for binary distribution that doesn't include the related code.

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this soft-
ware.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the follow-
ing restrictions:

 1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowl-
edgment in the product documentation would be appreciated but is not required.

 2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

 3. This notice may not be removed or altered from any source distribution.

 Jean-loup Gailly        Mark Adler

 jloup@gzip.org          madler@alumni.caltech.edu

## APACHE2

For convenience, a copy of the license on the mbedtls wrapper part. In binary distribution, this applies only when building lws against mbedtls. The canonical license 
application to source files uses the URL reference, so the whole is not reproduced here.

Copyright 2015-2016 Espressif Systems (Shanghai) PTE LTD

Licensed under the Apache License, Version 2.0 (the “License”); you may not use this file except in compliance with the License.

You may obtain a copy of the License at 

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an “AS IS” BASIS, WITHOUT WARRANTIES 
OR CONDITIONS OF ANY KIND, either express or implied.

See the License for the specific language governing permissions and limitations under the License.

## CC0

For convenience, the full text of CC0 dedication found on the lws examples. The intention of this is to dedicate the examples to the public domain, so users can build 
off and modify them without any constraint.

Statement of Purpose

The laws of most jurisdictions throughout the world automatically confer exclusive Copyright and Related Rights (defined below) upon the creator and subsequent 
owner(s) (each and all, an “owner”) of an original work of authorship and/or a database (each, a “Work”).

Certain owners wish to permanently relinquish those rights to a Work for the purpose of contributing to a commons of creative, cultural and scientific works (“Com-
mons”) that the public can reliably and without fear of later claims of infringement build upon, modify, incorporate in other works, reuse and redistribute as freely as 
possible in any form whatsoever and for any purposes, including without limitation commercial purposes. These owners may contribute to the Commons to promote 
the ideal of a free culture and the further production of creative, cultural and scientific works, or to gain reputation or greater distribution for their Work in part 
through the use and efforts of others.

For these and/or other purposes and motivations, and without any expectation of additional consideration or compensation, the person associating CC0 with a Work 
(the “Affirmer”), to the extent that he or she is an owner of Copyright and Related Rights in the Work, voluntarily elects to apply CC0 to the Work and publicly dis-
tribute the Work under its terms, with knowledge of his or her Copyright and Related Rights in the Work and the meaning and intended legal effect of CC0 on those 
rights.
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1. Copyright and Related Rights. A Work made available under CC0 may be protected by copyright and related or neighboring rights (“Copyright and Related 
Rights”). Copyright and Related Rights include, but are not limited to, the following:

    the right to reproduce, adapt, distribute, perform, display, communicate, and translate a Work; moral rights retained by the original author(s) and/or performer(s); 
publicity and privacy rights pertaining to a person's image or likeness depicted in a Work; rights protecting against unfair competition in regards to a Work, subject to 
the limitations in paragraph 4(a), below; rights protecting the extraction, dissemination, use and reuse of data in a Work; database rights (such as those arising under 
Directive 96/9/EC of the European Parliament and of the Council of 11 March 1996 on the legal protection of databases, and under any national implementation 
thereof, including any amended or successor version of such directive); and other similar, equivalent or corresponding rights throughout the world based on applica-
ble law or treaty, and any national implementations thereof.

2. Waiver. To the greatest extent permitted by, but not in contravention of, applicable law, Affirmer hereby overtly, fully, permanently, irrevocably and uncondition-
ally waives, abandons, and surrenders all of Affirmer's Copyright and Related Rights and associated claims and causes of action, whether now known or unknown 
(including existing as well as future claims and causes of action), in the Work (i) in all territories worldwide, (ii) for the maximum duration provided by applicable 
law or treaty (including future time extensions), (iii) in any current or future medium and for any number of copies, and (iv) for any purpose whatsoever, including 
without limitation commercial, advertising or promotional purposes (the “Waiver”). Affirmer makes the Waiver for the benefit of each member of the public at large 
and to the detriment of Affirmer's heirs and successors, fully intending that such Waiver shall not be subject to revocation, rescission, cancellation, termination, or 
any other legal or equitable action to disrupt the quiet enjoyment of the Work by the public as contemplated by Affirmer's express Statement of Purpose.

3. Public License Fallback. Should any part of the Waiver for any reason be judged legally invalid or ineffective under applicable law, then the Waiver shall be pre-
served to the maximum extent permitted taking into account Affirmer's express Statement of Purpose. In addition, to the extent the Waiver is so judged Affirmer 
hereby grants to each affected person a royalty-free, non transferable, non sublicensable, non exclusive, irrevocable and unconditional license to exercise Affirmer's 
Copyright and Related Rights in the Work (i) in all territories worldwide, (ii) for the maximum duration provided by applicable law or treaty (including future time 
extensions), (iii) in any current or future medium and for any number of copies, and (iv) for any purpose whatsoever, including without limitation commercial, adver-
tising or promotional purposes (the “License”). The License shall be deemed effective as of the date CC0 was applied by Affirmer to the Work. Should any part of the 
License for any reason be judged legally invalid or ineffective under applicable law, such partial invalidity or ineffectiveness shall not invalidate the remainder of the 
License, and in such case Affirmer hereby affirms that he or she will not (i) exercise any of his or her remaining Copyright and Related Rights in the Work or (ii) 
assert any associated claims and causes of action with respect to the Work, in either case contrary to Affirmer's express Statement of Purpose.

4. Limitations and Disclaimers.

    No trademark or patent rights held by Affirmer are waived, abandoned, surrendered, licensed or otherwise affected by this document.

    Affirmer offers the Work as-is and makes no representations or warranties of any kind concerning the Work, express, implied, statutory or otherwise, including 
without limitation warranties of title, merchantability, fitness for a particular purpose, non infringement, or the absence of latent or other defects, accuracy, or the 
present or absence of errors, whether or not discoverable, all to the greatest extent permissible under applicable law.

    Affirmer disclaims responsibility for clearing rights of other persons that may apply to the Work or any use thereof, including without limitation any person's Copy-
right and Related Rights in the Work. Further, Affirmer disclaims responsibility for obtaining any necessary consents, permissions or other rights required for any use 
of the Work.

    Affirmer understands and acknowledges that Creative Commons is not a party to this document and has no duty or obligation with respect to this CC0 or use of the 
Work.

## OFL: Open Font License

Copyright (c) 2012-2015, The Mozilla Foundation and Telefonica S.A.

This Font Software is licensed under the SIL Open Font License, Version 1.1.

This license is copied below, and is also available with a FAQ at:

http://scripts.sil.org/OFL

-----------------------------------------------------------

SIL OPEN FONT LICENSE Version 1.1 - 26 February 2007

-----------------------------------------------------------

PREAMBLE

The goals of the Open Font License (OFL) are to stimulate worldwide development of collaborative font projects, to support the font creation efforts of academic and 
linguistic communities, and to provide a free and open framework in which fonts may be shared and improved in partnership with others.

The OFL allows the licensed fonts to be used, studied, modified and redistributed freely as long as they are not sold by themselves. The fonts, including any deriva-
tive works, can be bundled, embedded, redistributed and/or sold with any software provided that any reserved names are not used by derivative works. The fonts and 
derivatives, however, cannot be released under any other type of license. The requirement for fonts to remain under this license does not apply to any document cre-
ated using the fonts or their derivatives.

DEFINITIONS

“Font Software” refers to the set of files released by the Copyright Holder(s) under this license and clearly marked as such. This may include source files, build 
scripts and documentation.

“Reserved Font Name” refers to any names specified as such after the copyright statement(s).

“Original Version” refers to the collection of Font Software components as distributed by the Copyright Holder(s).

“Modified Version” refers to any derivative made by adding to, deleting, or substituting -- in part or in whole -- any of the components of the Original Version, by 
changing formats or by porting the Font Software to a new environment.

“Author” refers to any designer, engineer, programmer, technical writer or other person who contributed to the Font Software.

PERMISSION & CONDITIONS



Ultricore BCS User Guide (v11-rev8) Software Licenses • 189

Permission is hereby granted, free of charge, to any person obtaining a copy of the Font Software, to use, study, copy, merge, embed, modify, redistribute, and sell 
modified and unmodified copies of the Font Software, subject to the following conditions:

1) Neither the Font Software nor any of its individual components, in Original or Modified Versions, may be sold by itself.

2) Original or Modified Versions of the Font Software may be bundled, redistributed and/or sold with any software, provided that each copy contains the above copy-
right notice and this license. These can be included either as stand-alone text files, human-readable headers or in the appropriate machine-readable metadata fields 
within text or binary files as long as those fields can be easily viewed by the user.

3) No Modified Version of the Font Software may use the Reserved Font Name(s) unless explicit written permission is granted by the corresponding Copyright 
Holder. This restriction only applies to the primary font name as presented to the users.

4) The name(s) of the Copyright Holder(s) or the Author(s) of the Font Software shall not be used to promote, endorse or advertise any Modified Version, except to 
acknowledge the contribution(s) of the Copyright Holder(s) and the Author(s) or with their explicit written permission.

5) The Font Software, modified or unmodified, in part or in whole, must be distributed entirely under this license, and must not be distributed under any other license. 
The requirement for fonts to remain under this license does not apply to any document created using the Font Software.

TERMINATION

This license becomes null and void if any of the above conditions are not met.

DISCLAIMER

THE FONT SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO 
ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, PATENT, 
TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABIL-
ITY, INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER IN AN ACTION OF CON-
TRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM OTHER DEALINGS IN 
THE FONT SOFTWARE.

openssl

What is it: Cryptography and secure comms library.

Website: https://www.openssl.org

License: https://www.openssl.org/source/license.html

License copy: 

LICENSE ISSUES

 ==============

 The OpenSSL toolkit stays under a double license, i.e. both the conditions of the OpenSSL License and the original SSLeay license apply to the toolkit. See below 
for the actual license texts.

 OpenSSL License

 ---------------

 ====================================================================

Copyright (c) 1998-2019 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

 3. All advertising materials mentioning features or use of this    software must display the following acknowledgment:

 “This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)”

 4. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote products derived from this software without prior written permis-
sion. For written permission, please contact openssl-core@openssl.org.

 5. Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear in their names without prior written permission of the OpenSSL 
Project.

 6. Redistributions of any form whatsoever must retain the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)”

 THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, 
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
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HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

 * OF THE POSSIBILITY OF SUCH DAMAGE.

 =================================================== This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). 
This product includes software written by Tim Hudson (tjh@cryptsoft.com).

 Original SSLeay License

 -----------------------

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to all code found in 
this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is covered by the same 
copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

 Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed.

If this package is used in a product, Eric Young should be given attribution as the author of the parts of the library used.

This can be in the form of a textual message at program startup or in documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

3. All advertising materials mentioning features or use of this software must display the following acknowledgment: “This product includes cryptographic software 
written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgment:

“This product includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUD-
ING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGE.

The license and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code cannot simply be copied and put 
under another distribution licence [including the GNU Public License.] 

libcrypto

What is it: Cryptographic algorithm library provided by OpenSSL.

Website: https://cppget.org/libcrypto

License: https://github.com/openssl/openssl/blob/master/LICENSE.txt

License copy: 
Apache License

                           Version 2.0, January 2004
                        https://www.apache.org/licenses/

 TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

“License” shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this document.

“Licensor” shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

“Legal Entity” shall mean the union of the acting entity and all       other entities that control, are controlled by, or are under common control with that entity. For the 
purposes of this definition, “control” means (i) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or 
(ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.

“You” (or “Your”) shall mean an individual or Legal Entity       exercising permissions granted by this License.

“Source” form shall mean the preferred form for making modifications, including but not limited to software source code, documentation source, and configuration 
files.
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“Object” form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not limited to compiled object code, gen-
erated documentation, and conversions to other media types.

“Work” shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by a copyright notice that is included in 
or attached to the work (an example is provided in the Appendix below).

“Derivative Works” shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for which the editorial revisions, anno-
tations, elaborations, or other modifications represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not include 
works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

“Contribution” shall mean any work of authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works 
thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf 
of the copyright owner. For the purposes of this definition, “submitted” means any form of electronic, verbal, or written communication sent to the Licensor or its 
representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, 
or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or otherwise desig-
nated in writing by the copyright owner as “Not a Contribution.”

“Contributor” shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by Licensor and subsequently incorpo-
rated within the Work.

 2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, 
no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the 
Work and such Derivative Works in Source or Object form.

 3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, 
no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the 
Work, where such license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combi-
nation of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a 
cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct       or contributory patent infringe-
ment, then any patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

 4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without modifications, and in Source or 
Object form, provided that You meet the following conditions:

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; and (b) You must cause any modified files to carry prominent notices 
stating that You changed the files; and (c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attri-
bution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and (d) If the Work includes a 
“NOTICE” text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices contained within 
such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file 
distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated by 
the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and do not 
modify the License. You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from 
the Work, provided that such additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different license terms and conditions for use, reproduction, or dis-
tribution of Your modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with 
the conditions stated in this License.

 5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the Licensor 
shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or 
modify the terms of any separate license agreement you may have executed with Licensor regarding such Contributions.

 6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names of the Licensor, except as required for 
reasonable and customary use in describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or

agreed to in writing, Licensor provides the Work (and each   Contributor provides its Contributions) on an “AS IS” BASIS, WITHOUT WARRANTIES OR CONDI-
TIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANT-
ABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the      appropriateness of using or redistributing the Work and 
assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory,      whether in tort (including negligence), contract, or otherwise,      unless required by applicable law 
(such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, inci-
dental, or consequential damages of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages 
for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has been advised 
of the possibility of such damages. 

   9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance 
of support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting such obligations, You may act only on 
Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harm-
less for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

   END OF TERMS AND CONDITIONS

libcrypt

What is it: A modern library for one-way hashing of passwords.

Note: Tally processor firmware dynamically links, and does NOT statically link, this library.

Website: https://tracker.debian.org/pkg/libxcrypt
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License: https://sources.debian.org/src/libxcrypt/1%3A4.4.36-2/COPYING.LIB/

Authors: https://sources.debian.org/src/libxcrypt/1%3A4.4.36-2/AUTHORS/

License copy: 
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999
Copyright (C) 1991, 1999 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA  02110-1301  USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2, hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public Licenses are intended to guaran-
tee your freedom to share and change free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of the Free Software Foundation and 
other authors who decide to use it. You can use it too, but we suggest you first think carefully about whether this license or the ordinary General Public License is the 
better strategy to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you wish); that you receive source code or can get it if you want it; that you can change the software 
and use pieces of it in new free programs; and that you are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender these rights. These restrictions translate 
to certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we gave you. You must make sure that 
they, too, receive or can get the source code. If you link other code with the library, you must provide complete object files to the recipients, so that they can relink 
them with the library after making changes to the library and recompiling it. And you must show them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you legal permission to copy, distribute 
and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library. Also, if the library is modified by someone else and passed on, 
the recipients should know that what they have is not the original version, so that the original author's reputation will not be affected by problems that might be intro-
duced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company cannot effectively restrict the users of a 
free program by obtaining a restrictive license from a patent holder. Therefore, we insist that any patent license obtained for a version of the library must be consistent 
with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General Public License. This license, the GNU Lesser General Public License, applies 
to certain designated libraries, and is quite different from the ordinary General Public License. We use this license for certain libraries in order to permit linking those 
libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking a combined work, a derivative of 
the original library. The ordinary General Public License therefore permits such linking only if the entire combination fits its criteria of freedom. The Lesser General 
Public License permits more lax criteria for linking other code with the library.

We call this license the “Lesser” General Public License because it does Less to protect the user's freedom than the ordinary General Public License. It also provides 
other free software developers Less of an advantage over competing non-free programs. These disadvantages are the reason we use the ordinary General Public 
License for many libraries. However, the Lesser license provides advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it becomes a de-facto standard. To 
achieve this, non-free programs must be allowed to use the library. A more frequent case is that a free library does the same job as widely used non-free libraries. In 
this case, there is little to gain by limiting the free library to free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body of free software. For example, per-
mission to use the GNU C Library in non-free programs enables many more people to use the whole GNU operating system, as well as its variant, the GNU/Linux 
operating system.

Although the Lesser General Public License is Less protective of the users' freedom, it does ensure that the user of a program that is linked with the Library has the 
freedom and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between a “work based on the library” and a 
“work that uses the library”. The former contains code derived from the library, whereas the latter must be combined with the library in order to run.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other program which contains a notice placed by the copyright holder or other authorized party saying it 
may be distributed under the terms of this Lesser General Public License (also called “this License”). Each licensee is addressed as “you”.

A “library” means a collection of software functions and/or data prepared so as to be conveniently linked with application programs (which use some of those func-
tions and data) to form executables.

The “Library”, below, refers to any such software library or work which has been distributed under these terms. A “work based on the Library” means either the 
Library or any derivative work under copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with modifications and/or trans-
lated straightforwardly into another language. (Hereinafter, translation is included without limitation in the term “modification”.)

“Source code” for a work means the preferred form of the work for making modifications to it. For a library, complete source code means all the source code for all 
modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation of the library.
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Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running a program using the Library 
is not restricted, and output from such a program is covered only if its contents constitute a work based on the Library (independent of the use of the Library in a tool 
for writing it). Whether that is true depends on what the Library does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code as you receive it, in any medium, provided that you conspicuously and appro-
priately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any 
warranty; and distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and distribute such modifications or 
work under the terms of Section 1 above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied by an application program that uses the facility, other than as an argument 
passed when the facility is invoked, then you must make a good faith effort to ensure that, in the event an application does not supply such function or table, the facil-
ity still operates, and performs whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is entirely well-defined independent of the application. Therefore, Subsection 2d 
requires that any application-supplied function or table used by this function must be optional: if the application does not supply it, the square root function must still 
compute square roots.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library, and can be reasonably considered 
independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as separate works. But when 
you distribute the same sections as part of a whole which is a work based on the Library, the distribution of the whole must be on the terms of this License, whose per-
missions for other licensees extend to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to control the dis-
tribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the Library) on a volume of a storage or distribution 
medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the Library. To do this, you must alter all the 
notices that refer to this License, so that they refer to the ordinary GNU General Public License, version 2, instead of to this License. (If a newer version than version 
2 of the ordinary GNU General Public License has appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all subsequent copies and derivative 
works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form under the terms of Sections 1 and 2 
above provided that you accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 
above on a medium customarily used for software interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy the source code from the same place 
satisfies the requirement to distribute the source code, even though third parties are not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being compiled or linked with it, is called a “work 
that uses the Library”. Such a work, in isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.

However, linking a “work that uses the Library” with the Library creates an executable that is a derivative of the Library (because it contains portions of the Library), 
rather than a “work that uses the library”. The executable is therefore covered by this License. Section 6 states terms for distribution of such executables.

When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the work may be a derivative work of the Library 
even though the source code is not. Whether this is true is especially significant if the work can be linked without the Library, or if the work is itself a library. The 
threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline functions (ten lines or less in length), 
then the use of the object file is unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object code plus portions of the Library 
will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section 6. Any executables containing that 
work also fall under Section 6, whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a “work that uses the Library” with the Library to produce a work containing portions of the 
Library, and distribute that work under terms of your choice, provided that the terms permit modification of the work for the customer's own use and reverse engi-
neering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are covered by this License. You must supply 
a copy of this License. If the work during execution displays copyright notices, you must include the copyright notice for the Library among them, as well as a refer-
ence directing the user to the copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including whatever changes were used in the work (which 
must be distributed under Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the complete machine-readable “work that uses the 
Library”, as object code and/or source code, so that the user can modify the Library and then relink to produce a modified executable containing the modified Library. 
(It is understood that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile the application to use the modified 
definitions.)
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b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a copy of the library already present on 
the user's computer system, rather than copying library functions into the executable, and (2) will operate properly with a modified version of the library, if the user 
installs one, as long as the modified version is interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in Subsection 6a, above, for a charge no more 
than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the above specified materials from the same 
place.

e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy.

For an executable, the required form of the “work that uses the Library” must include any data and utility programs needed for reproducing the executable from it. 
However, as a special exception, the materials to be distributed need not include anything that is normally distributed (in either source or binary form) with the major 
components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally accompany the operating system. Such a 
contradiction means you cannot use both them and the Library together in an executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a single library together with other library facilities not covered by this 
License, and distribute such a combined library, provided that the separate distribution of the work based on the Library and of the other library facilities is otherwise 
permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities. This must be distributed under 
the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where to find the accompanying uncom-
bined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense, link with, or distribute the Library is void, and will automatically terminate your rights under this License. However, parties who have received copies, or 
rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the Library or its 
derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the Library (or any work based on the 
Library), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on 
it.

10. Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from the original licensor to copy, distrib-
ute, link with or modify the Library subject to these terms and conditions. You may not impose any further restrictions on the recipients' exercise of the rights granted 
herein. You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are imposed on you 
(whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions of this License. If you can-
not distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the 
Library at all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who receive copies directly or indirectly through 
you, then the only way you could satisfy both it and this License would be to refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply, and the section as a 
whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this section has the 
sole purpose of protecting the integrity of the free software distribution system which is implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if 
he or she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright holder who places 
the Library under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution is permitted only in or among 
countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time to time. Such new versions will be simi-
lar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to it and “any later version”, you have 
the option of following the terms and conditions either of that version or of any later version published by the Free Software Foundation. If the Library does not spec-
ify a license version number, you may choose any version ever published by the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with these, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our 
decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing and reuse of software gener-
ally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY 
APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE 
LIBRARY “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFOR-
MANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER 
PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING 
ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY 
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(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PAR-
TIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making it free software that everyone can redistribute and 
change. You can do so by permitting redistribution under these terms (or, alternatively, under the terms of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach them to the start of each source file to most effectively convey the exclusion of 
warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.

one line to give the library's name and an idea of what it does.

Copyright (C) year name of author

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as published by the Free Software 
Foundation; either version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FIT-
NESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free Software Foundation, Inc., 51 Franklin 
Street, Fifth Floor, Boston, MA  02110-1301  USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright disclaimer” for the library, if necessary. Here is a sam-
ple; alter the names: Yoyodyne, Inc., hereby disclaims all copyright interest in the library `Frob' (a library for tweaking knobs) written by James Random Hacker. sig-
nature of Ty Coon, 1 April 1990 Ty Coon, President of Vice That's all there is to it!

FOSS libraries used by Tally System Console

Used in Tally System Console, which services the Ultricore-Tally.

Newtonsoft Json.NET

What is it: High-performance JSON framework for.NET applications.

Website: https://github.com/JamesNK/Newtonsoft.Json

License: https://github.com/JamesNK/Newtonsoft.Json/blob/master/README.md

License copy:

Copyright (c) 2007 James Newton-King

The MIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Soft-
ware without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS 
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

Redis Client by StackExchange

Used in Tally System Console, which services the Ultricore-Tally.

What is it: A high performance general purpose redis client for.NET languages.

Website: https://stackexchange.github.io/StackExchange.Redis/

License: https://github.com/StackExchange/StackExchange.Redis/blob/master/LICENSE

License copy:

Copyright (c) 2014 Stack Exchange

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Soft-
ware without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions:



196 • Software Licenses Ultricore BCS User Guide (v11-rev8)

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS 
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHERLIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

sshnet/SSH.NET by Renci

Used in Tally System Console, which services the Ultricore-Tally.

What is it: A Secure Shell (SSH) library for .NET, optimized for parallelism.

Website: https://github.com/sshnet/SSH.NET

License: https://github.com/sshnet/SSH.NET/commit/45ab50572d8cc6d150f4507eb2cbc3abaff1da8d

License copy:

Copyright (c) Renci, Oleg Kapeljushnik and Gert Driesen

The MIT License (MIT)

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the “Software”), to deal in the Soft-
ware without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS 
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Tool chain libraries that are dependencies of the tally processor firmware

libstdc++.so.6 => /usr/lib/x86_64-linux-gnu/libstdc++.so.6

Loaded by package: libstdc++6

libgcc_s.so.1 => /lib/x86_64-linux-gnu/libgcc_s.so.1

Loaded by package: libgcc1

libc.so.6 => /lib/x86_64-linux-gnu/libc.so.6

Loaded by package: libc6

/lib64/ld-linux-x86-64.so.2

Loaded by package: libc6

libdl.so.2 => /lib/x86_64-linux-gnu/libdl.so.2

Loaded by package: libc6

libstdc++6 license:

https://metadata.ftp-master.debian.org/changelogs//main/g/gcc-10/gcc-10_10.2.1-6_copyright
Version 3.1 of the GCC Runtime Library Exception

Libgcc1 license:

https://metadata.ftp-master.debian.org/changelogs//main/g/gcc-8/gcc-8_8.3.0-6_copyright

Version 3.1 of the GCC Runtime Library Exception

Libc6 license:

https://sources.debian.org/src/glibc/2.37-7/COPYING.LIB/

GNU LESSER GENERAL PUBLIC LICENSE - Version 2.1, February 1999

Note: Tally processor firmware dynamically links, and does NOT statically link, this library.
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Glossary
The following terms are used throughout this guide:

Breakaway — an act of performing a switch on only some of the signals grouped together under 
one label.

Connection Point — setting to define a communication connection between Ultricore BCS and a 
device in the routing system.

Crosspoint — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires 
one crosspoint.

Destination — a signal output from the routing system.

Hard Panel — the physical Ultricore BCS panel that provides a touchscreen interface to the menu 
system.

IP Address — a setting that defines the Internet protocol address of a device within a network.

Label — text that is used by control displays to identify a signal as an input or output.

Level — refers to a section of a routing system. For example, a video router would be one level and 
an audio router would be a second level.

Logical (virtual) Label — a name for a group of routing system inputs or outputs.

Logical (virtual) Routing — the action of switching a group of otherwise unrelated signals via a 
common label (name).

Remote Control Panel (RCP) — a physical hardware panel of buttons that is used to control the 
routing system.

Salvo — a system wide sequence of matrix control operations and crosspoint actions.

Soft Panel — a DashBoard software interface that represents a panel of buttons that is used to 
control the routing system.

Source — a signal input to the routing system.

Virtual Label — a name for a group of routing system inputs or outputs.

Virtual Routing — the action of switching a group of otherwise unrelated signals via a common 
label (name).
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